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Welcome to SpinFire™ 10

Welcome to SpinFire™ 10, the program that allows you to view, measure and markup 2D and 3D CAD data formats.
You can download the full trial from our download section:
® SpinFire 10 Download Page
The latest release of this application is SpinFire 10.8.3 Build 1912.5. See the SpinFire Releases page for more information.
To learn about the changes and improvements of SpinFire 10 please see the following release notes:

SpinFire 10.0 Release Notes.
SpinFire 10.1 Release Notes.
SpinFire 10.2 Release Notes.
SpinFire 10.2.2 Release Notes.
SpinFire 10.3 Release Notes.
SpinFire 10.4 Release Notes.
SpinFire 10.5 Release Notes.
SpinFire 10.6 Release Notes.
SpinFire 10.7 Release Notes.
SpinFire 10.8 Release Notes.
SpinFire 10.8.1 Release Notes.
SpinFire 10.8.2 Release Notes.
SpinFire 10.8.3 Release Notes.
SpinFire 10.9 Release Notes.

If you are migrating from from an earlier version refer to the migration section.

Returning Users

Key Improvements in SpinFire 10

If you are upgrading from SpinFire Professional 9.0, you'll find the following improvements:
® Better Home Page with improved list of recent document and notification messages
® New minimum thickness measurement
® Improved minimum distance plugin
®* New projected area measurement
® Better support for Windows 7 and Windows Vista
® Better Importers management
® Better importer properties
® |mporters install on demand (importers auto-deploy)
® Install and update of plug-ins from within the application
® Easier Plug-in install and updates

Read more ...

Key Improvements in SpinFire 9

If you are upgrading from SpinFire Professional 8.3, you'll find the following improvements:


http://help.actify.com/spaces/flyingpdf/flyingpdf.action?key=SF100
http://help.actify.com/spaces/flyingpdf/flyingpdf.action?key=SF100
http://www.actify.com/downloads/spinfire-professional-trial/

SpinFire™ 10.0 shares a single architecture where it runs four products in the following environments:

Desktop: SpinFire™ in Desktop environment now contains intuitive user interface which facilitates the user to perform measurements on
linear, angular, radial and new coordinate systems. The user can now copy the Measurements to the clipboard, which can be pasted into
any document with the Windows Paste command. The user can now insert bitmap or vector image of any 3D file and moreover the
Design data can also be copied to clipboard and pasted into office documents accordingly.

Browser: All the features that are available in Desktop environment of SpinFire™ are now available in Browser environment also, except
the non availability of Home component and menu bar. It opens up in Internet Explorer.

Office: Allows the user to insert Interactive image in office documents. Computed Data namely part name, volume, surface area, centre
of mass, part count, part extents and scene extents of any 3D file can be inserted into excel spreadsheet. See SpinFire™ in Office
Environment for details.

Plug-in architecture: Plug-ins are pieces of software that add functionality to SpinFire. A plug-in might add a new component tab to the
program or it may add a new object to the toolbar. A plug-in might be provided either by Actify or a third party. SpinFire™ 9.0 supports an
array of plug-ins namely Automatic part ID, Automatic Part List, Surface Area of Cross Section, Draft Angle Analysis, Model Compare,
STL Export and Windows SharePoint Server plug-in.

License: Feature based license is now available in SpinFire™. The licenses that are available are Reader, Markup, Lite and
Professional. The user can perform only the basic measurements with the Reader license. Whereas Markup facilitates the user to
perform Markups, display notes and save the same. Lite type of license helps the user to take snapshots, perform x-section, do
transformations and perform measurements. Professional license is the full fledged version, where the user can open native CAD files,
use Actify plug-ins with full access,and can perform measurements and markups.

Key Improvements in SpinFire 8

If you are upgrading from SpinFire Professional 2004v2 , you'll find a new user inerface and functionality imporved and enhanced in the following

ways:

Support for PMI/GD&T annotations: SpinFire Professional is able to work with specified Actify Importers to import PMI (Product and
Manufacturing Information) from native 3D CAD files. PMI annotations in the design such as Geometric Tolerances, Datums, and
Dimensions can be displayed in the 3D scene. Selection of a PMI annotation will highlight the part or surface on the model that the
annotation is associated with.

New measurements: Several new measurements are available for 3D models, including Boundary by Edges, Sum of Connected Edges,
Arc Center Coordinates, Edge to Edge, Arc Radius, and Surface Draft Angle.

New user interface: A new and attractive user interface facilitates navigating through commands and documents.

Plug-in architecture: SpinFire Professional 9.0 and later supports plug-ins. Plug-ins are pieces of software that add functionality to
SpinFire Professional. A plug-in might add a new component tab to the program or it may add a new object to the toolbar. A plug-in might
be provided either by Actify or a third party.

Print improvements: A dialog box offers options for choosing between raster and vector printing, page scaling, and information to
display in the header and footer. The “Print Preview” command displays how the printed document will appear before printing it. The
“Print Region” command prints only a selected area of a 2D document rather than the entire document.

Export to U3D: Exports a 3D document open in the SpinFire Professional WorkSpace as a U3D file.

Section Profile improvements: The section profile consists of all the points of the model that intersect with a section plane. The user
may decide whether an outline of the section profile will display be displayed on the cross-section plane. A vector representation of the
cross-section profile can be saved as an EMF file.

Transformation by Handles: Allows the user to freely translate or rotate an object in a 3D assembly by dragging a handle surrounding
the object.

From/To Coordinates: Moves an object in a 3D assembly from its current position with respect one coordinate system and places it in
the same position with respect to another coordinate system.

Key Improvements in SpinFire Professional 2004v2

If you are upgrading from SpinFire Professional 2004 , you'll find the following improvements:

2D CAD and TIFF drawings converted to vector data: 2D CAD drawings and TIFF files will be converted to vector data and imported into
a 2D document in the .3D WorkSpace. Multi-page files will have each page imported into a separate document in the WorkSpace.
Importers will need to be updated to take advantage of this feature.

Measurements for 2D documents: A menu on the toolbar offers several measurements for 2D documents. See Working with 2D
Documents for details.

Scale Calibration: The scale of measurement used in a 2D document may be calibrated with a real world scale. See Calibrate
measurements to a scale for details.

Connected Actify Servers integrated into the Windows Explorer: If you chose to install the Actify Server Extension, an entry for



"Actify Server" will appear under "My Network Places." Users may work with folders and files stored on an Actify Server just as with any
other network folder.

1st Angle or 3rd Angle projection options: The projection angle affects how the views of a 3D model are displayed in 4 Viewports
mode.

Key Improvements in SpinFire Professional 2004

If you are upgrading from SpinFire Professional 2003, you'll find the following improvements:

.3D WorkSpace: Open different document types simultaneously and save several documents in a single .3D file. See Working with
Documents in the .3D WorkSpace for details.

2D Document mode and redlining tools: Raster image files (.bmp, .jpg, .gif, .png, .tiff, .wmf, .emf) and snapshots of 3D models open in
2D mode with special tools for working with 2D documents. Add redlining markups to documents in 2D mode, including lines, shapes,
stamps, and text boxes. See Working with 2D Documents for details.

2D Snapshots of 3D models: A single click takes a snapshot of a 3D model for use in 2D mode. See Take a 2D Snapshot of a 3D
Model for details.

Thumbnails of .3D files available in Windows folders: Windows thumbnail view shows a 2D representation of a .3D file. Great for
quick browsing through multiple .3D files.

New measurements for 3D models: Nine new measurements including thickness, edge to surface distance, and surface normal to edge
angle. See Dimensions Reference for details.

New render modes for 3D geometries: A "Reflective” mode displays a part with metallic rendering for improved realism. "Surface
analysis" is a reflective rendering mode that allows a user to search for surface irregularities. See Change the Render Mode of an Object
for details.

Key Improvements in SpinFire Professional 2003

If you are upgrading from SpinFire Professional 5.0, you'll find the following improvements:

Multiple Coordinate Systems: Include multiple user-defined coordinate systems in a 3D scene. See Using Multiple Coordinate System for
details.

Show Only Command: Easily view selected parts while hiding the rest of the assembly. See Show Only Selected Objects in an Assembly
for details.

Improved Cross-Section Features: The length of a cross-section profile is measured in real-time. And the Section Definition dialog box
provides greater precision for positioning and orienting a cross-section plane. See Cross-Sectioning a Model for details.

New Options: The Options component has additional settings to control how SpinFire Professional works. You can set the volume
precision you want, choose SpinFire Professional as the default application to open native CAD formats, and choose whether to include
headers and footers in your printing.

Multiple Selection in Assembly Tree: Use Ctrl+Click and Shift+Click to select multiple parts and subassemblies in the assembly tree.

Drag-and-drop into the Library: Drag-and-drop files from your Windows desktop directly to and from the remote and local folders in the
Library component.

Key Improvements in SpinFire SpinFire Professional 5.0

If you are upgrading from SpinFire Professional 4.1 or 3DView, you'll find many of the same useful features for markup, measurement, and
cross-sectioning. In addition, you'll find a new user interface and powerful new features for working with mutliple documents and document types.

New Users

Learn about SpinFire™ from the following overviews:

Using The SpinFire User Interface
Working with CAD and .3D Files
Controlling the View

Measuring and Annotating a Model
Cross-Sectioning a Model

Working with Assemblies and Parts

Viewing PMI Annotations



® Working with 2D Documents
® Using Multiple Coordinate Systems
® Working with Documents in the .3D WorkSpace
® Configuring and Activating SpinFire™
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Highlights

® SpinFire 10.0 has over 50 product improvements and offers new and enhanced features, better windows integration, improved Importer
update capability, and the integration of the Actify Release Manager (ARM)

User Interface

® Recent Document Display Enhancement
SpinFire Help Access

®* New access via help website
Better Version Management

® SpinFire Version

® Plug-in Version

® |mporter Version
New Function

® Projected Plane Surface Area
Plug-ins

® New: Minimum Thickness
® Updated:  Minimum Distance

Importers

® Streamlined import process. Faster and more reliable.
® Better importer properties dialog.

Windows Integration

® Better Windows 7 Integration
¢ 3D Thumbnails now supported on Windows 7 and Vista

2D Workspace Enhancement

® Easier display of Drawing Layers
® Auto scale of notes in 2D based on page size.

Improved update management

® Plug-in Version
® Importer Version

User Interface

The SpinFire Home Page has been enhanced by now showing a thumbnail Image of the recent opened CAD files. This allows you to more easily
identify the files that you have already opened.

The Messages section will now alert you to new Importers and Plug-ins updates so you can more easily and consistently keep SpinFire up to
date.

The Message section also display warning messages when license expires or floating license tokens fail to load.
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Motegi MR116 Alloy Wheel.x_t

Open on: Friday, October 07, 2011 11:45:26 AM
Size: 768.0 KB

flywheel.prt.1

Open on: Friday, October 07, 2011 11:44:58 AM
Size: 4.0 MB

Samsung SGH-F330.5LDASM

Open on: Friday, October 07, 2011 11:43:43 AM
Size: 950.0 KB

Pipe Vice.stp

Open on: Friday, October 07, 2011 11:42:51 AM
Size: 273.5 KB

Rotor.3D

Open on: Friday, October 07, 2011 10:53:01 AM
Size: 441.2 KB

Desktop Edition

Clear Wamings

Clear

SpinFire Help Access

The SpinFire “Help” access is now available via the new help website.

New Functions

Projected Plane Surface Area

This new dimensioning function allows you obtain the surface area of a part(s) as projected onto a plane.

Many customers can use this to help calculate the tonnage required to manufacture their parts, thereby eliminating the need to use a CAD system

for this function.
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New Plug-in:

Minimum Thickness
This Plug-in allows users to quickly find the location on the part with the minimum thickness and create a measurement markup.
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Updated Plug-in:
[Minimum Distance|http://help.actify.com/display/SF100/Minimum-+Distance
This updated Plug-in incorporates a new algorithm based on surfaces instead of tessellation nodes. This has greatly improved the accuracy of the

results.
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Importers

® A new importing engine has been developed that is now used in both the new CENTRO publishing product as well as SpinFire.

* New Importer Options feature allows the Options Panel to stay open when testing the settings. All Importers are accessible via a single
Interface.

® The “Auto Install” feature has been reinstated that automatically installs an importer when a supported file format is selected, but the
Importers had not yet been installed

® New AutoCAD Importer Option that allows importing DXF/DWG files in Black & White

® The new importer engine allows us to update importers on a monthly basis via the “Auto Install” routines. Expect to see UG and PTC PMI
support delivered via this mechanism over the next few months. Also coming in the same time frame will be the support of Rhino, Ideas
and Tiff.

Windows Integration

SpinFire now has better Windows 7 Integration. The application no longer runs in compatibility mode.
Preview .3D files has been added to Windows 7 and Vista 32 and 64 bit.

2D Workspace Enhancement

Easier display of Drawing Layers by adding Show/Hide All Layers function

Improved update management

When new or updated Importers and Plug-ins are released, a message will be displayed on the Home page of SpinFire as well as on the Importer
s and Plug-in pages.
Download and installation of importers and plug-in can be performed directly from within the application.

Video Demo
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Using The SpinFire User Interface

SpinFire™ User Interface
The following sections cover all of the menu items.
Home Component
Library Component
® Folder Context Menu
® File Context Menu
WorkSpace Component
¢ 3D Document Toolbar
® Assembly Object Context Menu
® 2D Document Toolbar
¢ Document Context Menu
Options Component
® Main
® Application Settings
® Importers
® Plug-Ins
® Activation
® General Options
® 3D Viewer Settings

® 2D Viewer Settings
SpinFire User Interface
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1. Menu Bar

Running across the top of the application window is the menu bar. Use these menus to call commands.

2. General Toolbar

Contains buttons for the following commands:

New Document menu: Adds a new blank 3D or 2D document to the WorkSpace.

Open menu:

Open WorkSpace: Opens a .3D file in the WorkSpace; any documents currently open in the WorkSpace wil be closed.

Import CAD File: Imports a CAD or image file; if the file is the appropriate type it will be imported into the active document; otherwise it will be
imported as a new document in the WorkSpace.

Save: Saves the documents currently open in the WorkSpace as a .3D file.

Email: Opens a new email with the current WorkSpace attached as a .3D file.

Print menu:

Print: Prints the currently open document.

Print Region: Lets you drag across a region in a 2D document to print.
Snapshot menu:

New Snapshot: Takes a snapshot of the 3D model and creates a new 2D document. See #Take a 2D snapshot of a 3D model for details.
Take Snapshot: Takes a snapshot of the active 3D model and copies it to the clipboard.

Insert Snapshot: Pastes a snapshot from the clipboard into an existing 2D document.
ImageData menu:

Image: Allows you to insert Bitmap or Vector (Hidden Line Removed) Images into Word, Power point, and Excel documents.

Data: Allows you to copy the SpinFire™ Design data into Word, Power point, and Excel documents. The Data includes the Assembly Tree, Parts



List, Markup Notes, and Dimension values.
Help: Opens the Help file.

Stop: A useful button that helps to cancel a command you have selected. Also restores buttons in the Document toolbar when they become
locked.

3. Components Tabs

On the left-hand side of your screen you will see the Components tabs. Click the tabs to access the SpinFire™ components. The SpinFire™
components are Home, Library, WorkSpace, and Options. New components may be added when a Plug-In for SpinFire™ is installed.

Here is a brief description of each component; click the link for a more complete description:
#Home: Information about your recent activity and current status.

#Library: Central location to access local files

#WorkSpace: Viewing area for 3D, 2D, and other documents. Provides commands for measurement and markup.

#Options: Information and controls for configuration and activation.

4. Component Display Area

This pane will display the selected component. Here is where the viewer for 3D or 2D CAD files will appear.
The user interface inside this component changes depending on the type of data you will import with SpinFire.

Quick Video Overview

Home Component
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The Home Page of SpinFire 10 provides contains the following sections:

Messages:

Up-to-date information about the license, notices about importers or plug-in updates and warning messages about components that may fail to
load or activate.

Recent Documents
In the Recent Document section of the home page SpinFire provides a list of the most recent open files (.3D or native CAD files). Along with the

file name SpinFire shows a small images of the model or drawing, the date when the file was last opened, and the size of the file. You can click on
any listed item to quickly open the file.

Status

The Status section indicates whether you have activated and registered SpinFire™ and displays the expiration date for maintenance. See Activat
e SpinFire™ for details.

Options
The Options Links provide access to the Options section of the application.

Links

These links allow you to reach important Web pages from Actify.

Library Component

The Library provides a central location to access files.
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. Library Toolbar - Contains buttons for the following commands:

® Add Local Folder: Adds a folder on your hard drive or network to the Library.
® Open: Displays a selected file in the WorkSpace.
® Properties: Displays the Properties dialog box.
® Delete: Deletes a selected file.
Connections Pane - Lists all the folders and subfolders in the Library.
Status Bar - Displays messages about the status of your files and folders.
File List - Lists the files in a selected folder.

File Context Menu

Commands for working with local files are available from the File context menu. Open the File context menu by right-clicking a file in the right
pane of the Library. The commands listed on the Folder context menu will differ slightly depending on the type of file.

Available commands are:

Open - Opens the file in the WorkSpace. Any models currently in the Viewer will be cleared before this file is open.

Import - Opens the file in the WorkSpace without clearing the Viewer. The model will be included in the same scene as any other models
currently in the Viewer.

Add Document - Adds the file as a new document in the .3D WorkSpace.
Copy - Copies the file to the clipboard.

Rename... - Renames the file.

Delete - Deletes the file.

Properties - Opens a dialog box listing file properties.

Folder Context Menu

Commands for working with local folders are available from the Folder context menu. Open the Folder context menu by right-clicking a folder in
the left pane of the Library.

Refresh - Updates the displayed contents of the folder.

Paste - Pastes any file in your clipboard to the folder.

Explore - Opens the folder in Windows Explorer.

Rename... (subfolders only) - Changes the name of a subfolder.
New Folder... - Creates a new subfolder.

Remove - Removes the local folder listing from the Library. (Note: this command will not delete the folder from your system; it will only
remove its listing in the Library.)

Properties - Displays folder properties.

WorkSpace Component
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The WorkSpace component displays models or drawings, and allows you to manipulate and markup your documents.

The WorkSpace works in three modes:

« 3D Mode: Displays .3D files and all 3D CAD files.

« 2D Mode: Displays certain 2D CAD formats, image files (.bmp, .jpg, .gif, .png, .tiff, .wmf, .emf), and Snapshots taken of 3D models.

« File Mode: Displays other file formats such as PDF, Microsoft Office, or text.
Not all the features listed below are available in both modes.

1. Document Toolbar

« 3D Document Toolbar: SpinFire™ opens .3D files and all 3D CAD files in 3D mode and displays the #3D Document Toolbar. The 3D
Document Toolbar contains buttons and menus for view, cross-section, and markup commands. See #3D Document Toolbar for details.

« 2D Document Toolbar: SpinFire™ opens certain 2D CAD formats, image files (.bmp, .jpg, .gif, .png, .tiff, .wmf, .emf), and "Snapshots" of 3D
documents in 2D mode and displays the #2D Document Toolbar. The 2D Document Toolbar contains buttons and menus for working with
drawings, markups, and the page. See #2D Document Toolbar for details.

2. Explorer

For 3D Documents...

« Assembly Pane: Displays the assembly tree which lists the subassemblies and parts that comprise a model. See #Working with Assemblies
and Parts for details.

* Markups Pane Lists the Dimension and Note labels that have been added to a model, as well the username of the person who created them
and the date they were last modified. See #Measuring and Annotating a Model for details. The Markups pane also lists the defined #coordinate
systems.

« Annotations Pane Lists the PMI (GD&T) annotations in the scene.

« Views Pane: Lists available views. You can choose perspective or isometric projection, or select one of the standard views. You can save a



"user view" of your own and select user views saved by others. See #Controlling the View for details.
For 2D Documents...

« Drawings Pane: Lists all drawings in the 2D scene.

* Markups Pane: Lists all markups that have been added to a 2D scene, as well the username of the person who created them and the date they
were last modified. See #Working with 2D Documents for details.
The button on the Document Toolbar can hide or show the Explorer.

3. Status Bar

Displays tips for using commands and information about your design.

4. Mouse Mode

Indicates which view command is called when you drag across the Viewport. Click this field to change the mouse mode. See #Controlling the
View for details.

Note: For 2D documents, there is also a picking mode field that indicates which element in the 2D scene you may select with the pointer:
« Page mode lets you pan, zoom, or rotate the contents of the Viewport.
« Drawings mode lets you select drawings.

* Markups mode lets you select markups.
You may switch between these modes by clicking the mouse or picking mode field.

5. Color Chooser

Offers a selection of background colors. Click the color bar to instantly choose a color. Or double-click the solid rectangle to the right to open the
color selection dialog box. In a 2D document, the color of the page will be changed.

6. Solid/Gradient Background Switch

(3D Documents Only) Switch that determines whether the background will appear as a solid color or a gradient.

7. Viewport

Displays the model or drawing.

8. Document Tabs

Tabs indicating all the documents open in the WorkSpace. You can view one of the documents by clicking its tab. You can open the Document
Menu by right-clicking on a tab.

2D Document Toolbar
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Whenever SpinFire™ opens certain 2D CAD formats, image files (.bmp, .jpg, .gif, .png, .tiff, .wmf, .emf), and "snapshots" of 3D documents, the
new document will be open in 2D mode and the 2D Document toolbar will appear.

(See Using the Command Button/Menus below to learn how the buttons and menus work to call commands.)

1. Hide/Show Navigation Pane

Controls the visibility of the navigation pane on the left side.

2. Page Menu
Contains the following commands for working with the page:
« Page Setup: Allows selection of a page's size, orientation, margins, and grid.

« Page Color: Allows selection of the page color.



« Snap to Grid: Enables/disables drawings and markups to snap to the grid lines on the page.
« Show Grid: Enables/disables the visibility of the grid lines on the page.
3. Zoom Menu

Contains the Zoom Fit and Zoom Window commands. Also lets you set Rotate, Pan, or Zoom as the default drag action.

4. Drawings Picking Mode

Allows you to select drawings from the scene.

5. Markups Picking Mode

Allows you to select markups from the scene.

6. Measurement Menu

Contains the following tools for taking measurements:
® Linear

° ® Direct Distance: Distance between two points.
® X Axis Distance: Distance between two points along the x-axis.
® Y Axis Distance: Distance between two points along the y-axis.

Radial
° ® Arc by 3 Points Diameter of a circle defined by three points selected by the user.
Angular
. ®* Angle by 3 Points: Measurement of an angle defined by three points selected by the user.

* Angle by 4 Points: Measurement of an angle defined by three points selected by the user.
® Polygonal Area: Surface area of a polygon defined by user-selected points.

7. Shape Menu

Contains various predefined geometric shapes. Text may be added to the shapes.
® Rectangle Tool
®* Rounded Rect Tool

® Qval Tool

8. Callout Menu

Contains various predefined geometric shapes. Text may be added to the shapes.
® Right Callout Tool
® Left Callout Tool

® Cloud Tool

9. Line Menu
Contains the following tools for drawing lines:
® Line Tool: Straight line.
® Polyline Tool: Multiple connected straight lines.
® Curve Tool: Curved line drawn around multiple points selected by the user.

® Closed Polyline Tool: Shape made from multiple connected lines.

10. Text Box

Text may be added to the drawing, with full control over font, size, and color.

Note: When a markup is picked in the 2D scene, additional tools for formatting a markup will appear on the 2D toolbar to the right of the Text Box



button. See Change the Formatting of a 2D Markup for details.

11. Stamp Menu

Contains several commonly-used stamps that may be added to the document.
® Accept Stamp
®* Approved Stamp
®* Rejected Stamp
® Confidential Stamp
® For Review Stamp
® Received Stamp
® Draft Stamp
® Preliminary Stamp

® Final Stamp

Using the Command Button/Menus

SpinFire™'s 2D toolbar uses combination command buttons and command menus to call commands. You can call any available command by
selecting it from the menu. Open a menu by clicking the drop-down arrow to the right of the button. Once you have called a command from the
menu, the button will feature the icon for that command. You can then repeat the last command you called by simply clicking the command button

For example, to create a cloud shape, you would select the Cloud Tool command from the Callout menu. If you wanted to call the Cloud Tool
command again, you could simply click the Callout button, which would now feature the Cloud tool icon. If you were to select a different command
(such as the Right Callout Tool) from the Callout menu, the Callout button would then be set to call that command.

Command buttons can be useful when you need to call the same command repeatedly. You can find out which command a button is set to call by
letting your pointer hover over a button and waiting for the pop-up box to display the name of the command.

Top
3D Document Toolbar
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(See Using the Command Button/Menus below to learn how the buttons and menus work to call commands .)

1. Hide/Show Navigation Pane

Controls the visibility of the navigation pane on the left side.

2. Part/Surface Picking Mode
Determines whether you will be able to use the cursor to select either parts or surfaces in the scene.
3. Color Menu

Controls the background color and determines whether the background is gradient or solid.

4. Display Menu

Controls whether all Note, Dimensions, Coordinate Systems, PMI Annotations will be displayed in the scene. Determines whether the rulers and
grid will appear in Standard 2D Views. Enables and Disables Animated Transitions.

5. Multiple Viewports

Contains commands for splitting your Viewport into 2 to 4 Viewports. See Controlling the View for details



6. Projection Button

Determines whether perspective or parallel projection will be used in the scene. See Controlling the View for details

7. Render Menu

Determines how geometries in the scene will be rendered.

8. Zoom Menu

Contains options for zoom and focusing the view. See Controlling the View for details

9. Cross-Section Menu

Contains the commands for displaying a cross-section plane. See Cross-Sectioning a Model for details.

10. Notes

Contains commands for inserting a Note markup label. See Measuring and Annotating a Model for details.

11. Linear

Contains commands for measuring lengths, coordinates, and edges. See 3D Markups Dimensions Reference and Measuring and Annotating a
Model for details.

12. Radial

Contains commands for measuring arcs. See 3D Markups Dimensions Reference and Measuring and Annotating a Model for details.

13. Angular

Contains commands for measuring angles. See 3D Markups Dimensions Reference and Measuring and Annotating a Model for details.

14. Units drop-down

Contains the units drop-down to change the units of a single dimension.

15. Coordinate System

Opens a dialog box for creating a new coordinate system. See Add a Coordinate System for details.

Using the Command Button/Menus

SpinFire™'s 3D Document toolbar uses combination command buttons and command menus to call commands. You can call any available
command by selecting it from the menu. Open a menu by clicking the drop-down arrow to the right of the button. Once you have called a
command from the menu, the button will feature the icon for that command. You can then repeat the last command you called by simply clicking
the command button

For example, to measure the diameter of an arc, you would select the Arc Diameter command from the Dimension menu. If you wanted to call the
Arc Diameter command again, you could simply click the Dimension button, which would now feature the Arc Diameter icon. If you were to select
a different command-sueh-as-Mertex-Geerdirates-from the Dimension menu, the Dimension button would then be set to call that command.

Command buttons can be useful when you need to call the same command repeatedly. You can find out which command a button is set to call by
letting your pointer hover over a button and waiting for the pop-up box to display the name of the command.

Top
Assembly Object Context Menu

Commands for working with an object in assembly parts, assemblies, and sub-assemblies are available from the Assembly Object context menu.
Open the Assembly Object context menu by right-clicking a node in the Assembly Tree (located on the Model tab of the WorkSpace component).
You can also open the menu by right-clicking a part on the model itself.

To select multiple objects from the Assembly Tree, use Ctrl+Click or Shift+Click and then open the right-click context menu to call commands on
all the selected objects. (To select multiple parts from the model itself, use Ctrl+Right-click.)

The following commands are available from the Assembly Object context menu:

Hide/Show



Hides or shows the object.

Show Only

Hides all parts except for the selected objects. The top node of the assembly cotains the Show All Parts command instead of Show Only.

Focus

Zooms in on the object and places it at the center of the view.

Color

Determines the color of the object. From the submenu you can choose whether you want the color applied to the front (exterior) of the object, the
back (interior) of the object, or both.

Transparency...

Determines the transparency of the object.

Render Mode

Determines how an object will be drawn on screen. The submenu offer the following modes:
« Wire Frame: Transparent outline of each segment.

« Triangle Mesh: Outline of the triangles used to establish the shading.

« Flat Shading: The triangles are colored but the edges of the triangles are visible.

* Smooth Shading: Smoothes the edges of the triangles. This is the default render mode.

« Smooth Shading with Edges: Smooth Shading with highlighted edges.

« Hidden Lines: Similar to wire frame but the segments are not transparent.

« Reflective: Shiny metallic rendering.

» Metallic: Dull metallic rendering.

« Surface Analysis: Reflective rendering for analyzing surface irregularities.

Display

The Display submenu determines whether the vertices, points, wire-frame entities, and surfaces and solids of an object will be displayed.

Section

Enables and disables the cross-section cut and profile for the object. This command is enabled by default. This command is available only when a
cross-section plane is enabled.

Transform

The Transform submenu provides commands to precisely position an object.
» Rotate: Rotates the object along an axis.

« Translate: Positions the object along the X, Y, and Z axes.

« From/To Coordinates: Takes the object’s position with respect to one Coordinate System and transforms it to that same position with respect to
a different Coordinate System.

« Mirror: The Mirror submenu provides commands to mirror the object along a plane.
* Handles: Creates a box with handles around the object that allows for free translation and rotation of the object.
Delete

Deletes the object from the assembly.

Rename

Renames the object. You will type the new name and press Enter.



Properties

Displays properties of the object.
Document Context Menu

Commands for working with a document in a .3D WorkSpace are available from the Document context menu. Open the Document context menu
by right-clicking the document tab.

Available commands are:

New

Adds a blank 3D or 2D document to the WorkSpace.

Add...

Imports a new document into the .3D WorkSpace.

Remove

Closes a document from the .3D WorkSpace.

Rename...

Changes the name of the document. The new name will appear in the tab.

Reorder...

Changes the order of the document tabs in the workspace. This is important because when a WorkSpace is saved as a .3D file the first document
determines the image that appears when a user uses Windows thumbnail view to list files in a folder. Also, the first document will be what a user
who views that file using some older versions of SpinFire™.

Close WorkSpace

Closes all the documents in the .3D WorkSpace.

Options Component

The Options component contains pages for you to activate SpinFire™, check configuration information, and change default settings.
The Options component contains the following pages:

« Application Settings Lets you establish default settings for the application. details...

« 3D Viewer Settings: Lets you establish default settings for 3D documents. details...

« 2D Viewer Settings: Lets you establish default settings for 2D documents. details...

« Importers: Lists the installed and available importers. details...

 Plug-Ins: Lists the installed and available plug-ins. details...

« Activation: Lets you Activate SpinFire™. details...

« Registration: Lets you register your copy of SpinFire™ with Actify.
See Activate SpinFire™ for details.

Application Settings

The Application Settings page of the Options component allows you to set options that affect the SpinFire™ program.



SpinFire 10

Importers You can determine how often SpinFire checks for the availability of
updates to the application and importers.

Check For Updates  Every Day -

Plug-ins

Activation

Registration Importers Autodeploy installs automatically a compatible importer
when you try to load a CAD file that is not available in your
configuration.

This option requires an active Internet connection.

Importers AutoDeploy

Set here how many items you want in the Recent Documents list in

the Home page. Items shown in the home page 10 ~

When SpinFire starts it detects if there are updates available for
importers or plug-ins.

This option allows to enable/disable messages about updates in
the home page for new importers or plug-ins.

Available update messages

Apply Settings

Check For Updates

Determines how often SpinFire™ will check for updates to the program and the importer software. SpinFire™ checks for updates by accessing
the Internet.

Whenever an update is available, this will be indicated on the Importers page of the Option component. You may then download and install an
update by clicking Download.

Importers AutoDeploy

When this setting is checked, when loading a native CAD file the proper importer will automatically download and install if your system doesn't
have it installed already.

This option requires an active Internet connection.

Items shown in the home page

Determines how many most recent open documents are shown on the home page. Select from 0 to 10.

Available update messages.

This option allows to enable/disable message about updates in the home page for new importers or plug-ins.

Related topics

Options Component

Working with CAD and .3D Files

3D Viewer Settings

The 3D Viewer Settings page of the Options component lets you establish default settings for 3D documents.

After you have made desired changes to the 3D Viewer Settings page, be sure to click the Apply Settings button located at the top and bottom of
the page.



SpinFire 10 3D Viewer

Importers Graphics

[¥] Zoom-fit on each import
[¥] vertices visible on picking
Activation [¥] Automatic 2D detection
Enable 3D auto-spinning
Enable Gradient Background

Background -

Animations

Plug-ins

Registration

Slower & @ @ (O © Faster Animations
Views and Viewports

Display ruler

[¥] Display grid

[T Display cursor coordinates in 2D

@ 1% angle @ 39 angle Projection

Measurements
Decimal Places 2 E
Units  Millimeters -
Volume Precision  Medium -

Label Fonts and Colors
Font [ MS Shell Dig 12Pt Bold

Background | Color...

Sample Text
Apply Settings

Graphics

« Zoom-fit on each import: Will perform a Zoom Fit whenever you open a CAD design. Otherwise, the view will reflect the camera position of the
original CAD file.

« Vertices visible on picking: Will indicate available vertex points with red dots during any command that requires a vertex to be selected.

« Automatic 2D detection: Will load 2D CAD designs in 2D mode.

« Enable 3D Auto-Spinning: Will cause a 3D model to spin continuously when rotated quickly.

« Enable Gradient Background and Color: Determines the if a gradient background is used as a default. Click the Color button to set the default

background color.
Note: SpinFire 10.0 .3D files save background information. Default background settings do not apply to these files.

Animations

« Slower/Faster Animations: Determines the speed of animated transitions between views.

Views and Viewports
Determines whether the ruler and grid are visible in the "Standard Views"--Top, Bottom, Front, Back, Right, Left--and whether the coordinates of

the cursor will be displayed for standard views. The 1st Angle and 3rd Angle options determine the layout projection that will be used when the
model is displayed in 4 Viewport mode.

Measurements

« Decimal Places: Determines the default number of decimals places that will be displayed in measurement labels.

« Units: Determines the default unit of measurement for Dimension markups. Units of measurement for individual Dimension markups can be
changed from the right-click menu. See Change the Units of a Single Dimension for details.

« Volume Precision: Determines the resolution at which the volume is computed. Higher precision gives greater accuracy but may slow down



operations with the model.

Label Font

Click the buttons to determine the font and color of markup labels.

Related topics
Options Component
2D Viewer Settings

Controlling the View

2D Viewer Settings

The 2D Viewer Settings page of the Options component lets you establish default settings for the 2D Viewer.

After you have made desired changes to the 2D Viewer Settings page, be sure to click the Apply Settings button located at the top and bottom of
the page.

Sp inFire 10 2D Viewer

Settings
Importers Page
iy Units  Millimeters -
Plug-ins
Size A(210x287Tmm) ~
Activation . ; — 22
Orientation  Paortrait ©) Landscape @
Registration
g Grid Size ¥ A y: 5 Millimeters.
Margins -8 ¥ .8 Millimeters

Background I:I

Shadaows Uncheck to turn off 2D Shadowing.

Measurements
Decimal Places 2 -
Units  Millimeters -

Label Fonts and Colors
Label Font | MS Shell Dig 12Pt Bold

[ Sample Text

Apply Settings

® Units - Determines the units that will be used to establish the default Grid Size and Page Border (see below).

® Size - Determines the default page size for 2D documents. Page size for an individual document can be changed by calling the Page
Settings command from the toolbar.

® Orientation - Determines whether the page will have a landscape or portrait orientation. Page orientation for an individual document can
be changed by calling the Page Settings command from the toolbar.

® Grid Size - Determines the grid size along the x-axis and y-axis, respectively. Grid size for an individual document can be changed by
calling the Page Settings command from the toolbar.

® Margins - Determines the margins of the page. First field sets the left/right margin. Second field sets top/bottom margin. Margins for an in
dividual document can be changed by calling the Page Settings command from the toolbar.

® Background - Determines the default background color of the page in a 2D document.



® Shadow - By un-checking this box the light shadow that appears around 2D markup is removed. This shadow allows to more easily
distinguish the drawing from the added markup.

Measurement

® Decimal Places - Determines the default number of decimal places for measurements. Decimal places for individual measurements can
be changed from the right-click menu.

® Units - Determines the default unit of measurement. Units for individual measurements can be changed from the right-click menu.

Label Font

Determines the default font markups and measurements.

Fonts for individual markups and measurements can be changed from the toolbar.

Related topics
Options Component

Controlling the View

Importers

The Importers page of the Options component lists version information for installed and available importers.

SpinFire 10

Install, configure, and update importers used by SpinFire to open CAD files. [ Refresh Importer Info ]
Importers Name Bunp STATUS ASSOOATE CONFIGURE
Plug-ins ®  Adobe PDF 1540.4 Active &
GEREL Adobe PRC (Product Representation Compact) 1540.4 Active ]
e ®  Autodesk AutoCAD 15404 Active B
(®  Autodesk Inventor 1540.4 Active ]
®  CATIAV4 1540.4 Active B
®  CATIAVS 1540.4 Active m
®  CGM 15404 Active B
®  HPGL 1540.4 Active m
®  I1DEAS 15404 Active B
®  IGES 1540.4 Active m
® JT 15404 Active B
®  NX (Unigraphics) 3D and 2D 15404 Active [
®  Parasolid 1540.4 Active [}
®  PTC Pro/ENGINEER 1540.4 Active "
®  SolidEdge 1540.4 Active B
®  SolidWorks 1540.4 Active =

Importers are software modules that give SpinFire™ direct access to your native CAD files. To view a file in a certain format you will need to have
the importer for that format installed. For a complete list of importers available from Actify, go to the SpinFire™ Formats page.

This page will indicate if new versions of the importers are available and provide links to download. You are entitled to product updates for the
length of your maintenance period. To set how often SpinFire™ checks for updates, set "Check for Updates" on the Application Settings page.

The Importers page provides the following information for each installed importer:

Name


http://www.actify.com/products/spinfire-cad-solution-system/cad-system-file-importer/

Importers are usually named after the CAD file format they import. For more information about an importer, click the icon to the left of the
component hame.

Whenever an update is available for an importer, this will be listed underneath the component name. For example, "(Build 650: Download 235
Kb)" where 235 Kb is the size of the update download. To update the importer, click Download. Once you have successfully updated the
importer, the "Download" text will disappear, and the build number of the importer will be updated. You are entitled to importer updates for the

length of your maintenance period. You can determine how often SpinFire™ checks for available updates from the Application Settings page of
the Options component.

Build

This is the version number of the importer. Knowing the build number is important for technical support.

Status

If you have purchased the importer, the status will be "Active," indicating that you have full use of the importer. Otherwise, if you are in Reader
mode or are not licensed to use the importer, the status will show as "Inactive".

Associate

Click to check this box to associate the specific importers file extensions to be associated to SpinFire. Double clicking on an associated native
CAD file in the Windows Explorer automatically opens the file into a new session of SpinFire.

Options
The Options button opens up a dialog box which features settings for Filtering Options like Attribute, Type and Tessellation available for that

importer. Each importer has different options available. Some common options associate file extensions with the importer, determine the default
unit of measurement, set the precision of trimesh approximation, and select filters for entities associated with that file type.

.,
_ Importer Settings for SpinFire lL l = | (0 S|
: v|

’|VCM'IA va

Importer for Catia Model, Export and Session files. Supports 2D and 3D Catia files up to version 4. This
importer works ONLY with SpinFire 9.0 or higher, Publisher 3.4 or higher and PubCore 4.0 or higher.

Import 2D documents [V]

Import hidden entities []

Import layers as separate parts [V

]

Import solid parts

1<

Import surfaces |

[F
|

]

Import wire frame entities |

1

Join surfaces of each single part
Run in silent mode [¥]

Tessellation custom precision 1

Tessellation quality [Medium -

4

Reset to Defaults [ QK | [ Cancel | [ Apply |
|

=

After you have made desired changes in the dialog box, be sure to click the OK button located at the bottom of the dialog box.

Related topics
Options Component

Working with CAD and .3D Files
Plug-Ins



Plug-ins are pieces of software that add functionality to SpinFire™. A plug-in might add a new component tab to the program or it may add a new
object to the toolbar. For information about how a particular function works, see the documentation provided by the author of the plug-in.

SpinFire 10 Plug-ins

Settings Installed Plug-Ins: Here you can update existing plug-ins or install Refresh Plug-In Info
9 new ones. Use the Enable check-box to enable/disable a plug-in next

Importers time you start SpinFire.
Plug-ins

NAME Bulp ENABLE CONFIGURE
LA (® Automated Excel 1540.4 Options
Registration By: Actify Inc.

® Draft Angle Analysis 15404

By: Actify Inc.

Requires a License

This plugin helps to analyze one or more parts in an assembly for draft. It gives visual feedback
on what level of draft angle has been applied to the selected surfaces when compared to a 'pull
direction’, with different colour shades for the drafts, it is easy to see if the part can be

machined.
(®) Weight Calculator Plugin 1540.4 Options
By: Achelon
AVAILABLE PLUG-INS FOR DOWNLOAD

Name Avanaste Bup Size DowNLOAD
®  Exploded Assembly 1540.4 3 MB Install
®  Model Compare 1540.4 2 MB Install
(®  Parts List Generator 1540.4 2 MB Install
(®  SpinFire STL Export 1540.4 2 MB Install
(¥  SpinFire XSection Plus 1540.4 2 MB Install
()  Minimum Distance 1540.4 3 MEB Install
)  Automatic Parts Labeling 1540.4 3 MB Install

There are two types of plug-ins listed on this page:

1. Plug-Ins with Integrated Activation - from Actify: Plug-ins created by Actify.
2. Generic Plug-Ins: Plug-ins created by a third party that have not been certified by Actify and cannot be activated using the Actify license.

For third party plug-ins, the Producer of that plug-in will be listed. From the Enabled column, you can enable or disable any installed plug-in.

Related topics

Options Component

Configuring and Activating SpinFire

Activation

The Activation page lets you activate your copy of SpinFire™ using either a Seat ID or a license file. See Activate SpinFire™ for details.

SpinFire requires a license to activate. You should have received a SeatID code with the purchase of SpinFire. If your computer is not connected
to the Internet you must use a license file to activate the software.

This page also contains information about your license of SpinFire™. This information may be needed when receiving technical support.



Activation

SpinFire 10

Settings SeatiD :  00-000-00000000000000000000000
Importers Computer ID : ACTYO75481
Plug-ins License Error :  Unknown

Activate Online

Activation

Registration

License File

SpinFire requires a license to activate. You should have received a SeatlD code with the purchase of SpinFire.
If your computer is not connected to the Internet you must use a license file to activate the software.

Check the On-line Help to request a copy of your license file,

Read License File...

Related topics

Options Component
Configuring and Activating SpinFire
Registration

To register the product online, enter all required information in the fields and click Register.
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SpinFire 10

Settings SeatiD 09-338-1160481308038822

Importers *First Name Address
i *Last Mame City

Plug-ins ~Company ctate

Activation “Country o Zip Code

Registration *E-mail Phone

*Required fields

Register Online ]

Why Register?

Registering your seat of SpinFire ensures that you receive:
¢ Premier customer and technical support
» Naotification of new and updated importers

Tips and tools for getting the most out of SpinFire
« Mew release and upgrade opportunities
+ Maintenance renewal opportunities

Fill the form above and click the "Register” button or
ister by Fax Register by Mail Print this Page

Privacy Policy

The information here submitted will not be released to anyone outside Actify or used for any other purpose
other than those described in the "Why Register?” section above.

For information about registering by fax, click the Register by Fax link.
For information about registering by mail, click the Register by Mail link.

For print out your registration information, click the Print this page link.
Related topics
Options Component

Configuring and Activating SpinFire

Controlling the View

Controlling the View

SpinFire™ gives you several options to control your point-of-view of a scene.

Understanding the "View"

It is important to distinguish between shifting your view of a scene and moving the contents of the scene itself. You can think of your view as
looking at a model through a remote-controlled camera,; rotating, panning, or zooming the point-of-view moves the camera, but the contents of the
scene remain stationary. (Of course, SpinFire™ also has commands for moving a 3D assembly itself. See Working with Assemblies and Parts for
more information.) The focus point and center of rotation of your view will always be at the center of your Viewport.

Rotate, Pan, and Zoom

The three basic commands for manipulating your view are Rotate, Pan, and Zoom.

The basic drag command is specified by the mouse mode. The mouse mode is listed in the status bar an the bottom of the application window.



You can change the mouse mode by clicking this mouse mode listing in the status bar or by right-clicking an empty area in the scene and clicking
a mouse mode.

Rotate is the default mouse mode for 3D documents. Pan is the default mouse mode for 2D documents.
You may call use a view command other than the default by using the following keyboard shortcuts:
3D Documents

®* Rotate---Drag

® Pan---Shift+Drag (May also pan by holding down the mouse wheel button, if available)

® Zoom---Ctrl+Drag (Drag down to zoom in and up to zoom out. May also zoom by clicking in the Viewport and rotating the mouse wheel, if
available)

2D Documents

®* Pan---Drag

® Rotate---Alt+Drag

® Zoom---Ctrl+Drag (Drag down to zoom in and up to zoom out. May also zoom by clicking in the Viewport and rotating your mouse wheel,
if available)

View Commands

SpinFire™ provides powerful commands to establish the focus of your view:

Zoom a View pans and zooms to provide a close-up view of the model while still fitting the model entirely within the Viewport.

Zoom on a Single Part zooms in on a part in an assembly and sets the center of that part to the center of your view.

Focus on a Single Point pans until a selected point is at the center of your view.

Zoom a User Defined Area zooms in on a rectangular area you select by dragging across the model.

Focus on a Coordinate System Pans until the origin point of the coordinate system is in the center of your view. Call this command from
the right-click menu of a coordinate system.

Animated Transitions

Transitions from one view to another can occur either instantaneously or as a smooth, animated action depending on whether the Enable or
Disable Animated Transitions option is enabled or disabled.

User Views

A "user view" is a view of the 3D scene that has been saved by a user. User view information is saved in Actify's .3D file format. You can add a
user view or access saved user views from the Views tab of the WorkSpace component. A user view may be selected as the "startup view"
displayed when the file is opened.

A user view may consist of just the position of the "camera” (the "view" we have been discussing). A user view may, however, also include part
rotations and translations that are specifically applied to that user view. For example, you might perform a rotate or translate command on a part
of your assembly and apply that rotation to one of the user views. The part transformation will not be saved on the assembly, but it will be included
in the specified user view.

A user view may include the camera position, geometry information, and cross-section position. To apply camera, geometry, or cross-section
information to a view for the first time, right-click the user view item and click Capture Camera, Capture Geometry, or Capture Section. To
update or remove camera, geometry, or section information, expand the user view item and right-click Camera, Geometry, or Section.

Perspective vs Isometric Projection

SpinFire™ uses two kinds of 3D projection to display an assembly: Perspective and Isometric. Perspective projection displays the model in a
realistic manner, the way the object appears to the human eye. This way of drawing, however, can create distortions. Isometric projection
maintains accurate scale for the model---lines remain in proportion, parallel lines remain parallel. Isometric projection is very common on technical
drawings and is widely used by mechanical draftsman and engineers. You can switch between Perspective or Isometric projection by clicking the
Projection button in the 3D Document Toolbar.

Standard Views

SpinFire™ also provides a set of "Standard Views" for a 3D scene. These Standard Views are 2D Standard, Top, Bottom, Front, Back, Right, Left,
and Cross-Section. The Cross-Section view displays the cross-section profile when a cross-section plane is enabled. Select these Standard
Views from the Views tab in WorkSpace.

The Top, Bottom, Front, Back, Right, and Left views may display a ruler, grid, or real-time cursor tracking. To enable or disable these options, go
to the 3D Viewer Options page of the Options component and clear or select the options under Standard Views.



Multiple Viewports

SpinFire™ allows you to look at multiple views simultaneously. You can split your Viewport into as many as four different Viewports. A Viewport
configuration can be very useful to look at your 3D assembly from a planar view while keeping one eye on the whole 3D shape.

The following options are available from the Multiple Viewports menu on the 3D Document toolbar:

4 Viewports---four equal Viewports
2 Horizontal Viewports
2 Vertical Viewports

°
°
°
® 3+1 Viewports---three small Viewports on the left, one large Viewport on the right.

You can work with the models in each of the Viewports just as you normally would. By default, one of the Viewports will contain the same view
you were viewing, while the other Viewports will contain standard views. You can easily resize the Viewports by dragging the separation borders
with the pointer.

You can set whether a 4 Viewport layout uses 1st angle projection or 3rd angle projection from the 3D Viewer Settings page of the Options
component.

Related topics

Rotate a View

Pan a View

Zoom a View

Fit an Entire Model within the Viewport
Zoom on a Single Part

Focus on a Single Point

Zoom a User Defined Area

Focus on a Coordinate System

Enable or Disable Animated Transitions
Split the Viewport

Save a View

Choose Isometric or Perspective Projection

Apply a Part Transformation to a User View

You may apply a part rotation or translation to a specific user view rather than to the part itself. The selected user view will then contain the part
transformation you specified.

Note: It is strongly recommended that you create a "startup" view before applying a transformation to any user view.

To apply a part transformation to a user view

. From the Assembly tab, select the objects you want to transform.You can select multiple objects using Ctrl+Click or Shift+Click.

. Right-click a selected object in the assembly tree.This opens the Assembly Object context menu.

. Point to Transform and select Rotate or Translate.This opens the Transformation Panel.

. Enter the appropriate information in the dialog and click Apply.You will see the transformation take place in the Viewport. See Rotate an
Object in an Assembly or Translate an Object in an Assembly for details.

. Open the Views tab.

. Expand the listing of the User View you want to apply the transformation to.

. To apply geometry information to the view for the first time, right-click the user view item and click Capture Geometry.

. To update geometry information, expand the user view item, right-click Geometry, and click Update Geometry.
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Note

« If you would like the user view to contain only the part transformations and not a camera position, expand the user view in the Views tab,
right-click Camera, and click Remove Camera.

Related topics

Working with Assemblies and Parts

Controlling the View



Rotate an Object in an Assembly
Translate an Object in an Assembly

Save a View

Change the Mouse Mode

The "mouse mode" determines what the default behavior of the mouse pointer will be. You can determine (and change) the current mouse mode
from the mouse mode fields located at the bottom of the WorkSpace Component application window.

3D Mouse Modes

Documents in 3D mode have the following mouse modes that determine how the view will be changed when the pointer is dragged across the
Viewport:

* Rotate
* Pan
e Zoom

« X-Section: This mouse mode is only available when a cross-section plane is enabled. It will cause the plane to be moved along its normal
vector.
2D Mouse Modes

Documents in 2D mode have mouse modes that determine which elements can be selected in the 2D scene. In addition, the Page mouse mode
has further mouse modes that determine whether the pan, zoom, or rotate command will be the default for moving the elements in the Viewport.
The 2D mouse modes are:

* Rotate
* Pan

e Zoom
2D Picking Mode

A 2D document contains the page, markups, and drawings. The picking mode will indictate whether you can "pick" a markup or drawing in the
document so that you can call command on that object. The available picking modes are:

« Page: User may pan, zoom, or rotate the page and all the contents within the Viewport. The mouse pointer will appear in the shape of a hand.
When this mode is selected you can change the default mouse command (Pan, Zoom, or Rotate) by clicking the mouse field in the bottom of the
application window or by right-clicking anywhere in the Viewport.

« Drawings: User may select drawings in the scene.

* Markups: User may pick markups or measurements in the scene.

Ways to change the mouse mode

® Click the mouse mode (or picking mode) fields at the bottom of the SpinFire™ window.
® Right-click an empty spot in the scene and select a mode from the menu.
® Select from the Zoom menu on the 3D Document Toolbar or 2D Document Toolbar

Related topics

Controlling the View

Working with 2D Documents

Choose 1st Angle or 3rd Angle Projection

The 3D Options page lets users chose a default Viewport Layout Projection of either 1st angle or 3rd angle. The projection angle affects how the
views of the model are displayed in 4 Viewport mode.

To choose the angle projection:

Select the Options component

Click 3D Viewer Options link.This link is located on the left of the page.
For the Viewport Layout Projection, select 1st Angle or 3rd Angle.
Click the Apply button.
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Related topics



Controlling the View

3D Viewer Settings
Choose Isometric or Perspective Projection

To choose isometric or perspective projection:
1. Click the Perspective/Parallel Mode button on the 3D Document Toolbar.
Note

* You may also choose Isometric projection from the Views pane by clicking Standard Isometric under Standard Views.

Related topics
Controlling the View
WorkSpace Component

Save a View

Enable or Disable Animated Transitions

To enable or disable Animated Transitions, simply select Animated Transitions from the Display menu in the 3D Document Toolbar.
You can tell when it is enabled because the Animated Transitions icon will be highlighted.
Note

« In the "3D Viewer Options" page of the Options component, you can determine the speed of animated transitions.

Related topics

Controlling the View

3D Document Toolbar

Enable or Disable Cursor Tracking in 2D Views

You may choose whether the Top, Bottom, Front, Back, Right, and Left 2D views will display the cursor coordinates. The x- and y-coordinates will
be tracked in real time along the rulers.

To enable or disable cursor tracking in 2D views:

Select the Options component.

Select the 3D Viewer Options page.

In the Standard Views section, select or clear the check box beside Display cursor coordinates in 2D.
Click the Apply button at the top or bottom of the page.
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Note
« The rulers must be enabled in order for cursor coordinates to be visible.

« Changes will not take place until a new document is made active in the WorkSpace.

Related topics

Controlling the View

Enable or Disable Rulers in 2D Views
Enable or Disable the Grid in 2D Views

Enable or Disable Rulers in 2D Views

You may choose whether the Top, Bottom, Front, Back, Right, and Left 2D views in a 3D document will display a ruler.

To enable or disable rulers in 2D views:

1. Select the Options component.
2. Click 2D Viewer Options.
3. Inthe Standard Views section, select or clear the check box beside Display ruler.



4. Click the Apply button at the top or bottom of the page.
Note

« Changes will not take place until a new document is made active in the WorkSpace.

Related topics

Controlling the View
Enable or Disable the Grid in 2D Views

Enable or Disable Cursor Tracking in 2D Views

Enable or Disable the Grid in 2D Views

You may choose whether the Top, Bottom, Front, Back, Right, and Left 2D views will display a grid.

To enable or disable the grid in 2D views:

. Select the Options component.

. Select Settings.

. Click 3D Viewer.

. In the Standard Views section, select or clear the check box beside Display grid.
. Click the Apply Settings button at the top or bottom of the page.
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Related topics
Controlling the View
Enable or Disable Rulers in 2D Views

Enable or Disable Cursor Tracking in 2D Views

Fit an Entire Model within the Viewport

The Zoom Fit button on the 3D Document toolbar and 2D Document Toolbar pans and zooms to provide a close-up view of the document
contents while still fitting the contents entirely within the Viewport.

The Zoom Fit command may also be called by right-clicking the background in the scene and selecting Zoom Fit from the menu.

Related topics
Controlling the View
3D Document Toolbar
Split the Viewport
Zoom on a Single Part

Zoom a User Defined Area

Focus on a Coordinate System

A scene always contains the Global Coordinate System and may contain additional coordinate systems. The Focus command sets the origin point
of a coordinate system to the center of your view.

To focus on a coordinate system:

1. Right-click a coordinate system.This may be done either in the Markups pane or in the scene.
2. Select Focus.

Note
* You may also call the Focus command by double-clicking the coordinate system listing in the Markups tab.

* The Coordinate System Properties dialog box also has a button that calls the Focus command.

Related topics

Controlling the View

Using Multiple Coordinate Systems



Zoom a View

Fit an Entire Model within the Viewport
Zoom on a Single Part

Focus on a Single Point

Zoom a User Defined Area

Focus on a Single Point

The Focus on Point command shifts the center of the view to a selected vertex point on the assembly. The center of the view is also the center
of rotation.

To focus on a point:

1. Open the Focus menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Focus button. You should see a
drop-down menu listing the available commands.

2. Pointto Focus.

3. Click Focus on Point.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly
positioned over a vertex point.

4. Click a vertex on the model.The vertex point will shift to the center of the view.

Related topics
Controlling the View

3D Document Toolbar
Zoom on a Single Part
Zoom a User Defined Area

Display Vertex Coordinates

Hide or Show Coordinate Systems

A frame in the scene indicates the origin point (0,0,0) of a coordinate system and the direction of the x-, y-, and z-axes. Every scene contains the
global coordinate system and may contain user-defined coordinate systems as well.

The each coordinate system in a scene can be identified by a three pronged triad that indicates the x-, y-, and z-axis. You may hide these
coordinate system triads.

To hide or show all coordinate system triads:

1. Open the Display menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Display button. You should see a
drop-down menu listing the available commands.
2. Click Coordinate Systems.

To hide or show an individual coordinate system triad:

1. Select the Markups pane in the WorkSpace component.
2. Clear or select the check box next to the name of the coordinate system.

Note

« You cannot individually hide the active coordinate system triad.

Related topics

Using Multiple Coordinate Systems
Delete a Coordinate System
Add a Coordinate System

Pan a View

Panning shifts your view up-down or right-left.

To pan the view:



1. Make sure Pan is selected as your mouse mode. How?The status bar at the bottom of the SpinFire™ window lists the current mouse
mode (Rotate, Pan, Zoom). To change the mouse mode, click the text of the mouse mode in the status bar.

2. Press and hold the left mouse button.

3. Drag in the direction you desire.

Note

« Pan is the default drag action for 2D documents.

« For a 3D document, you may also pan by pressing Shift+Click and dragging.

« If you have a wheel mouse, you can pan by pressing the wheel button and dragging.

» The arrow keys may also be used to pan the view when in Pan mode.

Related topics
Controlling the View
Rotate a View

Zoom a View

Rotate a View

You can use your pointer to freely rotate your view of the contents of the document. Remember that the center of rotation will be in the center of
your Viewport.

To rotate the view:

1. Make sure Rotate is selected as your mouse mode. How?The status bar at the bottom of the SpinFire™ window lists the current mouse
mode (Rotate, Pan, Zoom). To change the mouse mode, click the text of the mouse mode in the status bar.

2. Press and hold the left mouse button.

3. Drag in the direction you desire.

Note
« This operation rotates your view, not the actual assembly or drawing. To rotate a 3D assembly itself, see Rotate an Object in an Assembly

* The arrow keys may also be used to rotate the view of a 3D document when in Rotate mode.

Related topics
Controlling the View
Pan a View

Zoom a View

Rotate an Object in an Assembly

Save a View

You can save any view of your 3D document and choose from previously saved "user views" from the Views tab in the WorkSpace.

A user view may consist of just the position of the "camera" or it might also include part rotations and translations that are specifically applied to
that user view.

To save a view:

. Position your view of the model to the one you want to save.

. Click the Views tab.

. Right-click User Views.

Click New...

. Type a name for your view and click OK.Your view will appear under User Views along with your username and the time it was saved.

ghwWN PR

Note
« If you don't see your saved view listed in the Views tab, double-click User Views to expand the list.
« If you would like your user view to include part transformations, see Apply a Part Transformation to a User View

« If you would like the user view to contain only the part transformations and not a camera position, right-click the user view in the Views tab and
select "Remove Camera".



* To apply a camera position to a user view, right-click the user view in the Views tab and select "Update Camera". The current camera position
will be applied the user view.

Related topics

Controlling the View

WorkSpace Component

Apply a Part Transformation to a User View
Choose Isometric or Perspective Projection

Save a Design as a Bitmap, JPEG, or EMF

Set the Startup View

A .3D file will normally open in the view that it was last saved in. You can change this by setting one of the saved user views as the startup view.
The .3D file will always open with the startup view.

To set the startup view:

1. Save a view you want, if it has not been saved already.
2. Right-click the name of the user view you want in the Views tab.This opens the User Views context menu.
3. Click Startup View.When the right-click menu for the current startup view is opened, the Startup View command will be checked.

Related topics

Controlling the View

Save a View

Split the Viewport

You can look at multiple views of your model at the same time by splitting your single Viewport into 2 to 4 Viewports. The options for multiple
Viewports are

4 Viewports---four equal Viewports

2 Horizontal Viewports

2 Vertical Viewports

3+1 Viewports---three small Viewports on the left, one large Viewport on the right
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To split the Viewport, open the Multiple Viewports menu on the 3D Document toolbar and click the option you want.
Note
« To resize the Viewport, drag a separation border.

« To go back to a single Viewport, click the multiple viewport icon on the toolbar.

Related topics

Controlling the View
3D Document Toolbar
Fit an Entire Model within the Viewport

Zoom a User Defined Area

The Zoom Window command zooms in on a rectangular area you select by dragging across the model.

To zoom a user defined area:
1. Select Zoom Window from the Focus menu in the 3D Document toolbar.

2. Drag across the area you would like to zoom in on.A rectangle shows the boundries of the area you are selecting.
3. Release the mouse button.The area you selected will fill your view.

Related topics

Controlling the View

3D Document Toolbar



Zoom a View
Save a View
Zoom on a Single Part

Focus on a Single Point

Zoom a View

To zoom a view:

1. Make sure Zoom is selected as your mouse mode. How?The status bar at the bottom of the SpinFire™ window lists the current mouse
mode (Rotate, Pan, Zoom). To change the mouse mode, click the text of the mouse mode in the status bar.
2. Drag down to zoom in and up to zoom out.

Note
* You may also zoom by pressing Ctrl+Click and dragging.
« If you have a wheel mouse, you can zoom by clicking in the Viewport and rotating the wheel.

« The arrow keys may also be used to zoom 3D documents when in Zoom mode.

Related topics

Controlling the View

Rotate a View

Pan a View

Fit an Entire Model within the Viewport
Zoom on a Single Part

Zoom a User Defined Area

Zoom on a Single Part

The Focus on Part command zooms in on a part in a 3D assembly and places the part's center at the center of your view.

To focus on a part:

1. Open the Focus menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Focus button. You should see a
drop-down menu listing the available commands.

2. Pointto Focus.

3. Click Focus on Part.

4. Click on a part.SpinFire™ will zoom in on that part

Related topics

Controlling the View

3D Document Toolbar

Fit an Entire Model within the Viewport
Zoom a User Defined Area

Focus on a Single Point

Working with CAD and .3D Files

Importers

With SpinFire™, you can view native CAD files in nearly all the most popular file formats. To view a file in a certain format you will need to have
the importer for that format installed. Importers are software modules that give SpinFire™ direct access to your native CAD files. To see a list of
the importers already installed in your SpinFire™, go to the Options component and click Importers.

SpinFire is able to use certain importers to import 2D CAD files as vector data. These files will be imported into 2D documents. Multi-page CAD
drawings will have each page imported into a separate document in the Workspace. In addition, when a 3D CAD model has 2D drawings
associated with it, each 2D drawing will be placed on its own document in the Workspace.



To the right of each importer listing on the Importers page, you will find a button labeled Options. The Options button opens up a dialog box
which features settings available for that importer. Each importer has different options available. Some common options associate file extensions
with the importer, determine the default unit of measurement, set the precision of tri-mesh approximation, and select filters for entities associated
with that file type.

The new Importer Option dialog in SpinFire 10 can be left open while you work on the main application. So you can import files and check the
result in the 3D graphics with the Option dialog open. To save a change in the option use the "Apply" button. Importing the file after that will be
using the new settings.

For a complete list of importers available from Actify, go to the SpinFire™ Formats page.

Importers are updated frequently. When a new version of an importer is available a notification will appear in the SpinFire home page and a link to
update the importer shows in the Importers page under the Options.
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Viewing

Viewing a CAD design is easy. Select File > Open Workspace from the menu bar and choose the CAD file you want to view. The content of the
file wil appear as one or more documents in the Workspace. (For details about working with documents in the Workspace, see Working with
Documents in the .3D WorkSpace.

The volume precision setting determines how precisely SpinFire™ will render models. Higher precision may result in longer importing time and
slower operation. See Set Volume Precision for details.

Saving

SpinFire™'s .3D file format enables people without a CAD application to view design data. The .3D file contains all the documents in the
WorkSpace as well as all the notes, measurements, and views added with SpinFire™. Sharing a design in a .3D file protects the information in
your original CAD file while allowing others to see the parts and measurements. Others can view .3D files from SpinFire™ or the free SpinFire
Reader.

To save the documents in the WorkSpace as a .3D file, open the CAD file in SpinFire™ and either select File > Save from the menu bar or click
the Save button in the toolbar.

To save a view of a model as a JPEG, BMP, or EMF file, select File > Export from the menu bar.

Printing

To print a document, either select File > Print or click the Print button on the toolbar. This will open a dialog box with options for printing the
document. See Print a Design for details.

Related topics


http://www.actify.com/products/spinfire-cad-solution-system/cad-system-file-importer/

Print a Design

Save a CAD Design as a .3D File

Import a Single Document into a Scene
Import a Multiple Document File

View a CAD File

Save a Design as a Bitmap, JPEG, or EMF
Reading Image files

CAD2CAD

View a CAD File

To view a CAD file, select File > Open WorkSpace from the menu bar and choose the file you want.

Note

* To view a CAD file in SpinFire™, you must have the importer for that file type installed.

« If the WorkSpace is empty, you may open a file by dragging it from a Windows folder to the WorkSpace component.

* You may also open a file by selecting it from the Library or the "Recent Documents” list on the Home page.

Related topics

Working with CAD and .3D Files
Print a Design

Save a CAD Design as a .3D File

Reading Image files

Save a CAD Design as a .3D File

Publishing is the process SpinFire™ uses to save a CAD design as a .3D file.

To publish a CAD design as a .3D file, open the CAD file in SpinFire™ and either select File > Save from the menu bar or click the Save button
on the toolbar.

Note
* To view a CAD file in SpinFire™, you must have the importer for that file type installed.

« All documents open in the WorkSpace Component will be saved in the .3D file.

Related topics

Working with CAD and .3D Files

View a CAD File

Save a Design as a Bitmap, JPEG, or EMF

Reading Image files

Import a Single Document into a Scene

You may import a design directly into the scene of a document. This is an alternative to opening the file as a new document in the WorkSpace.

To import directly into a scene:

1. Make sure the document you want to import the design into is open and active in the WorkSpace.
2. Select File > Import.
3. Select the file you would like to import into the scene.

Note

« When you try to import a .3D file with multiple documents, a dialog box will let you decide how to include each document in the file. See Import a
Multiple Document File for details.



« You may also import a model into a scene by dragging the file into the document currently open in the WorkSpace.

« If you attempt to import an inappropriate file, a dialog box will ask if you would like to add the new documents into the WorkSpace.

Related topics

Working with CAD and .3D Files

Import a Multiple Document File

Working with Documents in the .3D WorkSpace
Add a New Document into the WorkSpace
Import a Drawing into a 2D Document

Reading Image files

Reading Image files

Image Files

SpinFire allows opening standard image files such as JPEF, TIFF, BMP and PNG.
The procedure is the same as regular CAD native files.

® |n the top main menu select "File" -> "Open Workspace"
® Select the image file to open

® Click Open
T
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You can add images to your workspace as new document by using the Import command from the main File menu.

Import a Multiple Document File

When you attempt to import a .3D file containing multiple documents (either by dragging the file or selecting File > Import) a dialog box will give
you options as to what you would like to do with each of the documents in the file.



The actions available when importing a file are these:

® Import: The contents of the document will be directly imported into the 3D scene of the currently active document. This is available only
for 3D documents.

® Add: The document will be open as a new document with its own tab in the WorkSpace.

® None: The document will not be imported into to the 3D scene nor added as a new document in the workspace.

You can change the action taken for each document by double-clicking its entry in the dialog box. The type of action taken will be listed in the Acti
on column.

To import a multiple document file:

1. Select File > Import and select the file or drag the file into the WorkSpace.This opens the Add .3D WorkSpace Document dialog box.
2. Double-click each document listed until the action you desire is listed under the Action column
3. Click Proceed.

Note
* The "Add .3D WorkSpace Document" dialog box will appear only when importing a .3D file with multiple documents. When a .3D file containing a

single 3D document is imported, its scene will be directly imported into the 3D scene of the active document. See #Import a Single 3D Model into
a 3D Scene for details.

Related topics

Working with CAD and .3D Files

Import a Single Document into a Scene
Working with Documents in the .3D WorkSpace
Add a New Document into the WorkSpace
Import a Drawing into a 2D Document

Reading Image files

Print a Design

To print a design

1. Open the design in SpinFire™.

2. Choose File > Print.This opens the Print Options dialog box. This lets you choose vector or raster printer, page sizing, and information in
the header and footer.

3. Select the print options you want and click OK.This opens the Print dialog box.

4. Select the options you want and click Print.

Related topics
Working with CAD and .3D Files
Save a Design as a Bitmap, JPEG, or EMF

Reading Image files

Save a Design as a Bitmap, JPEG, or EMF

You can save a view of your model as a JPEG, BMP, or EMF file.

To save a design as a Bitmap, or JPEG:

Go to the WorkSpace and position your view of the model.

Select File > Export from the menu bar.This opens the Export submenu.

Click either JPEG or BMP.This opens the SpinFire™ Export dialog box.

Select the folder you want to save to and enter a filename.

Click Save.

If exporting a 2D document as a BMP or JPEG, enter the desired width, height, and resolution of the image.
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To save a design as an EMF:

1. Go to the WorkSpace and position your view of the model.
2. Select File > Export from the menu bar.This opens the Export submenu.



Point to EMF.

Click Drawing.This opens the SpinFire™ Export dialog box.
Select the folder you want to save to and enter a filename.
Click Save.
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Note
* When a 3D document is exported as an EMF, a black-and-white, hidden line vector representation of the scene will be saved.

« If the cross-section plane is enabled in a 3D document, you can click save the section profile as an EMF by clicking Section Profile.

Related topics

Working with CAD and .3D Files
Save a CAD Design as a .3D File
Print a Design

View a CAD File

Reading Image files

Export 3D PDF

The Actify PDF Export allows one to export 3D models to a .pdf file.

In Acrobat you can:

Rotate, zoom, and pan the 3D model

Change the background color

Change the lighting

View the assembly tree

Change to standard views (front, back, top, bottom, right, left)
Select and highlight parts
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Exporting to 3D PDF

If the plug-in is installed with SpinFire, simply:

1. Load your 3D model.

2. Go to the File > Export > 3D PDF... menu item.

Ei_le| Edit Tools Mavigation [Documents Help
¥ Open Workspace... Ctrl+0
Cloze
H Save Ctrl+5
Save As,.,
Save a Copy...
Import...
| Export b JPEG...
) Email EMP...
‘5| Print 3 3D PDF...
u}, Print Preview... EMF 3
Exit Alt+F4 Parts List...
7;| STL...

3. Select the location and enter a name for the pdf file.
4. Enter in header text, footer text, and the PDF template file.
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Header Text
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Template File
C:\Program Files (x36)\Actify\SpinFire\10 _

Cancel Ok
| cancel | ok |

Special Note
@ The Export PDF functionality was originally an Actify plug-in. In SpinFire 10.3 or greater, it is now part of the SpinFire functionality that

can be utilized in Reader mode as well.

Extended PDF Features
In Extended mode, Acrobat allows you to use measurement and cross-section tools. To use these features,

1. Load the exported pdf file into Adobe Acrobat Pro.
2. Enable the extended pdf features.
3. Save the file.

CAD2CAD

Description

SpinFire 10.4 introduced a new conversion output option called CAD2CAD. CAD2CAD converts CAD files to the following formats: PDF, STEP,
IGES, ACIS, Parasolid, STL, PRC, or JT.

CAD2CAD requires an additional license to SpinFire Professional. Please contact your system administrator for information about your licensing
status or sales@actify.com if you would like to receive a quotation to add this function.

To convert CAD2CAD files

1. Open SpinFire > File > Convert and choose which format to convert your CAD file to (for example, CAD to X)

. Browse to the file you wish to convert and Open

3. The "Convert X Options" box will appear for the format specified. The location folder by default will be where the original CAD file is
stored. Change any conversion settings here.

4. OK - Your file will be converted to your specified format and saved in the location specified.

N

Known Issues

® AutoCAD models do not convert to STEP or PDF

® ProE assembly files from WildFire 3 and WildFire 5 do not convert to STEP or PDF

® SAT models do not convert to STEP or PDF

® VDA models convert to empty STEP or PDF files

® The converter may have issues converting some Inventor, JT, NX, and SolidWorks assemblies
® The tessellation quality of the converted STEP file may be less than that of the original

® CAD to STEP does not contain PMI annotations

® CAD to STEP does not make transparent parts transparent for Catia v5 assemblies

® CAD to STEP and CAD to PDF fail to convert some surfaces and wireframe pieces

{D Supported File Formats
SpinFire 10.4 Formats



® STEP

* PDF

Formats added in SpinFire 10.5:

ACIS

PRC
STL

IGES
Parasolid

Format added in SpinFire 10.6:

*JT

Supported File Formats in SpinFire

Import

SpinFire provides the capability to read data from the popular 3D formats listed below:

Format
Autodesk Inventor

CATIA V4

CATIA V5

CATIA V6

Creo

I-deas

IGES

Industry Foundation
Classes (IFC)

JT

Parasolid

PRC
Pro/Engineer
Siemens PLM
Software NX

Solid Edge

SolidWorks

STEP

Stereo Lithography
(STL)

VDA-FS

VRML

Version

Up to 2013
Upto4.2.5

R4 to R21,
V5-62012 (R22)

2011 to 2013

Elements/Pro 5.0
Parametric 2.0

Up to 13.x (NX 5),
NX I-deas 6

5.1,52,53

IFC2x Editions 2, 3
and 4

Upto 9.5

Up to v25.0

All Versions

Up to Wildfire 5
Unigraphics V11.0 to
NX 8

V19 - 20, ST - ST5

Up to 2013

AP 203 E1/E2, AP
214

Version 1.0 and 2.0

V1.0 and V2.0

Extensions
IPT, IAM

MODEL, SESSION,
DLV, EXP

CATPART,
CATPRODUCT,
CGR

3DXML

ASM, NEU, PRT,
XAS, XPR

MF1, ARC, UNV,
PKG

IGS, IGES

IFC

JT

X_B, X_T, XMT,
XMT_TXT

PRC

ASM, NEU, PRT,
XAS, XPR

PRT

ASM, PAR, PWD,
PSM

SLDASM, SLDPRT

STP, STEP

STL

VDA

WRL, VRML

Tess

B-Rep

n/a

n/a

PMI

n/a

n/a

n/a

n/a

n/a



Export
SpinFire provides the capability to write data to popular 3D standards listed below:

Format Version Extensions Tess B-Rep PMI
ACIS 5.0 SAT, SAB X
IGES 5.1,5.2,53 IGS, IGES X
Parasolid Up to v25.0 X_B, X_T, XMT, X n/a
XMT_TXT
PRC All Versions PRC X X X
STEP AP 203 E1/E2, AP STP, STEP X
214
Stereo Lithography STL X

Working with Assemblies and Parts

The 3D models viewed in SpinFire™ may be made up of several parts. A model composed of several parts is called an assembly. An assembly
can contain parts and subassemblies.

The Assembly Tree

The assembly tree (located in the Assembly pane in the WorkSpace) details the assemblies, subassemblies, parts and surfaces found in a 3D
scene. You can change the appearance and position of a surface, part, subassembly, or assembly by picking it from the assembly tree.

The heirarchy found in the assembly tree is:
Scene

Assembly

Subassembly

Part

Surface

You pick an object simply by clicking the name of that object in the assembly tree. The object you picked should appear in yellow (or red) in the
scene. Right-click the name of the picked object in the assembly tree to bring up a context menu for altering the appearance and position of the
object. You may pick multiple objects in the assembly tree by using Ctrl+Click and Shift+Click. You may then open the right-click context menu to
simultaneously call commands on all the picked objects.

Parts and subassemblies can be moved from one assembly node to another on the tree simply by dragging picked objects to the desired node.
You may even create a hew assembly node from the New Assembly command on the Assembly object context menu.

Picking an Object from the 3D Scene

You can also pick an individual part or surface and call up its context menu by right-clicking on the part in the 3D image.

Whether the part of the surface will be selected depends on the mode indicated by the Part/Surface Selection Mode button on the 3D Document

[
Toolbar. If EI is displayed, then the part will be picked. If is displayed, then the surface will be picked.

Appearance

An object's right-click context menu offers several commands for controlling appearance.

You can hide or show an object in the scene by clearing and selecting the check box in the assembly tree---or by choosing the Hide or Show
command on the right-click context menu. You can view only the selected object in the scene and hide all other parts with the Show Only comma
nd. The context menu also offers commands to determine the precise color and transparency for a picked object.

The Render Mode determines how an object will be drawn on screen. You can select from the following render modes:

® Wire Frame: Transparent outline of each segment.
® Triangle Mesh: Outline of the triangles used to establish the shading.
® Flat Shading: The triangles are colored but the edges of the triangles are visible.



Smooth Shading: Smoothes the edges of the triangles. This is the default render mode.
Smooth Shading with Edges: Smooth Shading with highlighted edges.

Hidden lines: Similar to wire frame but the segments are not transparent.

Reflective: Shiny metallic rendering.

Metallic: Dull metallic rendering.

Surface Analysis: Reflective rendering for analyzing surface irregularities.

From the Display submenu, you can choose to show points, vertices, wire frames, and surfaces in your view.

Position

The Transform submenu lets you position an object. The Translate and Rotate options let you position an object by entering a precise angle or
distance. The Handles option lets you freely transform an object by dragging handles. The Mirror options lets you mirror the object along a plane.
The From/To Coordinates option moves the object from its current position with respect one coordinate system and place it in the same position
with respect to another coordinate system..

Note: The rotation performed from the Transform submenu is different from the rotation done with your mouse pointer. When you "rotate" with
your mouse pointer, only your view of the model is repositioned, not the model itself. The precise rotation done from the Transform submenu
rotates the actual model or object of the model.

Deleting an Object

You can entirely delete a picked object from your assembly. But be careful: If you save your .3D file after deleting an object you will not be able to
get it back without republishing the original CAD file.

Related topics

Hide or Show an Object in an Assembly
Rotate an Object in an Assembly
Translate an Object in an Assembly
Mirror an Object in an Assembly
Change the Color of an Object

Change the Transparency of an Object
Change the Render Mode of an Object

Change the Display Options of an Object

Add an Assembly Node

The assembly tree in the Assembly pane lists the parts, assemblies, and subassemblies that comprise a model. You may add a new assembly
node to the tree. Parts and subassemblies may then be dragged to and from this node.

To add an assembly node:

1. Select the Assembly pane in the WorkSpace.

2. Right-click the assembly or subassembly under which you would like to create the node.This opens the Assembly context menu.

3. Click the new assembly button at the top of the pane.This will add the node. The name of the node will be highlighted and the cursor
positioned for you to enter the new name.

4. Type the name of the node.

5. Press Enter.Note: You must press the Enter key for the new name to be saved. If you click the mouse instead, any changes made to the
name will not be saved and the object will revert to the default name.

Related topics
Working with Assemblies and Parts
Rename a Part or Subassembly

Move a Part to a New Assembly Node

Change the Color of an Object

You can determine the color for any part, subassembly, or assembly. You can choose a predefined color or define your own color. You can
choose to have the color applied to the "Front" (Exterior), "Back" (Interior), or both.



To change the color of an object

Select the Assembly tab in WorkSpace.

Right-click the name of the object in the assembly tree.This opens the Assembly context menu.
Point to Color.

Click either Front and Back, Front, or Back.This opens the Color dialog box.

Click a color swatch. Or click Define Custom Colors to create your own color.

Click OK.
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Related topics

Working with Assemblies and Parts

Change the Transparency of an Object

Change the Display Options of an Object

You can determine whether an oject's vertices, points, wire-frame entities, and surfaces and solids are displayed.

To change the display options of an object

1. Right-click an object.This opens the Assembly context menu.
2. Point to Display.This opens the Display submenu.
3. Click the object you want to display or hide.Currently displayed objects will have a check beside them.

Related topics

Working with Assemblies and Parts
Change the Render Mode of an Object
Change the Transparency of an Object
Change the Color of an Object

Display a Clear Cross-Section Plane

Change the Render Mode of an Object

The render mode determines how an object will be drawn on screen. You can select from the following render modes:

Wire Frame: Transparent outline of each segment.

Triangle Mesh: Outline of the triangles used to establish the shading.

Flat Shading: The triangles are colored but the edges of the triangles are visible.
Smooth Shading: Smoothes the edges of the triangles. This is the default render mode.
Smooth Shading with Edges: Smooth Shading with highlighted edges.

Hidden lines: Similar to wire frame but the segments are not transparent.

Reflective: Shiny metallic rendering.

Metallic: Dull metallic rendering.

Surface Analysis: Reflective rendering for analyzing surface irregularities.

Smooth Shading is the default render mode.

To change the render mode of an object:

Select the Assembly pane in the WorkSpace.

Right-click the name of the object in the assembly tree.This opens the Assembly context menu.
Point to Render Mode.This opens the Render Mode submenu.

Click the name of a render mode.

rONE

Note

By default the Smooth Shading render mode is used.

Related topics

Working with Assemblies and Parts
Change the Display Options of an Object
Change the Transparency of an Object

Change the Color of an Object



Hide or Show an Object in an Assembly

Change the Transparency of an Object

You can adjust the level of opacity and transparency of any part, subassembly, or assembly.

To change the transparency of an object:

. Select the Assembly pane in the WorkSpace.

. Right-click the name of the object in the assembly tree.This opens the Assembly context menu.

. Click Transparency.This opens the Set Transparency slider.

. Adjust the slider until the object is at the desired transparency.To guide you, the transparency of the object in the scene will reflect the
real-time adjustments you make with the slider.

5. Click Close.

A WNBE

Related topics

Working with Assemblies and Parts
Change the Color of an Object

Hide or Show an Object in an Assembly
Change the Render Mode of an Object
Change the Display Options of an Object

Display a Clear Cross-Section Plane

Choose Part or Surface Picking Mode

By right-clicking a model in the 3D scene will select either the part or the surface depending on which picking mode is active. The picking mode
determines whether you will be able to use the cursor to select either parts or surfaces in the scene.

To choose part or surface picking mode:

1. On the 3D Document Toolbar, click to switch to Part picking mode or click to switch to Surface picking mode.

Related topics
Working with Assemblies and Parts
Rotate an Object in an Assembly

Translate an Object in an Assembly

Hide or Show an Object in an Assembly

From the assembly tree you can make any assembly, subassembly, or part in a scene visible or invisible.

To hide or show an object in an assembly:

1. Click the Assembly pane button in the WorkSpace.
2. In the assembly tree, clear or select the check box beside the object.A visible object will have its check box selected.

Note

* You may also hide a part by right-clicking it in the 3D scene and selecting Hide.

Related topics

Working with Assemblies and Parts
Show Only Selected Objects in a Scene
Change the Display Options of an Object
Change the Render Mode of an Object
Change the Transparency of an Object

Display a Clear Cross-Section Plane



Mirror an Object in an Assembly

You can precisely mirror an assembly, subassembly or part along the XY, XZ, or YZ plane.

To mirror an object

. Select the Assembly pane in the WorkSpace.

. Right-click the name of the object in the assembly tree.This opens the Assembly context menu.

. Point to Transform.This opens the Transform submenu.

. Click Mirror.This opens the Tranformation Control dialog box.

. From the Relative to: drop-down menu, select the coordinate system you want to translate with respect to.The default is the current
active coordinate system.

. Click About XY-Plane, About YZ-Plane, About XZ-Plane.

7. Click Apply and OK.

abswNBE

o

Related topics
Working with Assemblies and Parts
Rotate an Object in an Assembly

Translate an Object in an Assembly

Move a Part to a New Assembly Node

The assembly tree in the Assembly pane lists the parts, assemblies, and subassemblies that comprise a model. You may move a part or
subassembly from one assembly node to another on the tree.

To move a part to a new assembly node:

1. Select the Assembly pane in the WorkSpace.

2. Click the objects you would like to move in the tree.You may move either parts or subassemblies. You may select multiple objects on the
tree using Ctrl+Click or Shift+Click.

3. Drag the objects to the desired assembly node.

Note

« Assembly nodes are identified in the assembly tree by the assembly icon . Parts are identified in the assembly tree by the part icon . Surfaces by

Related topics

Working with Assemblies and Parts
Add an Assembly Node

Rotate an Object in an Assembly

Translate an Object in an Assembly

Rename a Part or Subassembly

The name of each part and subassembly in a model is listed in the Assembly Tree in the Assembly pane.

To rename a part or subassembly:

. Select the Assembly pane in the WorkSpace.

. Right-click the name of the object in the assembly treeThis opens the Assembly context menu.
. Click RenameThe name of the object will be highlighted for you to type a new name.

. Type the new name of the object.

A WNBE

Note

* You may also change the name from the Properties dialog box of the object.

Related topics

Working with Assemblies and Parts
Add an Assembly Node
Rotate an Object in an Assembly



You can rotate an assembly, subassembly or part along the X-, Y-, and Z-axes. This can be done by either precisely specifying the angle of
rotation around an axis or by freely rotating the object by dragging a handle around the object.

To rotate by typing an angle:

O~NO O~ WNE

©

. Select the Assembly pane in WorkSpace.

. Right-click the name of the object in the assembly tree.This opens the Assembly context menu.

. Point to Transform.This opens the Transform submenu.

. Click Rotate.This opens the Transformation Control dialog box.

. From the Relative to: drop-down menu, select the coordinate system you want to translate with respect to.

. Select an Axis.

. Inthe Angle field, type the number of degrees you would like to rotate the object.The degrees may be positive or negative.

. Click Preview to see what the translation will look like.The object will briefly be rotated to the new position and then will return to its

original location.

. Click Apply to save the translation.
. Click OK to close the dialog box.

To rotate by dragging a handle:

O~NO U WNE

Note

. Select the Assembly pane in WorkSpace.

. Right-click the name of the object in the assembly tree.This opens the Assembly context menu.

. Point to Transform.This opens the Transform submenu.

. Click Handles.This opens the Transformation Control dialog box and displays a box with handles around the object.
. From the Relative to: drop-down menu, select the coordinate system you want to translate with respect to.

. Drag one of the red handles to rotate the object.A label will display the degrees that the object is being rotated.

. Click Apply to save the translation.

. Click OK to close the dialog box.

« Surfaces may not be rotated. You may only rotate an assembly, part, or subassembly.

Related topics

Hide or Show an Object in an Assembly

Translate an Object in an Assembly

Apply a Part Transformation to a User View

Mirror an Object in an Assembly

Rotate a View

Rotate a Cross-Section Plane

Show Only Selected Objects in a Scene

You may view only the parts and assemblies you have selected and hide all other parts in the scene with the Show Only command.

To show only selected objects in a scene

1.

2.
3.

Note

In the Assembly pane, select the objects you would like to show.Select a single object from the assembly tree by clicking it or multiple

objects using Ctrl+Click or Shift+Click.
Right-click a selected object in the assembly tree.This opens the Assembly context menu.
Click Show Only.

* You may also select a single part directly from the model using right-click, or multiple parts using Ctrl+Right-click.

* You may call the Show All Parts command from the right-click menu of the Scene node of the assembly tree.

Related topics

Working with Assemblies and Parts

Hide or Show an Object in an Assembly

Translate an Object in an Assembly

You can precisely translate, or shift, an assembly, subassembly or part along the x-, y-, and z-axes.



To translate an object by typing distances:

. Select the Assembly tab in the WorkSpace.

. Right-click the name of the object in the assembly tree.This opens the Assembly context menu.

. Point to Transform.This opens the Transform submenu.

. Click Translate.This opens the Transformation Control dialog box.

. Select the Translation tab, if it is not already selected.

. From the Relative to: drop-down menu, select the coordinate system you want to translate with respect to.

. Inthe X, Y, and Z fields, type the number of units you would like to translate the object along the axes.The units can be positive or
negative.

8. Click Preview to see what the translation will look like.The object will briefly be translated to the new position and then will return to its

original location.
9. Click OK to save the rotation and close the dialog box.
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To translate by dragging a handle:

1. Select the Assembly pane in WorkSpace.
2. Right-click the name of the object in the assembly tree.This opens the Assembly context menu.
3. Point to Transform.This opens the Transform submenu.
4. Click Handles.This opens the Transformation Control dialog box and displays a box with handles around the object.
5. From the Relative to: drop-down menu, select the coordinate system you want to translate with respect to.
6. Drag one of the purple handles to translate the object.A label will display the distance that the object is being translated.
7. Click Apply to save the translation.
8. Click OK to close the dialog box.
Note

« The units used in a translation are the default units set in the "3D Viewer Options" page of the Options component.

« Surfaces may not be translated. You may only translate an assembly, part, or subassembly.

Related topics

Hide or Show an Object in an Assembly
Rotate an Object in an Assembly

Apply a Part Transformation to a User View
Mirror an Object in an Assembly

Translate a Cross-Section Plane

Measuring and Annotating a Model

Measuring and Annotating a Model

SpinFire™ offers several options for adding useful markup labels to your 3D model. The two categories of markup labels are Dimensions and
Notes. Dimensions, or measurements, indicate lengths, areas, coordinates, or angles. Notes are comments created by users. The Markups tab in
the WorkSpace lists a model's Notes and Dimensions. You can call a markup's right-click context menu from either the label itself or its listing in
the Markups tab. To hide or show a markup, select or clear its check box in the Markups tab.

Example of a Note and a Markup Dimension label.

[-24.01,56.08,49.00] @=6.000 rmm

Positioning

The Markup Dimension and Note labels have similar appearances and can be manipulated in some of the same ways. You can freely position a
markup label by dragging it---or you can prevent repositioning by selecting "Lock Position" from the right-click menu. Normally, a markup label
rotates along with your model and can appear behind the model. You can prevent a label from appearing behind the model by selecting the "Stay



on Top" option from the markup's right-click menu.

Comments and Hyperlinks

You can add a text comment to a markup label. This comment appears when the pointer hovers over a markup label. A label with a text comment
has a mark in its lower-right corner.

This Markup Dimension label has a text comment attached to it.

[~ 0 O i B R B G = ] [ OO Notice the mark in the lower-right corner, indicating a comment.
Increase notch =iz a

A markup label can be made into a hyperlink so that a user can access a file or Web page by clicking the label. A markup label that is also a link
will be underlined.

You can add or edit a text comment or hyperlink by calling the Properties dialog box from the right-click menu.

Markup Dimensions

A Markup Dimension can measure a line, angle, diameter, surface area, or volume. You can call the different Markup Dimension commands from
menus on the 3D Document toolbar. For details on how each of these commands works, see the 3D Markups Dimensions Reference.

The initial unit of measurement for any Markup Dimension is determined by the default settings in SpinFire™. You can change the units of
measurement for any individual Markup Dimension from the Units submenu of its right-click menu.

Notes

SpinFire™ offers four types of notes:

3D Vertex Note: Attached to a vertex point on the model.

3D Edge Note: Attached to a straight line on the model.

3D Note: Attached to any point in the 3D space.

2D Note: Not attached to any point in the 3D space. Label remains stationary.
3D Surface Note: Attached to any point of a surface.

For each of these, you select the appropriate location to attach the note, position the label, type the text of the label, and hit the Enter key when
finished.

The title of a Note is the same as the text in its label. The title identifies a Note in the Markups tab. You can edit this text by calling the Properties
dialog box from the right-click menu.

Note: Do not confuse the text of a Note label with an optional text comment attached to a markup label. See Add Extra Text to a Label for details.

Related topics

Position a Markup Label

Delete a Markup Label

Hide or Show a Markup Label

Lock a Markup Label in Position

Keep a Markup Label in Front of the Model

Add Extra Text to a Label

Add a Link to a Markup Label

3D Markups Dimensions Reference

The 3D Markups Dimension commands are called from either the Dimension, Angles, or Part Dimension menus on the 3D Document Toolbar



Selecting a vertex point

A 3D design is built from lines, triangles, and other polygons. Vertex points are the points of intersection between these figures that underlie the
3D design. When you choose a command that requires you to select a vertex point, the pointer appears as an arrow with a small "x" at the tip
when over the Viewport. Red dots designate available vertices on the model. (If you do not see the red dots, you may want to go to the 3D Viewer
Options page of the Options component and select the Vertices visible on picking check box.) A cross-hatch indicates when the pointer is
properly positioned over a vertex point. A yellow dot indicates that you have successfully selected a vertex point.

Selecting an edge or arc

Some 3D Markup Dimension commands, such as Edge Length and Arc Diameter, require you to select an edge or arc that already exists on the
model. When the pointer is properly positioned over an edge or arc, a line or circle highlight will appear.

3D Markups Dimensions
Linear menu:

® Vertex Coordinates

® Arc Center Coordinates

® Edge Length

® Thickness

® Vertex to Vertex

® Vertex to Edge

® Arc Center to Edge

® Arc Center to Arc Center

¢ Surface Point to Edge

¢ Surface Point to Surface Point

¢ Distance Between Two Surfaces

® Sum of Connected Edges

® Minimum Distance Between Edges

® Boundary Center by Edges
Radial menu:

® Arc Diameter

® Arc Radius

® Circle by Three Vertices
Angular menu:

® Three Vertices Angle

®* Two Edge Angle

¢ Surface Point to Surface Point

® Surface Point to Vertex

¢ Surface Point to Edge

® Two Vertices Draft-Angle

® Surface Draft Angle
Calculate menu (found on the Assembly pane):

® Volume

® Surface

¢ Center of Mass

® Extent Box



o
I-J Vertex Coordinates - Measures the X, Y, and Z coordinates of a point on the model. How...
Ii‘ Arc Center Coordinates - Measures the X, Y, and Z coordinates of the center of the arc on the model. How...

Inj Edge Length - Measures an existing straight line on the model. A line will indicate when the pointer is properly positioned over an edge. How

&+
I ¥ Thickness - Measures the distance between a surface you pick and the nearest surface.How...
ID

E# vertex to Vertex - Measures the distance between two points you select on the model. By default, this command measures a line directly
connecting the two points. How...

You can also choose to measure the distance between two points with respect to the X-, Y-, or Z-axis by selecting "Along X", "Along Y", or "Along
Z". Or you can change an existing Vertex to Vertex Distance to measure the distance between the two points with respect to the X-, Y-, or Z-axis
by selecting the appropriate choice from the right-click menu. How...

I‘lﬂ Vertex to Edge - Measures the distance between a vertex point and an existing straight edge on the model. How...

I@n; Arc Center to Edge - Measures the distance between the center of an existing arc on the model and an existing straight edge on the model.
How...

I% Arc Center to Arc Center - Measures the distance between the centers of two existing arcs on the model. How...

o
I # Surface Point to Edge - Measures the distance between a point on a surface and an existing edge on the model. The "line" formed by the
selected edge will be extended in space and the distance measured will be between the point on the surface and the nearest point on the "line" of
the selected edge. How...

o
] . . . .
I = Surface Point to Surface Point - Measures the distance between two points on surfaces of the model. How...

ad

Distance Between Two Surfaces - Measures the distance between two parallel surfaces on the model. How...

IE% Sum of Connected Edges - Measures the sum of any number of connected edges selected by the user. How...

%
= Minimum Distance Between Edges - Measures the distance between two edges of the model. How...

I' ' Boundary Center by Edges - Measures the the center point of a bondary on the assembly. How...

a

I3 Arc Diameter - Measures the diameter of an existing circle on the model and draws the circle. Measure an Arc Diameter

R
T84 Arc Radius - Measures the radius of an existing circle on the model and draws the circle. How...

B

I=# circle by Three Vertices - Draws a circle that passes through three selected vertex points on the model and measures the circle's diameter.
This command draws a visible diameter that passes through the first point you select. The label also lists the X, Y, and Z coordinates of the
circle's center point. You can also choose to show only the arc that runs through the three points by selecting Draw Arc from the right-click menu.
How...

o

“w Three Vertices Angle - Measures an angle defined by two segments with a common vertex. You will pick the first point of the first segment,
the vertex point, and finally the endpoint of the second segment. It is important to remember that the second point you select will be the vertex of
the angle. Flip this angle's measurement by selecting the Flip Axis command from the right-click menu. How...

3

lLu—‘ Two Edges Angle - Measures an angle defined by two edges on the model. The two edges picked must be co-planar How...
a .

&' Two Surface Normals Angle - Measures the angle defined by the normal vectors of two surfaces. How...

A . . ) )
%= Vertex to Surface Normal Angle - Measures an angle defined by the line between a vertex point on the model and a point on a surface and
the normal vector of the surface. How...

4
I]-r-T Surface Normal to Edge Angle - Measures an angle defined by the normal vector of a surface and a straight edge on the model. How...

i
c»-j Two Vertices Draft-Angle - Measures an angle defined by a line between two selected points and the X-, Y-, or Z-axis. Flip this angle's
measurement or change the axis used to compute it from the right-click menu. How...



LA ) o
it Surface Draft Angle - Measures an angle defined by a surface normal vector and the X-, Y-, or Z-axis. Flip this angle's measurement or
change the axis used to compute it from the right-click menu. How...

5% Volume - Measures the volume of a part. How...

'h Surface - Measures the surface area of a part. How...

et |

98 Center of Mass - Lists the X, Y, and Z coordinates of the center of mass of a part. How...

Ili Extent Box - Draws a box around a part and measures the part along the X-, Y-, and Z-axes. How...

Top

Add a 2D Note

A 2D Note is not attached to any point in the 3D space. The label remains stationary and does not rotate with the view.

To add a 2D Note:

1. Open the Notes menu on the 3D Document Toolbar. How?
® Click the drop-down arrow to the right of the Notes button. You should see a drop-down menu listing the available commands.
. Click 2D Note.
. Move the label into position with your pointer.
. Click once to set the label.A cursor will appear in the label.
. Type the text of your label and press Enter.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Add an Edge Note
Add a Vertex Note

Add a 3D Note

Add a 3D Note

A 3D Note is attached to a spot in the 3D space and will rotate along with your model.

To add a 3D Note:

1. Open the Notes menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Notes button. You should see a
drop-down menu listing the available commands.

. Click 3D Note.The label will appear.

. Move the label into position with your pointer.

. Click once.A cursor will appear in the label.

. Type the text of your label and press Enter.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Add an Edge Note
Add a Vertex Note

Add a 2D Note

Add a Link to a Markup Label



A markup label can be made into a link so that a user can access a file, Web page, or user view by clicking the label. A markup label that's a link
will be underlined.

Examples of valid link paths include:

« http://www.actify.com

« C:\MyDocs\SomeDocument.doc

* #view2

* [DocumentName]

» [DocumentNamel#view2

To link to a user view, type the pound sign # and the name of the saved view.

To link to another document within the .3D file, suround the name of the document with square brackets [ ]. For example, a link [Wheel] would
open the Wheel document.

If you would like to link a user view within a 3D document add the pound sign # and the viewname. For example, the link [WheelJ#view2 would
open the Wheel document and display the view named view2.

SpinFire™ will append the http:// protocol header to any relative link. Therefore, links to files must use an absolute path.

To add a link to a markup label:

1. Right-click the label.You can do this on either the label itself or the name of the label in the Markups tab. This opens the Markup context
menu.

. Click Properties.This opens the Markup Properties dialog box

. Click in the Hyperlink field.

. Type the path of the Web page or file you want to link to. Or click the [...] button to browse to a local file.

. Click OK.The text of the label should be underlined.
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Related topics
Measuring and Annotating a Model
Edit a Note's Text

Add Extra Text to a Label

Add an Edge Note

An 3D Edge Note is attached to an existing straight edge on the model.

To add an Edge Note:

1. Open the Notes menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Notes button. You should see a
drop-down menu listing the available commands.

. Click 3D Edge Note.

Position the pointer over an edge on the model.SpinFire™ indicates when your pointer is over an edge by highlighting the edge with a

line.

. Click the edge.The label will appear.

. Move the label into position with your pointer.

. Click once.A cursor will appear in the label.

. Type the text of your label and press Enter.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Measure a Straight Edge

Add a Vertex Note

Add a 3D Note

Add a 2D Note

Add a Vertex Note

A 3D Vertex Note is a label attached to a specific point on a model.


http://www.actify.com

To add a Vertex Note:

1. Open the Notes menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Notes button. You should see a
drop-down menu listing the available commands.

. Click 3D Vertex Note.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly positioned
over a vertex point.

. Click the vertex you want to attach the note to.The label will appear.

. Move the label into position with your pointer.

. Click once.A cursor will appear in the label.

. Type the text of your label and press Enter.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Display Vertex Coordinates

Add an Edge Note

Add a 3D Note

Add a 2D Note

Add Extra Text to a Label

There are two kinds of additional text that can be added to a markup label:

® Description: Appears as an extra line of text on the markup label itself. This is most useful for measurement labels.
® Comment: Appears a as a bubble when the pointer hovers over the label. A markup label with a comment will have a mark in the
lower-right corner.

To add or edit a description on a markup label:

1. Right-click the label.You can do this on either the label itself or the name of the label in the Markups tab. This opens the Markup context
menu.

2. Click Properties.This opens the Markup Properties dialog box.

3. Click in the Description box and type your comment.

4. Click OK.The description will appear on the lable beneath the original measurement or note.

To add or edit acomment on a markup label:

1. Right-click the label.You can do this on either the label itself or the name of the label in the Markups tab. This opens the Markup context
menu.

2. Click Properties.This opens the Markup Properties dialog box.

3. Click in the Comments box and type your comment.

4. Click OK.A mark should appear in the lower-right corner of the label, indicating a comment.

Related topics
Measuring and Annotating a Model
Edit a Note's Text

Add a Link to a Markup Label
Change a Dimension's Coordinate System

Certain dimension markups take their measurements with respect to the coordinate system that is active at the time the markup is created. When
the active coordinate system changes, the dimension label will not change---it will still display the measurement with respect to the coordinate
system that was active when the dimension was created.

You may change the coordinate system of a dimension from the Markup Properties dialog box.

To change a dimension's coordinate system:

1. Right-click the dimension.This can be done either from the Markup tab or the label in the scene.
2. Select Properties.This opens the Markup Properties dialog box.



3. Select the desired coordinate system from the Relative to: drop-down menu.
4. Click OK.

Note

« You can tell if a dimension measurement is taken relative to a coordinate system other than the Global Coordinate System by the icon on the
markup label.

Related topics

Measuring and Annotating a Model

Using Multiple Coordinate Systems

Change the Color of a Markup

To change the color of a 3D markup:

Right-click the label.This can be done either on the label itself or its listing in the Markups tab. This opens the Markup context menu.
Click Properties.This opens the Markup Properties dialog box.

Click the Color... button.This opens the Color dialog box.

Click the desired color swatch and click OK.
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To change the color of a 2D markup:

1. Select the Markups mode.This may be done by clicking the Markup Mode button on the toolbar or the mouse mode listing in the status
bar at the bottom of the window.

2. Click a markup.This will cause new controls for markup editing to appear to the right of the toolbar.

3. Use the toolbar control to change the color of the font, line, or fill.

Note

« This procedure changes the color of the selected label only.

Related topics
Measuring and Annotating a Model
Change the Font of a Markup

Change the Decimal Places of a Measurement

The following steps will set the decimal places for a single measurement. To set the default decimal places for all measurements, see Set the
Default Decimal Places for Measurements.

To change the decimal places of a measurement:

1. If you are changing a measurement in a 2D document, select the Markup mode from the toolbar.

2. Right-click the measurement.You can do this either on the measurement itself or its listing in the Markups tab. This opens the Markup
context menu.

3. Point to Decimal Places and click a number.

Related topics

Measuring and Annotating a Model

Set the Default Decimal Places for Measurements

Change the Font of a Markup

The step required to change the font of a markup are different for 3D markups and 2D markups.

To change the font of a 3D markup:

Right-click the label.You can do this either on the label itself or its listing in the Markups tab. This opens the Markup context menu.
Click Properties.This opens the Markup Properties dialog box.

Click the Font... button.This opens the Font dialog box.

Select the desired font settings and click OK.

el N

To change the font of a 2D markup:



1. Select the Markups mode.This may be done by clicking the Markup Mode button on the toolbar or the mouse mode listing in the status
bar at the bottom of the window.

2. Click a markup.This will cause new controls for markup editing to appear to the right of the toolbar.

3. Use the toolbar controls to change the attributes of the font.

Note

« This procedure changes the font of the selected label only.

Related topics
Measuring and Annotating a Model
Set the Default Font of Markups

Change the Color of a Markup

Change the Main Axis of a 2-Vertices Draft Angle

A Two Vertices Draft-Angle measures an angle defined by a line between two selected points and the X-, Y-, or Z-axis. You can change which
axis is used.

To change the axis, right-click the label and select X-Axis, Y-Axis, or Z-Axis from the context menu.

Related topics

Measuring and Annotating a Model
Measure a Two Vertices Draft-Angle
Measure a Three Vertices Angle

Reverse an Angle Measurement

Change the Units of a Single Dimension

Change the Units of a Single Dimension

The initial unit of measurement for Dimensions is determined by the default setting in the 3D Viewer Options page of the Options component. You
can, however, change the units of measurement for an individual Dimension from the Units submenu of its right-click menu.

To change the units of a single dimension:

1. Right-click the label.You can do this on either the label itself or the name of the label in the Markups tab. This opens the Markup context
menu.

2. Point to Units.This opens the Units submenu.

3. Click new unit.The Dimension label will reflect the new unit.

Note

« Clicking As Environment in the Units submenu will change the label's unit of measurement to the default set in the 3D Viewer Options page of
the Options component.

Related topics

Measuring and Annotating a Model

Set the Default Unit of Measurement

Copy the Text of a Markup Label

You can copy the text of a note or measurement label and paste it into another document.

To copy the text of a markup label

1. Right-click the label.You can do this either on the label itself or its listing in the Markups tab. This opens the Markup context menu.
2. Select Copy.This copies the text of the label to your Windows Clipboard. It can then be pasted into any document with the Windows
Paste command.

Note

« You can also copy an entire markup label (not just the text) and paste it into the 3D scene in SpinFire™. Just copy the label, then right-click
either Notes or Dimensions in the Markups tab (depending on the type of label you want to paste), and select Paste. A copy of the label will be



pasted in the 3D scene.

Related topics

Measuring and Annotating a Model
Edit a Note's Text

Delete a Markup Label

Deleting a Note or Dimension label removes it permanently. If you would rather temporarily hide a label, see Hide or Show a Markup Label

To delete a markup label:

1. Right-click the label.You can do this on either the label itself or the name of the label in the Markups tab. This opens the Markup context
menu.
2. Click Delete on the menu.A dialog box asks you to confirm your delete.

Related topics

Measuring and Annotating a Model

Hide or Show a Markup Label
Display Arc Center Coordinates

The Arc Center Coordinates command inserts a Dimension label that measures the X, Y, and Z coordinates of the center point of an arc.

To display the coordinates of a vertex:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Point to Coordinates.

. Click Arc Center Coordinates.

4. Position your pointer over the arc you want to measure in the model.SpinFire™ indicates when your pointer is over an arc by highlighting
the arc with a circle.

5. Click the arc.

6. Drag and click to position the label in the scene.
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Note

« If red dots do not appear on the model when you call the command, you may need to go to the 3D Viewer Settings page of the Options
component and click the Vertices visible on picking check box.

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Add a Vertex Note

Change the Units of a Single Dimension

Display Vertex Coordinates

The Vertex Coordinates command inserts a Dimension label that measures the X, Y, and Z coordinates of a vertex on the model.

To display the coordinates of a vertex:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Point to Coordinates.

3. Click Vertex Coordinates.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly
positioned over a vertex point.

4. Click the vertex on the model you want to measure.

5. Drag the label and click to set it in position.

Note

« If red dots do not appear on the model when you call the command, you may need to go to the 3D Viewer Settings page of the Options



component and click the Vertices visible on picking check box.

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Add a Vertex Note

Change the Units of a Single Dimension

Edit a Note's Text

The following operation changes the text that appears on a Note label. This text is the same as the Note's title that appears in the Markups tab.

To edit a Note's text:

1. Right-click the label.You can do this on either the label itself or the name of the label in the Markups tab. This opens the Markup context
menu.

2. Click Properties on the menu.This opens the Markup Properties dialog box.

Click in the Title field and type your new label text.

4. Click OK.
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Note

« When the Edit Note dialog box first appears, all the text in the Title field will be selected. To completely replace the text in the Note label, just
start typing.

Related topics

Measuring and Annotating a Model
Add Extra Text to a Label

Delete a Markup Label

Hide or Show a Markup Label

Change the Units of a Single Dimension

Hide or Show a Markup Label

You can make a Note or Dimension label invisible without deleting it. The Markups tab lists all the hidden and visible markup labels.

To hide or show a markup label:

1. Open the Markups pane in the WorkSpace.This tab lists all the hidden and visible Notes and Dimension labels.
2. Clear or select the check box next to the name of the label.

Note
« If you do not see the name of a markup label in the Markups tab, double-click the Notes or Markup Dimensions heading.

* You may also hide a markup by right-clicking its label and clicking Hide.

Related topics

Measuring and Annotating a Model

Delete a Markup Label

Keep a Markup Label in Front of the Model

Markup labels (with the exception of a 2D Note) rotate along with your view of the model. This can result in the label appearing behind the model.
But you can prevent this with the Stay on Top setting.

To keep a markup label in front of the model:

1. Right-click the label.You can do this on either the label itself or the name of the label in the Markups tab. This opens the Markup context
menu.
2. Click Stay on Top.The Stay on Top setting has a check mark beside it when it is enabled.



Note

« Follow this same procedure to disable the Stay on Top setting.

Related topics

Measuring and Annotating a Model
Position a Markup Label

Lock a Markup Label in Position

Lock a Markup Label in Position

You can prevent a label from being dragged into a new position with the Lock Position option.

To lock a markup label in position:

1. Right-click the label.You can do this on either the label itself or the name of the label in the Markups tab. This opens the Markup context
menu.
2. Click Lock Position.The Lock Position setting has a check mark beside it when it is enabled.

Note
« Follow the same procedure to disable the Lock Position setting.

« The labels with the Lock Position setting enabled will still rotate with the view of the model. Lock Position only prevents the label from being
moved with a drag operation. See Keep a Markup Label in Front of the Model.

Related topics

Measuring and Annotating a Model
Position a Markup Label

Keep a Markup Label in Front of the Model
Measure a Boundary Center by Edges

The Boundary Center by Edges measures the center point of a boundary defined by connected edges.

The way this command works is that you select an edge or an arc on the model. SpinFire™ will automatically find the connected edges that form
the boundary and the measure the center point.

You may need to click more than one edge for SpinFire™ to be able to measure the boundary center. For example, if you click an edge on a
cube, SpinFire™ will not know which square "boundary" you want to measure. When you click a second edge, SpinFire™ will then be able to
calculate the boundary and measure the center.

To measure a boundary center by edges:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Click Boundary Center by Edges.

3. Click an edge or arc on the assembly.SpinFire™ indicates when your pointer is over a slot by highlighting the edges.

4. If necessary, continue clicking connected edges or arcs on the assembly.When SpinFire™ can determine the edges of a boundary, the
center point will be measured.

5. Drag the label into position.

Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure the Sum of Connected Edges

Measure a Circle by Three Vertices

The Circle by Three Vertices command draws a circle that passes through three selected points on the model and measures the circle's
diameter. This command draws a visible diameter that passes through the first point you select. The label also lists the X, Y, and Z coordinates of



the circle's center point.

To measure a Circle by Three Vertices:

1. Open the Radial menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Radial button. You should see a
drop-down menu listing the available commands.

2. Click Circle by Three Vertices.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly
positioned over a vertex point.

3. Click three vertices on the model.

4. Drag the label into position and click once.

Note
« You can choose to show only the arc that runs through the three points by right-clicking the label and selecting Draw Arc from the context menu.

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure an Arc Diameter

Measure a Draft-Angle using a Surface Normal

The Surface Draft-Angle command measures an angle defined by a surface normal vector and the X-, Y-, or Z-axis.

To measure a draft-angle using a surface normal:

1. Open the Angular menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Angular button. You should see
a drop-down menu listing the available commands.

2. Point to Draft Angles.

. Click Surface Draft-Angle X, Surface Draft-Angle Y, or Surface Draft-Angle Z.

4. Click a surface on the model
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Note
« You can flip the direction of the axis segment used to form the angle by right-clicking the label and clicking Flip Axis from the context menu.
« You can change the main axis from the right-click context menu.

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Change the Main Axis of a 2-Vertices Draft Angle
Reverse an Angle Measurement

Measure a Three Vertices Angle

Measure an Arc Center to Arc Center Distance

The Arc Center to Arc Center command measures the distance between the centers of two existing arcs on the model.

To measure the distance between two arc centers:

1. Open the Linear menu on the 3D Document Toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Point to Arc Center to.

. Click Arc Center.

4. Click the first arc you want to measure in the model.SpinFire™ indicates when your pointer is over an arc by highlighting the arc with a
circle.

5. Click the second arc.

6. Drag the label into position and click once.
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Note

* To measure the Centerline of Arc to Centerline of Arc distance, right click on the Arc Center to Arc Center markup label and click on Centerline.



The label will now show the Centerline of Arc to Centerline of Arc Distance.

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Measure an Arc Diameter
Measure an Arc Center to Edge Distance

Measure a Circle by Three Vertices

Measure an Arc Center to Edge Distance

The Arc Center to Edge command measures the distance between the center of an existing arc on the model and an existing straight edge on
the model.

To measure an arc center to edge distance:

1. Open the Linear menu on the 3D Document Toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

. Point to Arc Center to.

. Click Edge.

Click an arc on the model.SpinFire™ indicates when your pointer is over an arc by highlighting the arc with a circle.

. Click an edge on the model.SpinFire™ indicates when your pointer is over an edge by highlighting the edge with a line.

. Drag the label and click to set it in position.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Measure an Arc Diameter

Measure a Circle by Three Vertices
Measure a Straight Edge

Measure the Distance Between Two Vertices

Measure an Arc Diameter

The Arc Diameter command measures the diameter of an existing arc on the model and draws the circle. SpinFire™ draws a circle and its
diameter. The label indicates the length of the diameter and the coordinates of the circle's center point. You can take this measurement only for
an arc that already exists in the model itself.

To measure an arc diameter:

1. Open the Radial menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Radial button. You should see a
drop-down menu listing the available commands.

2. Pointto Arc.

. Click Arc Diameter.

4. Position your pointer over the arc you want to measure in the model.SpinFire™ indicates when your pointer is over an arc by highlighting
the arc with a circle.

5. Click on the arc.

6. Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model



Measure an Arc Diameter in a 2D Document

Measure a Circle by Three Vertices

Measure an Arc Radius

The Arc Radius command measures the radius of an existing arc on the model and draws the circle. SpinFire™ draws a circle and its diameter.
The label indicates the length of the radius and the coordinates of the circle's center point. You can take this measurement only for an arc that
already exists in the model itself.

To measure an arc diameter:

1. Open the Radial menu on the 3D Document Toolbar. How?Click the drop-down arrow to the right of the Radial button. You should see a
drop-down menu listing the available commands.

. Point to "Arc".

. Click "Arc Radius".

4. Position your pointer over the arc you want to measure in the model.SpinFire™ indicates when your pointer is over an arc by highlighting

the arc with a circle.
5. Click on the arc.
6. Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Measure an Arc Diameter

Measure a Circle by Three Vertices

Measure an Edge to Edge Distance

The Minimum Distance Between Edges command measures the minimum distance between two edges.

To measure the the minimum distance between two edges:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

. Click Minimum Distance Between Edges.

. Click an edge on the assembly.SpinFire™ indicates when your pointer is over an edge by highlighting the edge with a line.

. Click another edge on the assembly.

. Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure a Straight Edge

The Edge Length command measures an existing straight edge on a model.

To measure a straight edge:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Click Edge Length.

3. Click the edge you want to measure on the model.A line highlight will appear whenever the pointer is properly positioned over an edge.

Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.



Related topics

Measuring and Annotating a Model

Measure the Distance Between Two Vertices

Measure a Surface Normal to Edge Angle

The Surface Normal to Edge Angle command measures an angle defined by the normal vector of a surface and a straight edge on the model.

To measure the angle between a surface normal and an edge:

1. Open the Angular menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Angles button. You should see
a drop-down menu listing the available commands.

. Point to Surface Point to.

. Click Edge.

. Click on a surface of the model.

. Click an edge on the model.SpinFire™ indicates when your pointer is over an edge by highlighting the edge with a line.

. Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Measure the Vertex to Surface Normal Angle

Measure a Two Edges Angle

Measure a Surface Point to Edge Distance

The Surface Point to Edge command measures the distance between a point on a surface and an existing edge on the model. The "line" formed
by the selected edge will be extended in space and the distance measured will be between the point on the surface and the nearest point on the
"line" of the selected edge.

To measure the distance between a point on a surface and an edge:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

. Point to Surface Point to.

. Click Edge.

Click a point on a surface of the model.

. Click an edge on the model.SpinFire™ indicates when your pointer is over an edge by highlighting the edge with a line.

. Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure a Vertex to Edge Distance

Measure a Surface Point to Surface Point Distance

The Surface Point to Surface Point command measures the distance between two points on surfaces of the model.

To measure the distance between two surface points:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

. Point to Surface Point to.

. Click Surface Point.

. Click a point on a surface of the model.

. Click another point on a surface of the model.
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6. Drag the label into position and click once.
Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure a Distance in a 2D Document

Measure Tube Length

The Tubing command allows for the following measurements of a "Tube";

® Tube Length: Measures the length of a tube from arc radius to arc radius of the part being selected and generates the total centerline
length

®* Tube Bill of Materials: Exports a .csv file containing the following information;

Length

Diameter

Arcl Center XYZ

Arc2 Center XYZ

BendRadius

BendAngleDegrees

BendCenter XYZ

Intersection XYZ

Total length

To measure the length of a tube:

1. Open the Linear menu on the 3D Document Toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Pointto Tubing.

. Click Tube Length.

4. Click a starting arc radius on the model.
Recommendation: To find arc radii easier, select your model and render as smooth surfaces with edges.

5. Continue to click radii on the model in sequence until the end is reached.
A green line that traverses the center of the tube will indicate what will be measured.

6. Click the end arc radius a second time to end the measurement.

7. Drag the label into position and click once.
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@ If the green indication line appears incorrect then you either did not select the correct sequential arc or a portion of the tube cannot be
measured correctly by SpinFire.

Note

You can save your annotation and tube measurement in your .3D file and recall it when you open the file again. Previous versions of SpinFire will
not allow you to view Tube Lengths however the .3D files will open without them.

Measurement Tips

Selecting Arc Radii

Selecting each arc radii for a piece of tubing can be difficult since the default view does not show any of the arcs. It is highly recommended to
switch the Render Mode to Smooth Shading w/ Edges to reveal the arcs.

See Change the Render Mode of an Object.



Pipe length = 111.40 mm

Selecting an Incorrect Arc

If you select an incorrect arc by mistake, you must stop your current measurement and redo it or the measurement may not be correct.

One way to get around this is to measure smaller lengths then export these lengths in the Tube Length Bill of Materials and add up the lengths in
Excel. This allows simple, smaller measurements that are more tolerant to mistakes (i.e. - re-selecting 4 or 5 arcs is more acceptable than
re-selecting 50 arcs).

See Tube Length Bill of Materials.

Known Limitations

180 Degree Bends

Because the Tube Length measurement functionality operates on arc radii to measure, SpinFire cannot accurately measure a tube bend that is
180 degrees without an arc radius in the bend. SpinFire cannot follow the bend and measures one side of the bend with a straight line to the
other.



Pipe length = 101_60 mm

To overcome this issue, make sure 180 degree bends are split so it is measured in two pieces.

Pipe length = 15948 mm

Angled Cut Tubes

Tubes consisting of a vertical cut on one end and an angled cut on the other cannot measure the length correctly.

Pipe length = 3417.08 mm




Tube Length Bill of Materials

The Tube Length Bill of Materials command exports the measurements of the model's existing tube lengths to a .csv file.

To create a tube length bill of materials:

Prerequisites:

® Tube length measurements have been created.
® In the Markups view, any Tube Length markups that are checked will be used to create the Bill of Materials. Check/Uncheck the markups
appropriately.

1. Open the Linear menu on the 3D Document Toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

. Point to Tubing.

. Click Tube Length Bill of Materials.

. Select a folder and file name to save the bill of materials .csv file.

. Click OK.
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Known Limitations

Differing Diameters

The Tube Length Bill of Materials uses the diameter measurement from the start of the tube. If a the tube changes in diameter, this can be
reported in the Bill of Materials incorrectly.

Unicode Characters

Because the CSV format is simply a text delimited file, some characters could not be properly represented. Bill of Materials in Japanese, Chinese
(Simplified), Chinese (Traditional), and Korean will export in English.

Measure a Three Vertices Angle

The Three Vertices Angle command measures an angle defined by two segments with a common vertex. The second point you select will be the
vertex of the angle.

To measure an angle with three vertices:

1. Open the Angular menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Angular button. You should see
a drop-down menu listing the available commands.

2. Click Three Vertices Angle.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly
positioned over a vertex point.

3. Click three vertices on the model. The second point you select will be the vertex of the angle.

Note
« To cancel this operation, press Esc on your keyboard.

« If red dots do not appear on the model when you call the command, you may need to go to the 3D Viewer Options page of the Options
component and click the Vertices visible on picking check box.

« You can measure the angle in the opposite direction by right-clicking the label and selecting Flip Axis from the context menu.

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure a 3 Points Angle in a 2D Document
Measure a Two Vertices Draft-Angle
Change the Units of a Single Dimension

Reverse an Angle Measurement



Measure a Two Edges Angle
The Two Edges Angle command measures an angle defined by two edges on the model. The two edges picked must be co-planar.

To measure atwo edges angle:

1. Open the Angular menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Angular button. You should see
a drop-down menu listing the available commands.

. Click "Two Edges Angle".

Click an edge on the model.SpinFire™ indicates when your pointer is over an edge by highlighting the edge with a line.

Click a co-planar edge on the model.

Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure a Two Surface Normals Angle

The Two Surface Normals Angle command measures the angle defined by the normal vectors of two surfaces.

To measure the angle of two surface normals:

1. Open the Angular menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Angles button. You should see
a drop-down menu listing the available commands.

. Point to Surface Point to.

Click Surface Point.

Click a surface on the model.

Click another surface on the model.

Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure a Two Vertices Draft-Angle

The Two Vertices Draft-Angle command measures an angle defined by a line between two selected points and the X-, Y-, or Z-axis.

To measure atwo vertices draft angle:

1. Open the Angular menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Angular button. You should see
a drop-down menu listing the available commands.
2. Point to Draft-Angles.

3. Click Two Vertices Draft-Angle.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly
positioned over a vertex point.

4. Click two vertices on the model.The second point you select will be the vertex of the angle.
5. Drag the label into position and click once.

Note
« You can flip the direction of the axis segment used to form the angle by right-clicking the label and clicking Flip Axis from the context menu.

« If red dots do not appear on the model when you call the command, you may need to go to the 3D Viewer Options page of the Options
component and click the Vertices visible on picking check box.

« You can change the main axis from the right-click context menu.

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.



Related topics

Measuring and Annotating a Model
Change the Main Axis of a 2-Vertices Draft Angle
Reverse an Angle Measurement

Measure a Three Vertices Angle

Measure a Vertex to Edge Distance

The Vertex to Edge command measures the distance between a vertex point and an existing straight edge on the model.

To measure the distance between a vertex and an edge:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.
2. Click Vertex to Edge.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly positioned
over a vertex point.
. Click a vertex on the model.
. Click an edge on the model.SpinFire™ indicates when your pointer is over an edge by highlighting the edge with a line.
. Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model
Measure a Surface Point to Edge Distance
Measure a Straight Edge

Measure the Distance Between Two Vertices

Measure the Center of Mass of a Part

The Part Center of Mass command lists the X, Y, and Z coordinates of a part's center of mass.

To measure the center of mass of a part:

. Select the Assembly pane.

. Select the part, assembly, or sub-assembly that you would like to measure.

. Open the Calculate menu.The Calculate menu is locate at the top of the Assembly pane.
. Click Center of Mass.

. Drag the label and click to set the position.
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Note

* You can alternate among a Volume, Surface, or Center of Mass label by right-clicking the label and selecting the new measurement from the
menu.

Related topics

Measuring and Annotating a Model
Measure the Surface Area of a Part
Measure the Volume of a Part

Measure the Extents of a Single Part

Measure the Distance Between Two Surfaces

The Distance Between Two Surfaces command measures the distance between two flat parallel surfaces.
If you select a second surface that is not flat and parallel to the first pick, a message will appear.

The attachment point from the first selected surface is projected onto the second surface.



To measure the distance between a point on a surface and an edge:

1. Open the Linear menu on the 3D Document Toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a

drop-down menu listing the available commands.
. Select to Distance Between Two Surfaces.
. Click a point on a surface of the model.
. Click on a second surface of the model.
. Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure the Distance Between Two Vertices

The Vertex to Vertex Distance command measures the distance between two vertex points you select.

To measure the distance between two vertices:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a

drop-down menu listing the available commands.
2. Point to Vertex to Vertex.

3. Click Direct.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly positioned over a

vertex point.
4. Click two vertices on the model.
5. Drag the label into position and click the mouse.

Note

« By default, the Vertex to Vertex Distance command measures the direct distance between two points. To measure the distance between the two

points with respect to an axis, see Measure Two Vertices Along the X-, Y-, or Z-Axis.

« If red dots do not appear on the model when you call the command, you may need to go to the 3D Viewer Settings page of the Options
component and click the Vertices visible on picking check box.

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure a Straight Edge

Measure Two Vertices Along the X-, Y-, or Z-Axis
Measure a Distance in a 2D Document

Measure the Extents of a Model

The Extent Box command draws a box around an object in the scene along the X-, Y-, and Z-axes.

To measure the extents of a model:
1. Select the Assembly pane.

2. Click Scene. If you would rather measure the extents of a part or subassembly, then click that object instead.
3. Click the Extent Box button. This button is located at the top of the Assembly pane.

Related topics

Measuring and Annotating a Model

Measure the Extents of a Single Part

Measure the Extents of a Single Part

The Extent Box command draws a bounding box around a single part and measures the part along the X-, Y-, and Z-axes.



To measure the extents of a single part:

1. Select the Assembly pane.
2. Select the part, assembly, or sub-assembly that you would like to measure.
3. Click the Extent Box button.This button is located at the top of the Assembly pane.

Related topics

Measuring and Annotating a Model
Measure the Extents of a Model
Measure the Center of Mass of a Part
Measure the Surface Area of a Part

Measure the Volume of a Part

Measure the Sum of Connected Edges

The Sum of Connected Edges command measures the sum of any number of connected edges selected by the user.

To measure the sum of connected edges:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Click Sum of Connected Edges.

3. Click each connected edge that you would like to measure.SpinFire™ indicates when your pointer is over an edge by highlighting the
edge with a line.

4. Click one of the selected edges to display the measurement label.

5. Drag the label into position and click once.

Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics
Measuring and Annotating a Model

Measure a Boundary Center by Edges

Measure the Surface Area of a Part

To measure the surface area of a part:

. Select the Assembly pane.

. Select the part, assembly, or sub-assembly that you would like to measure.

. Open the Calculate menu.The Calculate menu is locate at the top of the Assembly pane.
. Click Surface.

. Drag the label and click to set the position.
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Note

« You can alternate among a Volume,Surface, or Center of Mass label by right-clicking the label and selecting the new measurement from the
menu.

Related topics

Measuring and Annotating a Model
Measure the Center of Mass of a Part
Measure the Volume of a Part

Measure the Extents of a Single Part

Measure the Vertex to Surface Normal Angle

The Surface Point to Vertex command measures an angle defined by the line between a vertex point and a surface point and the normal vector
of the surface.



To measure the angle between a vertex and the normal of a surface:

1. Open the Angular menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Angular button. You should see
a drop-down menu listing the available commands.

2. Point to Surface Point to.

3. Click Vertex.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly positioned over a
vertex point.

4. Click a vertex on the model.

. Click on a surface of the model.

. Drag the label into position and click once.
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Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure a Surface Normal to Edge Angle

Measure the Volume of a Part

To measure the volume of a part:

Select the Assembly pane.

Select the part, assembly, or sub-assembly that you would like to measure.

Open the Calculate menu.The Calculate menu is locate at the top of the Assembly pane.
Click Volume.

Drag the label and click to set the position.
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Note

« You can alternate among a Volume, Surface, or Center of Mass label by right-clicking the label and selecting the new measurement from the
menu.

Related topics

Measuring and Annotating a Model
Measure the Center of Mass of a Part
Measure the Surface Area of a Part

Measure the Extents of a Single Part

Measure Thickness

The Thickness command measures the distance between a surface you pick and the nearest surface.

Every surface has a "normal," that is, a vector perpendicular to the surface. When you pick a point on a surface, SpinFire™ searches the normal
in the opposite direction until it comes across another surface. The thickness measurement will be distance between the point on the surface you
picked and the point on the opposite surface.

To measure thickness:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Click Thickness.

3. Click a surface on the model.

4. Drag the label into position and click once.

Note

« If you want to add several of the same type of markup, you may select the Lock tool check box that appears when you select a markup
command. This will allow you to keep adding the same type of markup to the scene until you click Stop.

Related topics

Measuring and Annotating a Model

Measure Two Vertices Along the X-, Y-, or Z-Axis



By default, the Vertex to Vertex markup dimension command measures the direct distance between two points. You can, however, have a Vertex
to Vertex markup dimension measure the distance between the two points with respect to an axis.

To measure a distance along the X-, Y-, or Z-axis:

1. Open the Linear menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Linear button. You should see a
drop-down menu listing the available commands.

2. Point to Vertex to Vertex.

3. Click Along X, Along Y, or Along Z.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is
properly positioned over a vertex point.

4. Click two vertices on the model.This creates a label with the default measurement for the command.

5. Drag the label into position.

Note

« You can change the axis of an existing "Vertext to Vertex" markup dimension by right-clicking the label and clicking "Along X," "Along Y," or
"Along Z."

Related topics

Measuring and Annotating a Model

Measure the Distance Between Two Vertices
Measure a Two Vertices Draft-Angle

Measure a Straight Edge
Position a Markup Label

To move a markup label, simply drag it to the position you desire.
A line (or lines) will always indicate the spot on the model that the label is attached to.
Note

If you are unable to reposition a label, the Lock Position option might be enabled. See Lock a Markup Label in Position.

Related topics

Measuring and Annotating a Model
Lock a Markup Label in Position

Keep a Markup Label in Front of the Model
Reverse an Angle Measurement

When you insert an Dimension label that measures an angle, you can change the direction used to measure the angle with the Flip Axis comman
d on the Markup context menu.

To flip an angle measurement, right-click the label and select Flip Axis from the context menu.
Note

« The Flip Axis command works differently on a Three Vertices Angle and a Two Vertices Draft Angle.
« On a Three Vertices Angle, the Flip Axis command measures the angle in the opposite direction.

* On a Two Vertices Draft-Angle, the Flip Axis command flips the direction of the X-, Y-, or Z-axis segment used to form the angle.

Related topics

Measuring and Annotating a Model

Measure a Three Vertices Angle

Measure a Two Vertices Draft-Angle

Change the Main Axis of a 2-Vertices Draft Angle

Flip a Cross-Section Plane

Set the Default Decimal Places for Measurements



You can determine the default number of decimal places that will be used in 3D or 2D measurements. Default decimal places for 2D
measurements and 3D measurements must be set separately.

Set the default decimal places for measurements

Select the Options component

Select Settings.

Click either the 3D Viewer or 2D Viewer.These links are located at the top of the page.
Select the number of decimal places from the Decimal Places drop-down menu.

Click the Apply Settings button.
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Related topics

Measuring and Annotating a Model

Change the Decimal Places of a Measurement

Set the Default Font of Markups

You can determine the default font that will be used in 3D or 2D markups. Default fonts for 2D markups and 3D markups must be set separately.

To set the default font of markups:

Select the Options component

Select Settings.

Select either 3D Viewer or 2D Viewer.These links are located at the top of the page.
Click the font name listed as the Label Font.This opens the Font dialog box.

Select the desired font settings and click OK.

Click the Apply Settings button.
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Note

« You can change the font of an individual markup from the right-click menu. See Change the Font of a Markup.

Related topics

Measuring and Annotating a Model

Change the Font of a Markup
Set the Default Unit of Measurement

You can determine the default unit of measurement that will be used in 3D or 2D measurements. Default units for 2D measurements and 3D
measurements must be set separately.

To set the default unit of measurement:

Select the Options component

Select Settings.

Click either 3D Viewer or 2D Viewer.These links are located at the top of the page.

Select a unit from the Units drop-down menu located beneath the Measurements heading.
Click the Apply Settings button.
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Note
« You can change the unit of an individual measurement from the right-click menu. See Change the Units of a Single Dimension.
Related topics

Measuring and Annotating a Model

Change the Units of a Single Dimension

Measure Bounding Box

The Minimum Bounding Box command draws a box around an object in the scene along the X-, Y-, and Z-axes.

To measure the bounding box of a model:

1. Select the Assembly pane.



2. Click Scene. If you would rather measure the bounding box of a part or sub assembly, then click that object instead.
3. Right mouse click and select Calculate > Axis-Aligned Bounding Box or Calculate > Minimum Bounding Box.

(D The button located at the top of the Assembly pane is for the Axis-Aligned Bounding Box.

The Minimum Bound Box calculation may take longer on more complex objects. Pressing the ESC key will cancel the operation. An axis-aligned
bounding box will be created but hidden.

Differences

Given the same cube which is not aligned with the X, Y, or Z axis, each calculation provides different results

Axis-Aligned Bounding Box

The Axis-Aligned Bounding Box calculation finds the smallest box surround the object where the bounding box is aligned with the X, Y, and Z
axes. In the example below, the Reducer sample model has been transformed 45 degrees on the X, Y, and Z axes so
it is no longer axis aligned. Notice how the Axis-Aligned Bounding Box is calculated.

Dz=401.27 mm

Dx=598.08 mm

Minimum Bounding Box

Using the same model, the Minimum Bounding Box calculation tries to find the bounding box despite the axes. Here you can see the bounding
box forms to the Reducer model.



% Dx=645.92 mm

Known Issues

® The Minimum Bounding Box sometimes does not calculate correctly when a user coordinate is the active coordinate system.

® This does not occur for all models.
® As a work-around, temporarily make the global coordinates the active coordinate system and calculate the minimum bounding

box.

Related topics

Measuring and Annotating a Model

Measure the Extents of a Single Part

Working with 2D Documents

Working with 2D Documents

A 2D SpinFire™ document is one of the types of documents that can be contained in the SpinFire™ WorkSpace. A 2D SpinFire™ document
consists of a “page” onto which one or more drawing, measurements, and markups may be placed.

In addition, a 2D snapshot may be taken of a 3D document. The snapshot image will appear in a 2D document and can have redlining added to it.

Drawings

Whenever certain images files (.bmp, .jpg, .gif, .png, .tiff, .wmf, .emf) or 2D CAD formats are opened by SpinFire™, then a new 2D document will
be created in the WorkSpace and the file will be added to the document as a drawing. You may also import an image file or 2D CAD file as a
drawing into an existing 2D document in the WorkSpace.

Layers



A drawing in a 2D document may contain layers. A layer will be listed in the Drawings pane underneath its drawing. The visibility of a layer may be
turned on or off by clearing its check box. Commands to change the color of the layer are available from its right-click menu.

Snapshot of a 3D Document

Another way to add a drawing to a 2D document is to take a "Snapshot" of a 3D document in the WorkSpace. A Snapshot is a 2D image of the
current of the 3D scene. You can take a Snapshot and then either insert it to an existing 2D document or create a new 2D document for this

Shapshot. Snapshots in a 2D document can be distinguished from other types of drawing by the Snapshot icon =3 that appears on the
drawings when the document is in the "Drawings" picking mode.

One special feature of a Snapshot is the Update command. The Update command automatically updates a Snapshot of a model in a 2D
document to reflect the current state of the 3D document. This includes any markups, render modes, or part transformations that have been
added or removed from the 3D document, as well as the background color of the scene.

Please note that the Update command will not change the view of the Snapshot in the 2D document. The updated Snapshot will contain the
same view of the document as the original Snapshot, but changes to parts and markups will reflect the current state of the 3D document.

2D Measurements & Markups

The 2D Document Toolbar offers several measurement options:

« Direct Distance: Distance between two points.

« X Axis Distance: Distance between two points along the x-axis.

« Y Axis Distance: Distance between two point along the y-axis

« Arc by 3 Points: Diameter of a circle defined by three points selected by the user.

* Angle by 3 Points : Measurement of an angle defined by three points selected by the user.
« Angle by 4 Points : Measurement of an angle defined by four points selected by the user.

« Polygonal Area: Surface area of a polygon defined by user-selected points.
If measuring a document with vector data, the point will "snap" to an endpoint.

The measurement label may be dragged into position.

The measurement itself can be adjusted by dragging the measurement points to a new position. Options for editing a measurement are available
from its right-click menu.

2D Redlining Markups

The 2D Document Toolbar offers several redlining tools:

Shape Tools: Various predefined geometric shapes are available. Text may be added to the shapes.
« Rectangle

* Round Rect

* Oval
Callout Tools: Offers callout clouds. Text may be added to the callout.

« Left Callout
« Right Callout

¢ Cloud
Line Tools: Lines can be drawn with a specified arrowhead, color, and thickness.

« Line: Straight line.
« Polyline: Multiple connected straight lines.
« Curve: Curved line drawn around multiple points selected by the user.

« Closed Polyline: Shape made from multiple connected lines.
Text Box Tool: Text may be added to a drawing, with full control over font, size, and color.

Stamp Tools: Several commonly-used stamps may be added to a document.

* Accept



* Approved

* Rejected

« Confidential
* For Review
* Received

* Draft

* Preliminary
* Final

For Users of Non-English Versions of SpinFire™: The language a stamp appears in depends on the language version of SpinFire™ being
used. SpinFire Reader, however, does not come in multiple language versions; therefore, users using SpinFire Reader to view a 2D document
with a stamp will see that stamp in English.

By choosing the Markups mouse mode from the 2D Document Toolbar, you can pick any redlining markup in the 2D scene by clicking on it. A
picked markup will be surrounded by round handles. To move a picked markup, simply drag it into position. You may resize a markup by dragging
one of its handles. A yellow rotation handle can be used to rotate a markup (except for lines).

O A selected 2D markup. The selection handles enable resizing. The
o) yellow handle above the markup is for rotation.
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The Markups tab on the left side lists all the markups in a scene.

The right-click menu offers commands various commands for working with the markup, including setting the stacking order. The right-click menu
may be called from either a picked markup in the 2D scene or its listing in the Markups tab.

Picking Modes

Because markups can be placed on top of drawings in a 2D scene, the 2D Document Toolbar offers three mouse modes that determine which
elements can be picked:

« Page mode: User may pan, zoom, and rotate the page and all the contents within the Viewport. The mouse pointer will appear in the shape of a
hand. When this mode is selected you can change the default mouse command (Pan, Zoom, or Rotate) by clicking the mouse field in the bottom
of the application window or by right-clicking anywhere in the Viewport.

« Drawings mode: User may pick drawings in the scene. This allows the user to position, resize, or rotate a selected drawing.

* Markups mode: User may pick markups or measurements in the scene. This allows the user to position, resize, or rotate a selected markup.
The picking mode can be selected either by clicking the picking mode field at the bottom of the program window or from the buttons on the 2D
Document Toolbar.

Page Options and the Grid

The Page menu on the 2D Document Toolbar offers options for the page and the grid. Page options include settings for the page size, margins,
and color. To help you position drawings on the page, you can show a grid and set drawings to snap to the grid.

Related topics

Working with 2D Documents

Take a 2D snapshot of a 3D model
Update a 2D Snapshot

Import a Drawing into a 2D Document

Move a 2D Drawing



Resize a 2D Drawing

Rotate a 2D Drawing

Hide or Show a 2D Drawing

Delete a 2D Drawing

Add a Line to a 2D Document

Add a Shape to a 2D Document

Add a Stamp to a 2D Document

Add a Text Box to a 2D Document
Change the Formatting of a 2D Markup
Change the Transparency of a 2D Markup
Move a 2D Markup

Resize a 2D Markup

Rotate a 2D Markup

Edit the Text of a 2D Markup

Change the Size of a 2D Page

Show or Hide the Grid on a 2D page

Set Snap to Grid on a 2D Page

Change the Grid Size on a 2D Page
Change the Margins of a 2D Page
Change the Orientation of a 2D Page
Measure a Distance in a 2D Document
Measure an Arc Diameter in a 2D Document
Measure an Angle in a 2D Document
Measure a Polygonal Area in a 2D Document
Calibrate measurements to a scale

Turn off 2D Shadows
Add a Line to a 2D Document

The Line menu on the 2D toolbar offers three types of lines. The available selections are:

® Line Tool: A straight line.

® Polyline Tool: Multiple connected straight lines.

® Curve Tool: Curved line drawn around multiple points selected by the user.

® Closed Polyline Tool: A polyline where the endpoints will always form a closed loop.

To draw a straight line:

1. Open the Line menu on the 2D Document Toolbar and select Line Tool.
2. Drag the pointer in the 2D scene.

To draw a polyline, closed polyline, or curved line:

. Open the Line menu on the 2D Document Toolbar and select a tool.

. Click the starting point in the 2D scene.

. Move the pointer to draw a line segment.

. For polylines and closed polylines, click to begin a new line segment; for curved lines, click to indicate a curving point.

. Double-click to finish drawing the line.

. On the 2D toolbar, use the menus to select the color, width, and arrowhead for the line.These menus will appear on the 2D toolbar
anytime a line is selected.
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Related topics



Working with 2D Documents

Add a Shape to a 2D Document

Add a Stamp to a 2D Document

Add a Text Box to a 2D Document
Change the Formatting of a 2D Markup

Move a 2D Markup

Add a Shape to a 2D Document

The Shape and Callout menus on the 2D Document Toolbar offer the following selections:

Rectangle Tool
Rounded Rect Tool
Oval Tool

Callout Right Tool
Callout Left Tool
Cloud Tool

To add a shape to a 2D document:

1. Open the Shape or Callout menu on the 2D Document Toolbar and select a shape.
2. Drag across the 2D scene to draw the shape.
® |f drawing a Cloud or Callout, the Properties dialog box will immediately open for you to add text.
3. Use the menus on the 2D toolbar to change the fill and line of the shape, and the color, font, and formatting of any text.

Related topics

Working with 2D Documents

Add a Line to a 2D Document
Add a Stamp to a 2D Document
Add a Text Box to a 2D Document

Change the Formatting of a 2D Markup

Add a Stamp to a 2D Document

To add a stamp to a 2D document:

1. Open the Stamp menu on the 2D toolbar and select a tool.
2. Drag across the 2D scene to draw the stamp.

Note

« For Users of Non-English Versions of SpinFire™: The language a stamp appears in depends on the language version of SpinFire™ being
used.

« The line, fill, and text color and the line thickness of a stamp cannot be changed.

Related topics

Working with 2D Documents

Add a Line to a 2D Document
Add a Shape to a 2D Document
Add a Text Box to a 2D Document

Change the Formatting of a 2D Markup

Add a Text Box to a 2D Document

To add a text box to a 2D document:
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. Click the Text Box button —l on the 2D Document Toolbar. When this button is clicked, the pointer appears as a crosshair and the
words "Enter Text Here" appear beside it.

. Click in the 2D scene to place the text.Once this is done, the words "Enter Text Here" will disappear and be replaced by a cursor.

. Type the desired text.

. If you would like to begin a new line, press Ctrl+Enter.

. Press Enter to finish typing.Handles will appear around the text box, indicating it has been selected.

. Use the menus on the 2D toolbar to change the fill and line of the text box, and the color, font, and formatting of the text. These menus will
appear on the 2D toolbar anytime a text box is selected.
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Related topics

Working with 2D Documents
Add a Line to a 2D Document
Add a Shape to a 2D Document
Add a Stamp to a 2D Document

Change the Formatting of a 2D Markup
Calibrate Measurements to a Scale

By default, measurements in a 2D document are determined by the page size. You may, however, calibrate the measurements to a different scale
instead.

You will choose two points on a drawing and then set that line equal to a measurment you determine.

Using a smaller distance on the page will result in more accurate calibration.

To calibrate measurements to a scale:

. Select the Drawing picking mode.You may do this by clicking the Drawing picking mode button on the toolbar.

. Right-click a drawing.This displays Calibrate icon on the Toolbar.

. Click Calibrate Drawing.This will open the 2D Calibration Tool dialog box.

. Click the first point on the drawing.

. Click the second point on the drawing.

. If you would like to calibrate using the distance between the two points along an axis, select the X-Axis Aligned or Y-Axis Aligned optio

ns.

7. In the Distance on Drawing field, enter the distance you would like to set equal to the line you just drew.Use the drop-down menu to
choose the mesurement unit.
If you would like the scale to be a factor of the current scale, you may enter a number in the Cailbration factor field instead. For
example, setting the calibration factor to 3 creates a scale 3 times the current scale.

8. Click Apply or OK.
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Note

« Using a smaller distance on the page will result in more accurate calibration.

Related topics

Working with 2D Documents

Measure a Distance in a 2D Document
Measure an Arc Diameter in a 2D Document
Measure a 3 Points Angle in a 2D Document

Measure a Polygonal Area in a 2D Document

Change the Color of a Layer

You can create a custom color for a layer in a 2D document. You may then turn this custom color on and off.

To select a custom color for a layer:

In the Drawings pane, right-click the name of the layer.If you do not see the layer, expand the listing of its drawing.
Point to Custom Color.

Click Set Color.... This opens the Color dialog box.

Choose a color and click OK.
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Turn the custom color on or off:* In the Drawings pane, right-click the name of the layer.If you do not
see the layer, expand the listing of its drawing.

® Point to Custom Color.
® Click Turn Custom Color On or Turn Custom Color Off.

Related topics
Working with 2D Documents

Change the Formatting of a 2D Markup

The 2D toolbar offers menus for changing the appearance of 2D markups (lines, shapes, stamps, text boxes). When a markup is selected, the
formatting menus will appear on the toolbar.

The following menus format the appearance of a markup (not all menus are available for all types of markups):

Fill color

Line color

Text color

Line width

Font family

Font size

Arrowhead style (lines only)

To change the formatting of a 2D markup:

1. Select the markup. How?
® Click its listing in the Markups pane. Or choose the Markup picking mode and click the markup in the 2D scene. A selected
markup will be surrounded by handles.
2. Use the menus on the 2D toolbar to change the formatting of the markup.

Note

« If you do not see some or all of the markup formatting buttons on the toolbar when the markup is selected, resize the SpinFire™ window.

Related topics

Working with 2D Documents

Change the Transparency of a 2D Markup

Change the Grid Size on a 2D Page

The following steps will set the grid size for a page in a single 2D document. To set the default grid size for pages, see Set the Default Grid Size.

To change the grid size on a 2D page:

1. Open the Page menu on the 2D Document Toolbar.
2. Click Page Setup.This opens the Page Setup dialog box.
3. Inthe Grid Size field, enter the grid size (in inches).

Related topics

Working with 2D Documents

Set the Default Grid Size

Show or Hide the Grid on a 2D page
Set Snap to Grid on a 2D Page
Change the Size of a 2D Page
Change the Margins of a 2D Page
Change the Orientation of a 2D Page

Change the Margins of a 2D Page

The following steps will set the margins for a page in a single 2D document. To set the default margins for all 2D pages, see Set the Default Page
Margins.



To change the margins of a 2D page:

1. Open the Page menu on the 2D Document Toolbar
2. Click Page Setup.This opens the Page Setup dialog box.
3. Inthe Margins section, enter the Left, Right, Top, and Bottom margins (in inches).

Related topics

Working with 2D Documents

Set the Default Page Margins
Change the Size of a 2D Page
Change the Grid Size on a 2D Page

Change the Orientation of a 2D Page

Change the Orientation of a 2D Page

The following steps will change the orientation for a page in a single 2D document. To set the orientation for all 2D document pages, see Set the
Default 2D Page Orientation.

To change the orientation of a 2D page:

. Open the Page menu on the 2D Document Toolbar

. Click Page Setup.This opens the Page Setup dialog box.
In the Orientation section, select Portrait or Landscape.
Click OK.

Related topics

Working with 2D Documents

Set the Default 2D Page Orientation
Change the Size of a 2D Page
Change the Grid Size on a 2D Page

Change the Margins of a 2D Page

Change the Size of a 2D Page

The following steps will set the page size for a single 2D document. To set the default page size for 2D documents, see Set the Default Page Size

To change the size of a 2D page:

1. Open the Page menu on the 2D Document Toolbar.
2. Click Page Setup.This opens the Page Setup dialog box.
3. Set the size, orientation, and margins of the page and click OK.

Related topics

Working with 2D Documents
Change the Margins of a 2D Page
Change the Orientation of a 2D Page
Show or Hide the Grid on a 2D page

Set Snap to Grid on a 2D Page

Change the Transparency of a 2D Markup

You can change the transparency of the line, fill, and text of line, shape, and text box markups.

1. Select the markup. How?

® Click its listing in the Markups pane. Or choose the Markup picking mode and click the markup in the 2D scene. A selected
markup will be surrounded by handles.

2. Open the Line Color, Fill Color, or Text Color menu from the 2D Document Toolbar.



3. Click Transparency.This opens the Set Transparency dialog box.
4. Use the slider to set the transparency.

Related topics

Working with 2D Documents

Change the Formatting of a 2D Markup
Delete a 2D Drawing

To delete a 2D drawing:

1. Select the drawing. How?
a. Click its listing in the Drawings pane. Or choose the Drawing picking mode and click the drawing in the 2D scene. A selected
drawing will be surrounded by handles.
2. Right-click the drawing and select Delete.

Note

« You may also delete a drawing by selecting it and pressing the Delete button on the keyboard.

Related topics

Working with 2D Documents

Hide or Show a 2D Drawing

Edit the Text of a 2D Markup

You may change the text of a shape or text box once it has been added to a 2D scene.

1. Select the markup. How?
® Click its listing in the Markups pane. Or choose the Markup picking mode and click the markup in the 2D scene. A selected
markup will be surrounded by handles.
2. Right-click the markup.This opens the markup context menu.
3. Click Properties.This opens the Markup Properties dialog box.
4. Type text for the markup in the Title field.

Related topics

Working with 2D Documents

Add a Text Box to a 2D Document
Add a Shape to a 2D Document

Add Extra Text to a Label

Hide or Show a 2D Drawing

To hide or show a 2D drawing:

1. Select the Drawings pane.
2. Select or clear the check box beside the name of the drawing.

Note

« When in Drawings picking mode, you may also hide a drawing using the right-click menu.

Related topics

Working with 2D Documents

Delete a 2D Drawing

Import a Drawing into a 2D Document

The 2D mode allows you to import a raster image file (bmp, .jpg, .gif, .png, .tiff, .wmf, .emf) as a drawing.

In addition to this, you can also copy a snapshot of a 3D document to your clipboard and then paste it into a 2D document.



To import a raster image to a 2D document:

1. Make the 2D document active in the WorkSpace.If working with multiple documents, activate the desired document by clicking its
document tab.

2. Select File > Import from the menu bar.This opens the Import dialog box.

3. Choose the image file to import as a drawing.

Note

* You can also import a image file into an active 2D document by dragging the file from a Windows folder.

To paste a snapshot into a 2D document:

1. Make the 3D document active in the WorkSpace.|f multiple documents are open, you should click the tab of the document.

. Open the @ Snapshot menu on the General Toolbar.

. Click Take Snapshot.This copies the Snapshot to your clipboard.

. Click the tab of the 2D document you where would like to paste the snapshot.

. Open the Snapshot menu and click Insert Snapshot.The Snapshot will be inserted as a drawing in the 2D document.
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Related topics

Working with 2D Documents
Take a 2D snapshot of a 3D model

Add a New Document into the WorkSpace

Measure a Distance in a 2D Document

Measure a distance between two point with the Distance command. Use the Distance Along X or Distance Along Y commands to measure the
distance between two points along an axis.

To measure a distance in a 2D document:

1. Open the Measurement menu on the 2D Document Toolbar. How?
® Click the drop-down arrow to the right of the Measurement button. You should see a drop-down menu listing the available
commands.
. Pointto Linear
. Click Direct Distance.
. Click the first point.If measuring a document with vector data, the point will "snap” to a line on the page.
. Click the second point.
. Drag the measurement label into position.
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Note
« To measure the distance between two points along the x-axis or y-axis, use the X Axis Distance or Y Axis Distance command.
« To adjust the measurement, drag one of the measurement points to a new position.

« Options for editing a measurement are available from its right-click menu.

Related topics

Working with 2D Documents

Measure the Distance Between Two Vertices (3D document)
Measure a Two Surface Points Distance (3D document)
Measure an Arc Diameter in a 2D Document

Measure an Angle in a 2D Document

Measure a Polygonal Area in a 2D Document

Calibrate Measurements to a Scale

Measure an Angle in a 2D Document

To measure an angle using 3 points:

1. Open the Measurement menu on the 2D Document toolbar. How?Click the drop-down arrow to the right of the Measurement button. You



should see a drop-down menu listing the available commands.
. Click Angle by 3 Points.
. Click the first point of the angle.If measuring a document with vector data, the point will "snap" to a line on the page.
. Click the second point of the angle.This will be the vertex point.
. Click the third point of the angle.
. Drag the measurement label into position.
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To measure an angle using 4 points:

1. Open the Measurement menu on the 2D Document toolbar. How?Click the drop-down arrow to the right of the Measurement button. You
should see a drop-down menu listing the available commands.

. Click Angle by 4 Points.

. Click the first point of the angle.If measuring a document with vector data, the point will "snap" to a line on the page.

. Click the second point of the angle.These two points will define the first line of the angle.

. Click a third point.This will create a line connected to the first line that you will postion.

Drag to move the second line and click to set it into postion.

Drag to move the angle arc and click to set it into position.

. Drag the measurement label into position.
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Note
« You may position the measurement label by dragging it.
« To adjust the measurement, drag one of the measurement points to a new position.

« Options for editing a measurement are available from its right-click menu.

Related topics

Working with 2D Documents

Measure a Three Vertices Angle (3D document)
Measure a Distance in a 2D Document
Measure an Arc Diameter in a 2D Document
Measure a Polygonal Area in a 2D Document

Calibrate Measurements to a Scale

Measure an Arc Diameter in a 2D Document

To measure an arc diameter in a 2D document:

1. Open the Measurement menu on the 2D Document Toolbar. How?
#*Click the drop-down arrow to the right of the Measurement button. You should see a drop-down menu listing the available commands.

2. Point to Radial.
3. Click Arc by 3 Points.
4. Click the first point on the circle.If measuring a document with vector data, the point will "snap” to an endpoint.
5. Click the second point on the circle.A circle will appear to guide you as you size the circle.
6. Click the third point on the circle.The measurement will show a circle, a diameter line, and the length of the diameter.
7. Drag the measurement label into position.
Note

« To adjust the measurement, drag one of the measurement points to a new position.

« Options for editing a measurement are available from its right-click menu.

Related topics

Working with 2D Documents

Measure an Arc Diameter (3D document)
Measure a Distance in a 2D Document
Measure a 3 Points Angle in a 2D Document
Measure a Polygonal Area in a 2D Document

Calibrate Measurements to a Scale



Measure a Polygonal Area in a 2D Document

To measure a polygonal area in a 2D document:

1. Open the Measurement menu on the 2D Document toolbar. How?Click the drop-down arrow to the right of the Measurement button. You
should see a drop-down menu listing the available commands.

2. Click Polygonal Area.
3. Click and drag to draw the polygon.If measuring a document with vector data, the point will "snap" to an endpoint.
4. Double-click to finish drawing.
5. Drag the measurement label into position.The measurement measures the area of the polygon.
Note

* You may position the measurement label by dragging it.
« To adjust the measurement, drag one of the measurement points to a new position.

« Options for editing a measurement are available from its right-click menu.

Related topics

Working with 2D Documents

Measure a Distance in a 2D Document
Measure an Arc Diameter in a 2D Document
Measure a 3 Points Angle in a 2D Document

Calibrate Measurements to a Scale

Move a 2D Drawing

To move a 2D drawing:

1. Select the drawing. How?
a. Click its listing in the Drawings pane. Or choose the Drawing picking mode and click the drawing in the 2D scene. A selected
drawing will be surrounded by handles.
2. Drag the drawing into position.Be sure not to drag one of the handles, which will resize the drawing.

Related topics

Working with 2D Documents
Import a Drawing into a 2D Document
Resize a 2D Drawing

Rotate a 2D Drawing

Move a 2D Markup

To move a 2D markup:

1. Select the markup. How?

® Click its listing in the Markups pane. Or choose the Markup picking mode and click the markup in the 2D scene. A selected
markup will be surrounded by handles.
2. Drag the markup into position.Be sure not to drag one of the handles, which will resize the markup.

Related topics
Working with 2D Documents
Resize a 2D Markup

Rotate a 2D Markup
Resize a 2D Drawing

To resize a 2D drawing:



1. Select the drawing. How?Click its listing in the Drawings pane. Or choose the Drawing picking mode and click the drawing in the 2D
scene. A selected drawing will be surrounded by handles.

2. Drag one of the selection handles around the drawing.Be sure not to drag the yellow handle which rotates the drawing.
Related topics
Working with 2D Documents
Move a 2D Drawing

Rotate a 2D Drawing

Resize a 2D Markup

To resize a 2D markup:

1. Select the markup. How?

® Click its listing in the Markups pane. Or choose the Markup picking mode and click the markup in the 2D scene. A selected
markup will be surrounded by handles.

2. Drag one of the selection handles around the markup.Be sure not to drag the yellow handle which rotates the markup.
Related topics
Working with 2D Documents
Move a 2D Markup

Rotate a 2D Markup

Rotate a 2D Drawing

A 2D drawing may be rotated clockwise or counter-clockwise by dragging its yellow selection handle.

To rotate a 2D drawing:

1. Select the drawing. How?

a. Click its listing in the Drawings pane. Or choose the Drawings picking mode and click the drawing in the 2D scene. A selected
drawing will be surrounded by handles.

2. Drag the yellow selection handle that hovers above the markup.

Related topics
Working with 2D Documents
Move a 2D Drawing

Resize a 2D Drawing

Rotate a 2D Markup

Any 2D markup (except lines) may be rotated clockwise or counter-clockwise by dragging its yellow selection handle.

To rotate a 2D markup (except lines):

1. Select the markup. How?

® Click its listing in the Markups pane. Or choose the Markup picking mode and click the markup in the 2D scene. A selected
markup will be surrounded by handles.

2. Drag the yellow selection handle that hovers above the markup.

Related topics
Working with 2D Documents
Move a 2D Markup

Resize a 2D Markup

Set Snap to Grid on a 2D Page

Enabling "Snap to Grid" helps position drawings and markups by aligning them with guides on the 2D page. You can tell when it is enabled
because the Snap to Grid icon will have a yellow background on the menu and the button will look like it is pushed in.



To set snap to grid on a 2D page:

1. Open the Page menu on the 2D Document Toolbar.
2. Click Snap to Grid.

Note

« If the snap to grid % icon is visible in the document toolbar, you merely need to click it to enable or disable snap to grid.

Related topics

Working with 2D Documents
Show or Hide the Grid on a 2D page

Set Snap to Grid on a 2D Page

Set the Default 2D Page Orientation

The following steps will set the default page orientation for pages for 2D documents. To change the page orientation for an individual 2D
document, see Change the Orientation of a 2D Page.

To set the default 2D page orientation:

Select the Options component

Select Settings.

Click 2D Viewer.This link is located at the top of the page.
Select an Orientation of Portrait or Landscape.

Click the Apply Settings button.
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Related topics

Working with 2D Documents
Change the Orientation of a 2D Page

2D Viewer Settings

Set the Default Grid Size

The following steps will set the default grid size for pages in 2D documents. To change the grid size in an individual 2D document, see Change
the Grid Size on a 2D Page.

To set the default grid size:

Select the Options component

Select Settings.

Click 2D Viewer.This link is located at the top of the page.

Select the unit of measurement from the Units drop-down menu under the Page heading.
In the Grid Size fields, enter the grid size along the x-axis and y-axis.

Click the Apply Settings button.
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Related topics

Working with 2D Documents
Change the Grid Size on a 2D Page
Show or Hide the Grid on a 2D page

Set Snap to Grid on a 2D Page

Set the Default Page Margins

The following steps will set default margins for pages in 2D documents. To set the margin for an individual page, see Change the Margins of a 2D
Page

To set the default page margins:

1. Select the Options component
2. Select Settings.



. Click 2D Viewer.This link is located at the top of the page.

. Select the unit of measurement from the Units drop-down menu under the Measurement heading.
In the first Margins field, enter the right/left margin size.

In the second Margins field, enter the top/bottom margin size.

Click the Apply Settings button.
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Related topics
Working with 2D Documents

Change the Margins of a 2D Page

Set the Default Page Size

The following steps will set the default page size for pages in 2D documents. To change the page size in an individual 2D document, see Change
the Size of a 2D Page.

To set the default page size:

. Select the Options component.

. Select Settings.

Click 2D Viewer.This link is located at the top of the page.
Select the page size you want from the Size drop-down menu.
Click the Apply Settings button.
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Related topics
Working with 2D Documents

Change the Size of a 2D Page

Show or Hide the Grid on a 2D page

To show or hide the grid on a 2D page:

1. Open the Page menu on the 2D Document Toolbar
2. Click Show Grid.

Related topics
Working with 2D Documents
Set Snap to Grid on a 2D Page

Change the Grid Size on a 2D Page
Take a 2D snapshot of a 3D model

SpinFire™ allows you to take a 2D snapshot of a 3D document and work with it in 2D document. The snapshot will be a 2D image of the current
view of the document. You may take a snapshot and immediately open it in a new 2D document (using the New Snapshot command). Or you

may copy the snapshot to your clipboard and paste it into an existing open 2D document (using the Take Snapshot and Insert Snapshot comma
nds).

To take a Snapshot and create a new 2D document:
1. Make the 3D document active in the WorkSpace.|If multiple documents are open, you should click the tab of the document you want.

2. Open the @ Snapshot menu on the General Toolbar.
3. Click New Snapshot.A new 2D document with the Snapshot will be created.

To take a Snapshot and paste it into an existing 2D document:
1. Make the 3D document active in the WorkSpace. If multiple documents are open, you should click the tab of the document.

. Open the @ Shapshot menu on the General Toolbar.

Click Take Snapshot.This copies the Snapshot to your clipboard.

Click the tab of the 2D document you where would like to paste the snapshot.

Open the Snapshot menu and click Insert Snapshot.The Snapshot will be inserted as a drawing in the 2D document.
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Related topics

Working with 2D Documents
Update a 2D Snapshot
Working with Documents in the .3D WorkSpace

Turn off 2D Shadows

The following steps will allow you to control 2D shadowing in 2D documents. By default, 2D shadowing is turned on.

To turn of 2D shadows:
1. Select the Options component
2. Select Settings.
3. Click 2D Viewer.
® This link is located at the top of the page.
4. Deselect Shadows (to turn off shadowing).

5. Click the Apply Settings button.

Related topics

Working with 2D Documents

Update a 2D Snapshot

You can automatically update a Snapshot in a 2D document to reflect the current state of the scene in the 3D document. This includes any
markups, render modes, or part transformations that have been applied to the model, as well as the background color of the scene. The updated
Snapshot will be taken with the same view of the scene as the original Snapshot, but changes to parts and markups will reflect the current
state of the 3D scene.

To update a Snapshot:

1. Choose the Drawings selection mode.This can be done either by clicking the Select Drawings button K on the toolbar or the picking
mode field at the botton of the window.
2. Click the drawing in the 2D scene.The selected drawing will be indicated by handles.

3. Click the Update Snapshot button Bﬂ on the toolbar.

Related topics
Working with 2D Documents
Take a 2D snapshot of a 3D model

Working with Multiple Documents

Working with Documents in the .3D WorkSpace

Working with Documents in the .3D WorkSpace

A .3D file can contains multiple documents in its .3D WorkSpace. The SpinFire™ WorkSpace component lets you open all the documents
contained in a .3D file and save multiple documents in a single .3D file.

The SpinFire™ WorkSpace can contain three types of documents:
* 3D SpinFire™ Document for three-dimensional geometries. The 3D Document Toolbar offers commands for working with 3D models.

« 2D SpinFire™ Document for raster image files and snapshots of 3D documents. The 2D Document Toolbar offers commands for working with
2D documents.

» Other document such as PDF, Word, Excel, or text files.
Each document will be indicated by a tab at the top of the WorkSpace. You may view a document by clicking its tab to make it active. By



right-clicking the tab you can open the Document menu.

Adding a Document to the .3D WorkSpace

To add additional documents to the WorkSpace, you can use the Add Document command. You may call this command by choosing Document
> Add Document. If you choose to add a .3D file which contains several documents, then a dialog box will ask you which of the documents you
would like to add to your WorkSpace.

When you have documents open in the WorkSpace, the Open command (File > Open, or clicking the Open button on the General Toolbar) closes
all documents open in the WorkSpace and opens a new file.

Importing a File into a Document

The Import command can be used to import an appropriate file into an active 3D document or 2D document.

For example, you may want to import a .3D or CAD file into the 3D scene of a 3D document. The imported geometry will be added to the existing
scene in the 3D document. You may perform this type of importing by selecting File > Import. You may also drag a .3D or CAD file into the
WorkSpace component when a 3D document is active.

Similarly, you may import a raster image file (.bmp, .jpg, .gif, .png, .tiff, .wmf, .emf) as a drawing in a 2D document. To import a raster image file,
you can select File > Import.

Dragging a File to the WorkSpace

If you drag a file to the WorkSpace (either from a Windows folder or the Library), it will be imported into the active document if the file is of the
appropriate type. Otherwise, the file will be added as a new document in the WorkSpace.

When a 3D document is active in the WorkSpace, then dragging a CAD file or a .3D file (with only a single three-dimensional geometry) will import
the geometry into the 3D scene.

If a 2D document is active in the WorkSpace, you can drag a raster image file or certain 2D CAD files into the 2D scene.

If a file dragged to the WorkSpace is not of the appropriate type to be imported into the active document, then a dialog box will ask if you would
like to add it as a new document in the WorkSpace.

Saving Documents in the .3D WorkSpace

Not only can you work with several documents in the WorkSpace, but you can also save all those documents within a single .3D file.
The Save and Save As commands save all the documents open in the WorkSpace in a single .3D file.

To save only some of documents in your WorkSpace into a single .3D file, select File > Save a Copy. At the bottom of the dialog box, all the
documents in the WorkSpace will be listed. By default, all the documents in the WorkSpace will be saved in the .3D file. If you would like to have
one or more of the documents not included in the .3D file, clear the "Save all documents" check box and clear any document you do not want to
be included.

Removing Documents

You can remove a single document from the WorkSpace by right-clicking the document tab and clicking Remove. When a document is removed
from the WorkSpace, it will not be saved as part of the .3D file.

You can close all the documents in a WorkSpace by right-clicking the document tab and clicking Close WorkSpace or by selecting File > Close f
rom the menu bar. If any changes have been made to documents, you will be asked if you want to save the changes.

Reordering Documents in a WorkSpace
You can change the order in which the documents appear in your WorkSpace. This is important because when a WorkSpace is saved as a .3D

file, the first document will be what a user who views that file using SpinFire Reader will see. Also, the first document determines the image that
appears when a user uses Windows thumbnail view to list files in a folder.

See Reorder Documents in the WorkSpace for details.

Related topics

Add a New Document into the WorkSpace

Save Multiple Documents in a Single .3D File



Close Documents in the WorkSpace
Reorder Documents in the WorkSpace
Rename a Document

Add an Empty Document to the WorkSpace

Add a Local Folder to Your Library

Local folders can include any folder on your hard drive or network. Local folders are identified by a folder icon .

To add alocal folder to your Library:

. Select the Library component.

. Click the Add Local Folder button in the Library toolbar.This opens a dialog box listing your local and network folders.
. Navigate through the directory tree and click the folder you want to add.

. Click OK.
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Related topics

Remove a Local Folder from the Library

Add an Empty Document to the WorkSpace

You can add an empty 2D or 3D document to an open WorkSpace. An empty 3D document will have no model in the 3D scene. An empty 2D
document will contain a page but will have no drawings or markups. Once an empty document had been created, you may add models, drawings,
and markups, just as you would with any other document.

To add an empty document to the .3D WorkSpace

1. Select the WorkSpace component.You will not be able to add an empty document until a document is already open in the WorkSpace.
2. Select Document > New > 2D Document or 3D Document.

Related topics

Working with Documents in the .3D WorkSpace

Add a New Document into the WorkSpace

Add a New Document into the WorkSpace

SpinFire™ allows several documents to be added to the .3D WorkSpace. If you already have documents in the SpinFire™ WorkSpace, you can
add the documents contained in a .3D file to the current WorkSpace.

To add a new document into the WorkSpace:

1. Select Documents > Add DocumentThis opens the SpinFire™ Add Document dialog box.
2. Double-click the file you want to open in the WorkSpace.

Note

« If you add a .3D file that contains multiple documents, a dialog box will ask which of the documents in that file you would like to add to the
WorkSpace.

* When you have multiple documents open in a WorkSpace, then all those documents will be saved in the .3D file (the one listed in the title bar of
the application) when you perform the Save command.

« Dragging a file to the WorkSpace component will generally add that file as a new document in the WorkSpace. The exceptions are when you
drag a CAD file or a .3D file (containing a single 3D geometry document) into an active document in 3D mode or drag a raster file into an active
document in 2D mode; in those cases the file will be imported directly into the active document.

Related topics

Working with Documents in the .3D WorkSpace
Import a Single Document into a Scene

Import a Drawing into a 2D Document

Save Multiple Documents in a Single .3D File

Add an Empty Document to the WorkSpace



Add an Office Document to the WorkSpace

SpinFire™ allows Office documents to be added to the .3D WorkSpace for systems that have Office installed.

To add an Office document into the WorkSpace:

1. Select Documents > Add Document This opens the SpinFire™ Add Document dialog box.
2. Double-click the Office file you want to open in the WorkSpace.

1 Be Careful
“ If using a version of Office with SpinFire™ greater than Office 2003 then one may need to make some registry changes that Microsoft
removed in Office 2007 and 2010. These are the same registry entries that allow Office documents to appear within Internet Explorer.

Registry changes for Office 2007 and 2010

1. Copy and paste the following code snippet into Notepad.
2. Save the file as a .reg file (example: SpinFire_FixOffice.reg).
3. With the appropriate system permissions, double click the .reg file.
® This will automatically update your registry with the entries listed below.



W ndows Registry Editor Version 5.00

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Wor d. Docunent . 8]
" Br owser Fl ags" =dwor d: 80000024

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Wr d. RTF. 8]
" Browser Fl ags" =dwor d: 80000024

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Wor d. Docunent . 12]
" Browser Fl ags" =dwor d: 80000024

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Wor d. Docunent Macr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 80000024

[ HKEY_LOCAL_NMACHI NE\ SOFTWARE\ Cl asses\ Excel . Sheet . 8]
" Browser Fl ags" =dwor d: 80000A00

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Excel . Sheet . 12]
" Browser Fl ags" =dwor d: 80000A00

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Excel . Sheet Macr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 80000A00

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Excel . Sheet Bi nar yMacr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 80000A00

[ HKEY_LOCAL_NMACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Show. 8]
" Br owser Fl ags" =dwor d: 800000A0

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Show. 12]
" Browser Fl ags" =dwor d: 800000A0

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Showvacr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 800000A0

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt. Sl i deShow. 8]
" Browser Fl ags" =dwor d: 800000A0

[ HKEY_LOCAL_NMACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Sl i deShow. 12]
" Br owser Fl ags" =dwor d: 800000A0

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Sl i deShowiacr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 800000A0

® Torevert the changes:
1. Copy and paste the following code snippet into Notepad.
2. Save the file as a .reg file (example: SpinFire_RevertOffice.reg).
3. With the appropriate system permissions, double click the .reg file.
® This will automatically update your registry with the entries listed below.
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[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Wor d. Docunent . 8]
" Br owser Fl ags" =dwor d: 00000008

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Wr d. RTF. 8]
" Browser Fl ags" =dwor d: 0000002c

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Wor d. Docunent . 12]
" Browser FI ags" =dwor d: 0000002c

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Wor d. Docunent Macr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 0000002c¢

[ HKEY_LOCAL_NMACHI NE\ SOFTWARE\ Cl asses\ Excel . Sheet . 8]
" Browser Fl ags" =dwor d: 00000008

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Excel . Sheet . 12]
" Browser Fl ags" =dwor d: 00000008

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Excel . Sheet Macr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 00000008

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Excel . Sheet Bi nar yMacr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 00000008

[ HKEY_LOCAL_NMACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Show. 8]
" Browser Fl ags" =dwor d: 0000000A

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Show. 12]
" Browser Fl ags" =dwor d: 0000000A

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Showvacr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 0000000A

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt. Sl i deShow. 8]
" Browser Fl ags" =dwor d: 0000000A

[ HKEY_LOCAL_NMACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Sl i deShow. 12]
" Browser Fl ags" =dwor d: 0000000A

[ HKEY_LOCAL_MACHI NE\ SOFTWARE\ Cl asses\ Power Poi nt . Sl i deShowiacr oEnabl ed. 12]
" Browser Fl ags" =dwor d: 0000000A

Close Documents in the WorkSpace

To close a single document in the WorkSpace:

1. Click on the tab of the document you want to remove so that it is the active document.
2. Right-click the document tab.
3. Click Remove.

Note

* You can also close the active document by selecting Document > Remove Document.



To close all documents in a workspace:

1. Right-click the tab of a document.
2. Click Close WorkSpace.

Note

« You can also close all documents in the WorkSpace by selecting File > Close from the menu bar.

Related topics

Working with Documents in the .3D WorkSpace
Add a New Document into the WorkSpace
Save Multiple Documents in a Single .3D File

Remove a Local Folder from the Library

You might want to remove a local folder that you do not think you are going to use with SpinFire™ anymore. Removing a local folder from your
Library does not delete it from your computer; it only removes the link to the folder in the SpinFire™ Library.

To remove alocal folder from the Library:

. Select the Library component.

. Right-click the local folderThis opens the folder context menu.
. Click Remove.A dialog box asks you to confirm your decision.
. Click OK.
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Related topics

Add a Local Folder to Your Library
Rename a Document

To rename a document:

1. Right-click the document tab.
2. Click Rename.This opens the Rename Document dialog box.
3. Enter the new name of the document and click OK.The new name will appear on the document tab.

Related topics

Working with Documents in the .3D WorkSpace
Reorder Documents in the WorkSpace

You can change the order of the documents in the workspace. This is important because when a workspace is saved as a .3D file, the first
document will be what a user who views that file using SpinFire Reader (or some older versions of SpinFire™) will see. Also, the first document
determines the image that appears when a user uses Windows thumbnail view to list files in a folder.

To reorder documents in the workspace:

1. Right-click a document tab.

2. Click Reorder.This opens the Reorder Documents dialog box.

3. Select the name of the document you want to move and click the Move Up or Move Down button until the documents are in the order
you want.

4. Click OK.

Related topics

Working with Documents in the .3D WorkSpace
Add a New Document into the WorkSpace
Save Multiple Documents in a Single .3D File

Save Multiple Documents in a Single .3D File

When you use the Save command, then all the documents open in the workspace will be saved in the .3D file indicated in the application title bar.



To save only some of documents in your workspace into a single .3D file, select File > Save a Copy.

To save all open documents as a .3D file:

1. Select File > Save or File > Save As

To save selected documents in a .3D file:

. Select File > Save a CopyThis opens the SpinFire™ Save Copy As dialog box.
. Clear the Save all documents check box.

Clear any documents you do not want to save in the .3D file.

Enter a name for the file.

Click Save.
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Related topics
Working with Documents in the .3D WorkSpace
Add a New Document into the WorkSpace

Close Documents in the WorkSpace

Viewing PMI Annotations

Viewing PMI Annotations

SpinFire™ is able to work with specified Actify Importers to import PMI (Product and Manufacturing Information) from native 3D CAD files. PMI is
also known as GD&T (Geometric Dimensioning and Tolerancing) or MBD (Model Based Definition).

Annotation planes, datums, geometric tolerances, dimensions, and notes will be imported into a 3D document in the SpinFire™ WorkSpace. If the

WorkSpace is saved as a .3D file, the PMI will be saved along with the file.

A scene with PMI annotations. The dashed orange border indicates an annotation plane.

Listing of PMI Annotations

SpinFire™ lists all PMI annotations in the scene in the Annotation pane of the WorkSpace component.

The Annotation Planes in the scene are listed at the top of the pane. The pane then lists the parts in the scene and the PMI annotations
associated with that part. The annotations are grouped by type: Datums, Geometric Tolerances, Dimensions, and Notes.

The Description field provides further information about some of the annotations. For example, for the Geometric Tolerances the Description field
will list a category such as Form, Profile, Orientation, Location, or Runout.

Hiding and Showing Annotations in the Scene

The listing of the annotations in the Annotation and Assembly panes let you control the visibility. To hide an annotation, clear the check box
beside its listing. To show an annotation, select the check box beside its listing. You may also hide an annotation by right-clicking it in the 3D
scene and selecting Hide.

PMI annotations cannot be deleted.



Note: When hiding an Annotation Plane, you will be hiding only the border of the plane, not the annotations on that plane.

Selecting an Annotation and Viewing related Annotations and Surfaces

Selecting an annotation will highlight that annotation as well the associated surface (or part) and any associated datums or feature control frames.
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In this scene both a PMI annotation and the surface associated with that annotation are highlighted.

Changing your View to Better Read an Annotation Plane

The "View by Plane" command positions your view to better read the annotations on an annotation plane.
This command can be called by right-clicking an annotation and selecting View by Plane.

Although the View by Plane command positions your view to better read the annotation, it will not zoom the view in or out. So if you want to see
the entire plane in the Viewport you may need to call the Fit an Entire Model within the Viewport command as well.

Related topics

Hide or Show PMI Annotations

Hide or Show an Annotation Plane Border

Highlight a Surface or Part Associated with a PMI Annotation
Highlight Related Datums and Feature Control Frames
Position the View to Better Read an Annotation Plane

Turn On-Off Auto-Fading for PMI Annotations

Turn On-Off Forward Facing for PMI Annotations

Hide or Show an Annotation Plane Border

PMI annotation planes are indicated by a dashed border. You may turn the visibility of this border on or off.

Hide or Show an Annotation Plane Border

1. In the WorkSpace components, click Annotations.This opens the Annotations pane.

2. To control the visibility of all the planes, click the check box beside Annotation Planes.

3. To control the visibility of an individual annotation plane, try clicking the check box next to an Annotation Plane entry until the desired
plane is found.

Related topics

Viewing PMI Annotations

Hide or Show PMI Annotations

Hide or Show PMI Annotations



To Hide or Show All PMI:

1. In the 3D Document Toolbar, open the Display menu
2. Click PMI Annotations.

To Hide or Show Individual PMI Annotations:

1. In the WorkSpace component, select the Annotations or Assembly pane.If you don't see an annotation in the pane you may need to
expand the part or surface object associated with the annotation.
2. Select or clear the check box next to the annotation listing.

Note

« You can also hide an annotation by right-clicking it in the 3D scene and clicking Hide.

Related topics

Viewing PMI Annotations
Hide or Show an Annotation Plane Border

Highlight a Surface or Part Associated with a PMI Annotation

Selecting a PMI annotation in a 3D document will highlight its associated surface on the geometry. If no surface is associated with an annotation,
then the part will be highlighted.

To highlight a surface or part associated with a PMI annotation:

1. Click the annotation's listing in the Annotations or Assembly pane.This highlights the selected annotation, the associated surface or
part, as well as any associated annotations.

Note
* You may also select an annotation by right-clicking it in the 3D scene.

« If the PMI is a "scene" annotation, then no surface or part will be highlighted.

Related topics

Viewing PMI Annotations

Highlight Related Datums and Feature Control Frames
Hide or Show PMI Annotations

Highlight Related Datums and Feature Control Frames

Selecting a PMI annotation in a 3D document will highlight any datums or feature control frames associated with that annotation.

To highlight related datums and feature control frames:

1. Click the annotation's listing in the Annotations or Assembly pane.This highlights the selected annotation, the associated surface or
part, as well as any associated annotations.

Note

« You may also select an annotation by right-clicking it in the 3D scene.

Related topics

Viewing PMI Annotations
Highlight a Surface or Part Associated with a PMI Annotation

Hide or Show PMI Annotations

Position the View to Better Read an Annotation Plane

The View by Plane command positions your view to better read the annotations on an annotation plane.

To position the view to better read an annotation plane:



1. Right-click an annotationThis may be done either in the Annotations pane, the Assembly pane, or the 3D scene.
2. Click View by Plane.The view is re-positioned to better read the annotation plane associated with that annotation.

Note

« You may also right-click an Annotation Plane listing in the Annotations pane and click View by Plane.

Related topics

Viewing PMI Annotations
Turn On-Off Auto-Fading for PMI Annotations

Turn On-Off Forward Facing for PMI Annotations

Turn On-Off Auto-Fading for PMI Annotations

The Angle-Fading feature fades the annotations on a plane as the plane gets close to being perpendicular to the screen.

By default this setting is turned on, but it may be turned off by changing a setting in the Windows Registry. Angle-fading for annotation and for
annotation plane can be set separately.

Warning: Be careful when changing the Registry. Modifying the wrong Registry key may seriously harm your computer's performance. Only
perform this operation if you are comfortable using the Registry Editor.

To turn on/off Auto-Fading:

. Open the Windows Registry EditorGo to Start > Run and type regedit

. Select the HKEY_CURRENT_USER/Software/Actify/InstallApps/SpinFire Reader/General Options

. To change fading for annotations, right-click the PMI Annotations AngleFading value and click Modify.

. To turn OFF Angle-Fading, change the value data to 0; to turn ON Angle-Fading change the value data to 1.

. To change fading for annotation planes, right-click the PMI AnnotationPlanes AngleFading value and click Modify.
. To turn OFF Angle-Fading, change the value data to O; to turn ON Angle-Fading change the value data to 1.
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Related topics
Viewing PMI Annotations
Turn On-Off Forward Facing for PMI Annotations

Hide or Show PMI Annotations

Turn On-Off Forward Facing for PMI Annotations

By default this setting is turned on, but it may be turned off by changing a setting in the Windows Registry.

Warning: Be careful when changing the Registry. Modifying the wrong Registry key may seriously harm your computer's performance. Only
perform this operation if you are comfortable using the Registry Editor.

To turn on/off Auto-Fading:

. Open the Windows Registry EditorGo to Start > Run and type regedit

. Select the HKEY_CURRENT_USER/Software/Actify/InstallApps/SpinFire Reader/General Options

. To change forward facing for annotation planes, right-click the PMI Annotations AutoRotate value and click Modify.
. To turn OFF Angle-Fading, change the value data to O; to turn ON Angle-Fading change the value data to 1.
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Related topics
Viewing PMI Annotations
Turn On-Off Auto-Fading for PMI Annotations

Hide or Show PMI Annotations

Cross-Sectioning a Model

Cross-Sectioning a Model

The capability to display a cross-section of a part or assembly is one of the most important and useful features of SpinFire™. Mechanical
designers look at cross-sections to have a better understanding of the structure of a part and of hidden components in an assembly.

The Cross-Section menu on the 3D Document toolbar lists the commands available for cross-section planes. You add a cross-section to the



scene by clicking Enable Section.

Cut Material and Show Profile

A cross-section in SpinFire™ can perform two functions:

1. Cut Material: The cross-section can cut through the visible material of the model.
2. Show Profile: The section profile is an outline of all the points of the model that intersect with the section plane.

By default both the Cut Material and Show Profile functions are enabled for a section plane, but you can disable either one. Furthermore, you can
turn off the cut or profile for just selected parts or subassemblies. This is useful if you want to section a certain portion of an assembly but not all
the geometries in the 3D scene.

You can enable or disable the cut or profile for the entire scene from the Cut Material and Show Profile commands on the Cross-Section menu
on the 3D Document toolbar. To enable or disable the cut or profile for an individual part or subassembly, right-click the object in the Assembly p
ane and then click Cut Material or Show Profile.

By default, the section profile will be outlined in red along the cross-section plane. You can change this color by calling the Profile Color comman
d.

The Cross-Section view in the Views pane displays the section profile without displaying the geometry.

Defining a Plane

By default, the cross-section plane will be a plane bounded by the YZ axes that passes through the (0,0,0) point of the global coordinate system.
The Cross-Section menu contains options for you to precisely define other planes.

The Align submenu lets you choose a YZ Plane, XZ Plane, or XY Plane and then pick a vertex point on the model for the plane to intersect.
The Place By submenu offers the following commands for defining a plane:

® 3 Vertices: A plane defined by three vertices you select on the model.

® 2 Vertices: A plane that is perpendicular to a line defined by two vertices you select on the model. The initial plane will pass through the
first vertex you select.

® 2 Screen Points: A plane that is parallel to the line defined by any two points you select in the Viewport. The two points do not have to
be vertex points and do not even have to be on the model. The initial plane will pass through the two points you select.

The Section Definition dialog box offers greater precision and more options for defining a cross-section plane. Use the Define submenu to call
tabs on the Section Definition dialog box.

From the Position tab, you can choose a point that the plane will intersect. The point can be specified by entering its coordinates in the X, Y, and
Z fields. Or you can designate a point in the 3D scene by choosing an option from the drop-down menu, clicking the Pick button, and selecting an
appropriate point or coordinate system in the scene. (See Position a Cross-Section Plane for details.)

From the Orientation tab, you can orient the plane perpendicular to a line. This line may be specified by entering vector values in the X, Y, and Z
fields. Or you can designate a line in the 3D scene by choosing an option from the drop-down menu, clicking the Pick button, and clicking an
appropriate point in the scene. (See Orient a Cross-Section Plane for details.)

From the Movement tab, you can move an enabled plane a certain number of units along its translation axis.

Rotation and Translation

Once you have created your plane, you are free to rotate it and translate it into the desired position.

To rotate a plane, point to one of the plane's side handles (not a corner or center handle) and drag it to a new orientation. When you point to a
side rotation handle, it should turn yellow and display a curved arrow; a yellow line representing the rotation axis will appear in the center of the
lane to help guide you. When a cross-section plane is nearly parallel to a principal plane--x¥—%Z—¥Z--it will snap exactly to that position.
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A cross-section plane being rotated. Notice the yellow line in the center of the plane.
To translate, or shift, a plane, point to one of the plane's corner handles or the center handle and drag to the desired position. When you point to
a corner or center translation handle, it should turn yellow and display a straight arrow.

To pan the cross section plane, point to one of the plane's "offset edge" handles (they are located slightly outside the borders of the projection
plane). When you point to an offset edge handle, it turns yellow and displays a straight arrow indicating which direction the plane will pan.

The length of the cross-section profile is the sum of all the points where the cross-section plane intersects the model. The lines of this
cross-section profile can be seen by enabling the Show Profile option on the Cross-Section menu or by selecting the Cross-Section view from
the Views pane.

Displaying a Cross-Section

The Cross-Section menu gives you access to several commands--Erable-Section—Enable-Gapping:—HHp--that control how the cross-sectioning is
displayed. You can also access these commands from a context menu by right-clicking any plane handle.

Enable/Disable Section turns the cross-section on and off.

By default, a cross-section plane shows the model as if it has been cut straight through; the section is transparent and you can see into the model.
The Capping command changes that by filling in the sectioned edge of a model so that it appears solid.

A cross-sectioned model will be visible on one side of the plane and invisible on the other. The Flip X-Section command switches these two
sides.

The cross-section plane normally appears as a gray rectangle. You can turn this coloring on and off using the Show Plane command.

Related topics

Create a Standard Cross-Section Plane

Create a 3 Vertices Cross-Section Plane

Create a 2 Vertices Cross-Section Plane

Create a 2 Screen Points Cross-Section Plane

Rotate a Cross-Section Plane

Translate a Cross-Section Plane

Flip a Cross-Section Plane

Disable a Cross-Section

Disable Cross-Sectioning for Parts and Subassemblies
Display a Clear Cross-Section Plane

Cap a Cross-Section

Cap a Cross-Section

By default, a cross-section plane shows the model as if it has been cut straight through; the section is transparent and you can see into the model.
The Capping option on the Cross-Section menu can fill in the sectioned edge so that it appears solid.

To cap a cross-section:

1. Position your pointer over any handle of the plane.The handle will turn yellow and show an arrow.
2. Right-click the handle.This opens the Cross-Section context menu.
3. Click Capping Visible.

Note
« You can disable the Capping Visible option in the same manner.

« You can also enable and disable capping from the Cross-Section menu on the 3D Document Toolbar.

Related topics

Cross-Sectioning a Model

Display a Clear Cross-Section Plane

Change the Color of a Cross-Section Profile



You may set the color of the Cross-Section Profile that appears on a Cross-Section plane.

To the color of the profile on a cross-section plane:

1. Open the Cross-Section menu on the 3D Document Toolbar.
2. Click Profile Color....This opens the Color dialog box.
3. Select a color.

Related topics

Cross-Sectioning a Model
View a Cross-Section Profile

Create a 2 Screen Points Cross-Section Plane

A 2 Screen Points Cross-Section Plane is a plane that is parallel to the line defined by any two points you select on the screen. The two points do
not have to be vertex points and do not even have to be on the model. The initial plane will pass through the two points you select.

To create a 2 Screen Points Cross-Section Plane:

1. Open the Cross-Section menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Cross-Section button. You
should see a drop-down menu listing the available commands.

2. Point to Place By.

3. Click 2 Screen Points.

4. Click any two places in the scene.

Related topics

Cross-Sectioning a Model
Create a Standard Cross-Section Plane
Create a 2 Vertices Cross-Section Plane

Create a 3 Vertices Cross-Section Plane

Create a 2 Vertices Cross-Section Plane

A 2 Vertices Cross-Section Plane is a plane that is perpendicular to the line defined by two vertices you select.

To create a 2 Vertices Cross-Section Plane:

1. Open the Cross-Section menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Cross-Section button. You
should see a drop-down menu listing the available commands.

2. Point to Place By.
3. Click 2 Vertices.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly positioned over

a vertex point.
4. Click two vertices on the model.

Related topics

Cross-Sectioning a Model
Create a Standard Cross-Section Plane

Create a 3 Vertices Cross-Section Plane

Create a 3 Vertices Cross-Section Plane

A 3 Vertices Cross-Section Plane is a plane defined by three vertex points you select on the model.

To create a 3 Vertices Cross-Section Plane:

1. Open the Cross-Section menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Cross-Section button. You
should see a drop-down menu listing the available commands.

2. Point to Place By.
3. Click 3 Vertices.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer is properly positioned over

a vertex point.
4. Click three vertices on the model.



Related topics

Cross-Sectioning a Model
Create a Standard Cross-Section Plane
Create a 2 Vertices Cross-Section Plane

Create a 2 Screen Points Cross-Section Plane

Create a Standard Cross-Section Plane

Standard planes are bound by the X-, Y-, and Z-axes. Each of these planes are bound by two axes and can be translated, or shifted, along the
third axis.

For example, if you select "XY Plane," the resulting rectangular plane is defined by the X- and Y-axes; it can be rotated around the X- and Y-axes
and translated along the Z-axis.
To create a standard cross-section plane:

1. Open the Cross-Section Plane menu on the 3D Document toolbar.How?Click the drop-down arrow to the right of the Cross-Section
button. You should see a drop down menu listing the available commands.

2. Point to >Align.
3. Click eitherXY Plane,XZ Plane, orYZ Plane.Red dots designate available vertices on the model. A cross-hatch indicates when the pointer

is properly positioned over a vertex point.
4. Click the point where you would like the plane to be positioned.

Related topics

Cross-Sectioning a Model

Create a 2 Vertices Cross-Section Plane
Create a 2 Screen Points Cross-Section Plane

Create a 3 Vertices Cross-Section Plane

Disable a Cross-Section

To disable a cross-section:

1. Open the Cross-Section menu on the 3D Document toolbar. How?Click the drop-down arrow to the right of the Cross-Section button. You
should see a drop down menu listing the available commands.
2. Click Enable Section.

Note

« If the icon is visible in the 3D Document toolbar, you merely need to click it to enable or disable the cross-section.

Related topics

Cross-Sectioning a Model

Disable Cross-Sectioning for Parts and Subassemblies
Display a Clear Cross-Section Plane

Disable Cross-Sectioning for Parts and Subassemblies

By default, cross-sectioning affects every part of an assembly. However, you can choose to enable and disable cross-sectioning for each of the
parts and subassemblies in your model.

You must have a cross-section plane enabled before you can enable or disable the cross-sectioning for the objects in an assembly.

To disable or enable cross-sectioning for an object:

1. Inthe Assembly pane, right-click the name of the part, subassembly, or assembly for which you would like to disable or enable
cross-sectioning.This opens the context menu.

2. Point to Section.
3. Click Cut Material.The Cut Material command will be checked when cross-sectioning is enabled for the object.

Related topics



Cross-Sectioning a Model
Disable a Cross-Section

Display a Clear Cross-Section Plane

Display a Clear Cross-Section Plane

By default, the rectangular cross-section plane is gray in color. However, you can make the cross-section plane clear with the Plane Visible com
mand. The handles of the cross-section will still remain visible in the Viewport and you can manipulate the cross-section plane in exactly the same
way. You can then restore the gray coloring with the Show Plane command.

To hide or show a cross-section plane:

1. Position your pointer over a handle of the plane.The handle will turn yellow and show an arrow.
2. Right-click the handle.This opens the Cross-Section context menu.
3. Click Plane Visible.The Plane Visible command will be checked when the plane is shaded and unchecked when the plane is clear.

Note
« This same procedure is used to restore the shading to the plane.
* The Plane Visible command is also availabe from the Cross-Section menu on the 3D Document Toolbar.

« If you would like to disable the cross-section entirely, and not merely remove the coloring from the plane, see Disable a Cross-Section.

Related topics
Cross-Sectioning a Model
Disable a Cross-Section
Cap a Cross-Section

Enable-Disable the Cut of a Cross-Section

By default a cross-section plane cuts through the geometry in a 3D scene so that the material on one side of the plane is visible and on the other
side is invisible. This behavior may be enabled or disabled through the Cut Material option.

A cross-section plane must be enabled for Cut Material to be available.

To enable/disable the cut of a cross-section:

1. Open the Cross-Section menu on the 3D Document Toolbar.
2. Click Cut Material.

Related topics
Cross-Sectioning a Model

Export a Cross-Section Profile to EMF

The Cross-Section Profile consists of the points where the cross-section plane intersects the model. A vector representation of this profile may be
exported as an EMF file.

To export a cross-section profile to EMF

. Make sure the cross-section plane is enabled.
. Right-click a cross-section plane handle.

. Click Export Profile.

. Choose a name for the file and click Save.
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Note

« You may also perform this operation from the menu bar by selected File > Export > EMF > Section Profile...

Related topics

Cross-Sectioning a Model

View a Cross-Section Profile

Flip a Cross-Section Plane



The Flip command switches which side of the plane hides the model and which side shows the model.

To flip a cross-section plane:

1. Position your pointer over a handle of the plane.The handle will turn yellow and show an arrow.
2. Right-click the handle.This opens the Cross-Section context menu.
3. Click Flip Section.

Note

* You can also call the Flip command from the Cross-Section menu in the 3D Document toolbar.

Related topics

Cross-Sectioning a Model

Rotate a Cross-Section Plane
Measure Cross-Section Length

By default, a cross-section plane shows the model as if it has been cut straight through; the section is transparent and you can see into the model.
You can measure the cross section length of the model by selecting cross-section length from the Cross-Section context menu.

A cross-section plane must be enabled to measure the cross-section length.

To measure the cross-section length:

Open the Cross-Section menu on the 3D Document Toolbar.

Click Enable Section.

Position your pointer over a handle of the plane.The handle will turn yellow and show an arrow.
Right-click the handle.This opens the Cross-Section content menu.

Click Cross-Section Length.
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Note

*The length of the profile is displayed in a pop-up.

Related topics

Cross-Sectioning a Model

Change the Color of a Cross-Section Profile

Orient a Cross-Section Plane

You may orient a cross-section plane by selecting a side handle and rotating the plane. (See Rotate a Cross-Section Plane for details.) Or you
may orient a plane precisely from the Section Definition dialog box, which lets you define a vector to which the plane will be perpendicular.

To orient a cross-section plane:

1. Open the Cross-Section menu from the 3D Document toolbar. How?Click the drop-down arrow to the right of the Cross-Section button.
You should see a drop down menu listing the available commands.
2. Point to Define.
. Click Orientation.From the Orientation tab you will define a vector to which the cross-section plane will be perpendicular.
4. Choose one of two methods to define a vector:Enter the coordinates:
a. Inthe X, Y, and Z fields, enter the coordinates of the vector.
The vector will be defined with respect to the Global Coordinate System.
b. Click Apply to see the effect of the repositioning.
c. Click OK to save the position and close the dialog box.
--OR--
Choose a vector from the scene:
a. Select an option from the drop-down menu.
The options are:
« Pick a 2 Vertices: Select two vertex points on the model.
 Pick a Coordinate System Axis: Select an axis of a coordinate system in the scene.
« Pick an Edge: Click a straight edge on the model. When the pointer is properly positioned over an edge, the edge will be highlighted.
b. Click the Pick button.
c. Click the appropriate element in the scene.
d. Click OK to save the orientation and close the dialog box.
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Related topics



Cross-Sectioning a Model
Position a Cross-Section Plane

Rotate a Cross-Section Plane

Position a Cross-Section Plane

You may position a cross-section plane by selecting a corner or center handle and translating the plane along an axis. (See Translate a
Cross-Section Plane for details.) Or you may position a plane precisely from the Section Definition dialog box.

From the Section Definition dialog box you can define a point the plane will intersect from the Position tab. Or you can move the current location
of the plane by a desired number of inches using the Movement tab.

To choose a point of intersection for the plane:

1. Open the Cross-Section menu from the 3D Document toolbar. How?Click the drop-down arrow to the right of the Cross-Section button.
You should see a drop down menu listing the available commands.
2. Point to Define.
3. Click Position.This opens the Section Definition dialog box with the Position tab selected.
4. Choose one of two methods to select a point the plane will intersect:Enter the coordinates:
a. Inthe X, Y, and Z fields, enter the coordinates of the point.
This point will be defined with respect to the Global Coordinate System.
b. Click Apply to see the effect of the repositioning.
c. Click OK to save the position and close the dialog box.
--OR--
Pick a point in the scene:
a. Choose a method for selecting a point from the drop-down menu.
The available methods are:
« Pick a Vertex: Select a vertex point on the model
« Pick a Coordinate System: Select a coordinate system in the scene. The point will be the origin point of the frame.
b. Click the Pick button.
c. Click the appropriate element in the scene.
d. Click OK to save the position and close the dialog box.

To move the location of a plane:

1. Open the Cross-Section menu from the 3D Document toolbar. How?Click the drop-down arrow to the right of the Cross-Section button.
You should see a drop down menu listing the available commands.

. Point to Define.

Click Movement.This opens the Section Definition dialog box with the Movement tab selected.

. In the Step field, enter the number of inches you would like to move to plane.

Use the << and >> buttons to move the plane by the number of inches in the Step field.

. Click OK.
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Related topics
Cross-Sectioning a Model
Orient a Cross-Section Plane

Translate a Cross-Section Plane

Rotate a Cross-Section Plane

You can freely rotate a cross-section plane along an axis by dragging a side handle.

To rotate a plane:

1. Position your pointer over a side handle (not a corner or center handle) of the plane.The handle will turn yellow and show an curved
arrow. A yellow line will appear in the center of the plane to help guide your rotation.
2. Drag the handle until the plane is in the position you want.

Note
« Do not use a corner or center handle to rotate. The corner handles and center handle are for translating, or shifting, a plane.

* When a cross-section plane is nearly parallel to a principal plane--x¥-—>%Z—¥Z--it will snap exactly to that position.

Related topics



Cross-Sectioning a Model
Translate a Cross-Section Plane
Flip a Cross-Section Plane
Rotate a View

Rotate an Object in an Assembly

Translate a Cross-Section Plane

You can translate, or shift, a cross-section plane into position along an axis by dragging a corner handle or the center handle.

To translate a plane:

1. Position your pointer over a corner or center handle (not a side handle) of the plane.The handle will turn yellow and show a straight
arrow.
2. Drag the handle until the plane is in the position you want.

Note

« Do not use a side handle to translate. Side handles are for rotating a plane.

Related topics
Cross-Sectioning a Model
Rotate a Cross-Section Plane
Flip a Cross-Section Plane

Translate an Object in an Assembly

View a Cross-Section Profile

The Cross-Section Profile consists of the points where the cross-section plane intersects the model. There are two ways to view this cross-section
profile. One is to show the outline of the profile on the cross-section plane in the 3D scene. The second way is to select the Cross-Section view in
the Views pane, which shows just the profile and does not display any geometry.

A cross-section plane must be enabled for the cross-section profile to be available.

To show/hide the profile on a cross-section plane:

1. Open the Cross-Section menu on the 3D Document Toolbar.
2. Click Show Profile.

To display the cross-section profile view:

1. Select the Views pane in the WorkSpace.
2. Click Cross-Section under "Standard Views."

Note

« The length of the profile is displayed in the label that appears when you select a handle of a cross-section plane.

Related topics
Cross-Sectioning a Model
Change the Color of a Cross-Section Profile

Export a Cross-Section Profile to EMF

Projected Area

The projected area function allows users to easily view and calculate the area of the projected plane.
To access the projection plane, activate the cross section and then select the Projection Mode option under the Cross Section plane menu.
The projected surface area is very useful in sheet metal forming applications to calculate the necessary press tonnage.

The control of the projection plane uses many of the same functions as the cross-section plane. Refer to the cross section help for details on how
to manipulate the plane.



Warning
{D When the projected area is calculated, only the portion included in the plane will be used to calculate the surface area. So if the part
falls off of the plane, be sure to move the plane such that the entire part is shown on the projection plane.

Below is an example of a part with the projection plane activated and the surface area calculation displayed.
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sing Multiple Coordinate Systems

Using Multiple Coordinate Systems

Users can define their own coordinate systems and include multiple coordinate systems in a 3D scene.

Every scene viewed in SpinFire™ contains the Global Coordinate System, which defines the (0,0,0) point and the direction of the x-, y-, and
z-axes. Users can include additional coordinate systems with their own positions and orientations. The Markups pane of the WorkSpace
component lists all the coordinate systems in a scene.

Like markups and views, coordinate systems are included when you save a model in Actify's .3D file format.

The Active Coordinate System

At all times, one of the available coordinate systems is designated as the active coordinate system. The triad for the active coordinate system
appears larger in the 3D scene and its name is bold on the Markups pane. You can designate any coordinate system as the active coordinate
system by right-clicking it and selecting Active Coordinate System.

The active coordinate system affects part rotations, part translations, and certain dimension measurements. By default, these commands are
performed with respect to the active coordinate system.

A dimension markup takes its measurement with respect to the coordinate system that is active at the time the markup is created. When the
active coordinate system changes, the dimension label will not change---it will still display the measurement with respect to the coordinate system
that was active when the dimension was created. If you would like to change which coordinate system a dimension markup is measured with
respect to, you may do so from the Markup Properties dialog box. (See Change a Dimension's Coordinate System for details.)



When using the Rotate or Translate command to position a part, you may select a coordinate system other than the active coordinate system
from the "Relative To:" drop-down menu. (See Rotate an Object in an Assembly and Translate an Object in an Assembly for details.)

Creating and Editing a Coordinate System

To create or edit a coordinate system, you will use the Coordinate System dialog box. (See Add a Coordinate System, Position a Coordinate
System, and Orient a Coordinate System for step-by-step instructions.)

The Coordinate System dialog box contains the Position and Orientation tabs which set the location and direction of the coordinate system. Both
the Position and Orientation tabs offer two methods for defining position and orientation: either pick an element in the scene or enter precise
figures into the dialog box.

From the Position tab, you can determine the origin point of the coordinate system either by selecting a vertex point or circle on the model or by
entering the distance the origin point will be offset with respect to the origin point of another coordinate system. (See Position a Coordinate
System for details.)

From the Orientation tab, you can set the x-, y-, or z-axis by clicking two vertices on the model or an axis of another coordinate system. Or you
can set the axis by entering the values of a vector relative to another coordinate system. (See Orient a Coordinate System for details.)

The Global Coordinate System cannot be edited or deleted.

Related topics

Add a Coordinate System

Position a Coordinate System
Orient a Coordinate System

Set the Active Coordinate System
Rename a Coordinate System
Delete a Coordinate System

Hide or Show Coordinate Systems

Focus on a Coordinate System

Add a Coordinate System

A 3D scene may incorporate user-defined coordinate systems and include multiple coordinate systems. You will need to set the position and
orientation of any new coordinate system you add to the scene. The default settings of a new coordinate systems are equal to those of the active
coordinate system.

To add a coordinate system:

1. Select the Markups pane in the WorkSpace component.
2. Right-click Coordinate Systems.This opens the Coordinate Systems context menu.
3. Click *New Coordinate System...*This opens the Coordinate System dialog box.
4. In the Name field, type a name for the coordinate system.
5. Select the Position tab.
6. Choose one of two methods to set the origin point:Picking a point on the model:
a. From the drop-down menu, choose a method for setting the origin.
The methods for determining the origin point are:
« Pick a Vertex: Select an available vertex point on the model.
« Pick a Circle: Select a circle on the model. The origin will be set to the circle's center point.
If the method you would like to select is already visible in the drop-down menu, you may simply click the Pick button.
The Pick button should appear pressed in before you pick an element in the scene.
b. Click the desired location in the 3D scene.
--OR--
Offseting the origin with respect to another coordinate system:
a. Select a coordinate system from the Relative to drop-down menu.
The origin point of the new coordinate system will be offset relative to the origin point of the coordinate system in the Relative to field.
b. Enter the number of units you want the origin point offset in the Position X, Position Y, and Position Z fields.
c. Click Apply.
7. Select the Orientation tab.This tab lets you set an axis of the coordinate system equal to a vector. This can be done either by selecting a
vector from the 3D scene or by entering vector values in the dialog box.
8. Select the option button for the axis you want to orient.The options buttons are the round buttons to the left of the X-Axis, Y-Axis, and
Z-Axis options. The selected axis will be oriented.
9. Choose one of two methods to set the orientation of the axis:Selecting a vector in the 3D scene:
a. From the drop-down menu, choose a method for setting the axis.
The methods for determining the orientation of an axis are:



« Pick 2 Vertices: Select two available vertex points on the model. The axis direction will be toward the first point picked.
« Pick 3 Vertices (Normal Plane): Pick three points to define a plane.
« Pick Normal on Surface: The axis will be oriented to the normal vector of the selected surface.
« Pick an Edge: Select an edge on the model. When the pointer is properly positioned over an edge, the edge will be highlighted on the
model.
« Pick Another Coordinate System Axis: Click the axis of another coordinate system in the scene.
If the method you would like to select is already visible in the drop-down menu, you may simply click the Pick button.
The Pick button should appear pressed in before you pick an element in the scene.
b. Click the desired location in the 3D scene.
--OR--
Entering vector values in the dialog box:
a. From the Relative to drop-down menu, choose the coordinate system you would like the vector to be relative to.
b. Enter values in the x, y, and z fields next to the selected axis.
c. Click Apply.
10. Click OK to save the settings of the coordinate system and close the dialog box.

Note
« A coordinate system may be repositioned or re-oriented at any time. See Position a Coordinate System and Orient a Coordinate System.

* You may also add a coordinate system from the Coordinate System menu on the 3D Document toolbar by clicking the New Coordinate System
button.

Related topics

Using Multiple Coordinate Systems
Add a Coordinate System

Position a Coordinate System
Orient a Coordinate System

Set the Active Coordinate System

Hide or Show Coordinate Systems

Delete a Coordinate System

To delete a coordinate system:

1. Right-click the coordinate system you want to delete.This can be done from either the Markups tab or in the 3D scene.
2. Click Delete.A dialog box will ask you to confirm.

Note

« The Global Coordinate System cannot be deleted.

Related topics

Using Multiple Coordinate Systems
Hide or Show Coordinate Systems

Rename a Coordinate System

Orient a Coordinate System

A 3D scene may incorporate user-defined coordinate systems by including multiple coordinate systems. A coordinate system may be re-oriented
at any time by setting it equal to a vector.

To orient a coordinate system:

. Right-click the coordinate system.This can be done either on the Markups tab or the frame in the 3D scene.

. Select Properties.This opens the Coordinate System dialog box.

. Select the Orientation tab.

. Select the option button for the axis you want to orient.The options buttons are the round buttons to the left of the X-Axis, Y-Axis, and
Z-Axis options. The selected axis will be oriented.

5. Choose one of two methods to set the orientation of the axis:Selecting a vector in the 3D scene:

a. From the drop-down menu, choose a method for setting the axis.

The methods for determining the orientation of an axis are:

« Pick 2 Vertices: Select two available vertex points on the model. The axis direction will be toward the first point picked.

« Pick 3 Vertices (Normal Plane): Pick three points to define a plane.
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Note

» Pick Normal on Surface: The axis will be oriented to the normal vector of the selected surface.

« Pick an Edge: Select an edge on the model. When the pointer is properly positioned over an edge, the edge will be highlighted on the
model.

« Pick Another Coordinate System Axis: Click the axis of another coordinate system in the scene.

If the method you would like to select is already visible in the drop-down menu, you may simply click the Pick button.
The Pick button should appear pressed in before you pick an element in the scene.

b. Click the desired location in the 3D scene.

c. Click OK to save the orientation and close the dialog box.
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Entering vector values in the dialog box:

a. From the Relative to drop-down menu, choose the coordinate system you would like the vector to be relative to.
b. Enter values in the x, y, and z fields next to the selected axis.

c. Click Apply.

d. Click OK to close the dialog box.

« You may cancel a "Pick" operation by pressing the Esc key.

« The Global Coordinate System cannot be re-oriented.

Related topics

Using Multiple Coordinate Systems

Add a Coordinate System

Position a Coordinate System

Position a Coordinate System

A 3D scene may incorporate user-defined coordinate systems by including multiple coordinate systems. The origin point of a coordinate system
may be repositioned at any time.

To position a coordinate system:

Note

1. Right-click the coordinate system.This can be done either on the Markups tab or the frame in the 3D scene.
2. Select Properties.This opens the Coordinate System dialog box. The Position tab should be selected.
3. Choose one of two methods to set the origin point:Picking a point on the model:

a. From the drop-down menu, choose a method for setting the origin.

The methods for determining the origin point are:

« Pick a Vertex: Select an available vertex point on the model.

« Pick a Circle: Select a circle on the model. The origin will be set to the circle's center point.

If the method you would like to select is already visible in the drop-down menu, you may simply click the Pick button.
The Pick button should appear pressed in before you pick an element in the scene.

b. Click the desired location in the 3D scene.

c. Click OK to save the orientation and close the dialog box.
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Offseting the origin with respect to another coordinate system:

a. Select a coordinate system from the Relative to drop-down menu.

The origin point of the new coordinate system will be offset relative to the origin point of the coordinate system in the Relative To field.
b. Enter the number of units you want the origin point offset in the Position X, Position Y, and Position Z fields.

c. Click Apply.

d. Click OK to close the dialog box.

* You may cancel a "Pick" operation by pressing the Esc key.

* The Global Coordinate System cannot be repositioned.

Related topics

Using Multiple Coordinate Systems

Add a Coordinate System

Orient a Coordinate System

Focus on a Coordinate System

Rename a Coordinate System



To rename a coordinate system:

1. Right-click the coordinate system and select Properties.This can be done from either the Markups tab or in the 3D scene. This will open
the Coordinate System dialog box.

2. In the Name field, type the new name.

3. Click OK.

Note
« The Global Coordinate System cannot be renamed.

* You may also rename a selected coordinate system by choosing Rename from the right-click menu or pressing F2.

Related topics

Using Multiple Coordinate Systems
Add a Coordinate System

Delete a Coordinate System

Rotate a Coordinate System Around an Axis

To rotate a coordinate system around an axis:

. Right-click the coordinate system.This can be done either on the Markups tab or the frame in the 3D scene.
. Click Properties.This opens the Coordinate System dialog box.

. Click the Rotation tab.

Select an axis to rotate the coordinate system around.

. In the Rotation value field, enter the degrees to rotate the coordinate system.
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Related topics

Using Multiple Coordinate Systems
Position a Coordinate System
Orient a Coordinate System

Set the Active Coordinate System

A 3D scene may incorporate user-defined coordinate systems. At all times, one of the available coordinate systems is designated as the active
coordinate system. The active coordinate system appears larger in the 3D scene and its name is bold in the Markups pane.

The active coordinate system affects part rotations, part translations, and certain dimension measurements. By default, these commands are
performed with respect to the active coordinate system.

To set the active coordinate system:

1. Right-click the coordinate system you want to make active.This can be done from either the Markups tab or the 3D scene.
2. Select Active Coordinate System.

Note

« A dimension markup takes its measurement with respect to the coordinate system that is active at the time the markup is created. When the
active coordinate system changes, the dimension label will not change---it will still display the measurement with respect to the coordinate system
that was active when the dimension was created.

Related topics

Using Multiple Coordinate Systems
Add a Coordinate System

Position a Coordinate System
Orient a Coordinate System

Hide or Show Coordinate Systems

Configuring Importers



Configuring Importers

The user can configure the Importer settings like Attribute, Type and Tessellation available for the selected importer. Each Importer has different
options available. Some common options associate file extensions with the importer, determine the default unit of measurement, set the precision
of trimesh approximation, and select filters for entities associated with that file type.

There are various options available for the Importers. Few options are specific to few Importers only. And quite a few options are common for
most of the Importers which SpinFire supports.

Related topics

Select Importer Configuration

Available Configuration Options

Available Configuration Options

The Options button opens up a dialog box which features settings for Filtering Options like Attribute, Type and Tessellation available for that
importer. Each importer has different options available. Some common options associate file extensions with the importer, determine the default
unit of measurement, set the precision of trimesh approximation, and select filters for entities associated with that file type.

You can customize selected Importer options like Attribute, Type and Tessellation available for the that importer.

After you have made desired changes in the dialog box, be sure to click the OK button located at the bottom of the dialog box.

Related topics

Configuring Importers

Select Importer Configuration

Extended CAD

Some CAD files contain attribute meta data captured within them. The Extended CAD (introduced in SpinFire 10.6) feature allows users to extract
this information into a .txt file.

Currently, a text file is created in the same folder that the source file exists. The file is named <source file>.txt (example: cadfile.prt.txt). The file is
created when the source file is opened. If there are no attributes to extract, a file will not be created.

If the file cannot be created, the an error will appear and the operation will halt. Causes may be due to insufficient disk space or permissions.
To configure:

. In SpinFire, go to the Importers page.

. Click on the Options button for the applicable importer.
. Check the Write Out Attributes Metadata check box.

. Click OK or Apply.
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' Importer Settings for § inﬁrve‘ w L =NR= ﬂ

NX (Unigraphics) 3D and 2D "] Build: 1725.5

Importer for Unigraphics 30 and 2D files, parts and assemblies. Support up to NX8.5 for 3D and 2D. This
importer works ONLY with SpinFire 10.6 or higher and Centro 6.1 or higher unless an Actify importer 5P is
applied.

Import 2D documents

Import hidden entities [~

Import layers as separate parts

Import solid parts |

Import surfaces

Import wire frame entities [

Join surfaces of each single part [
Paths for searching parts data files

Run in silent mode

Tessellation custom precision (50-10000) 1

Tessellation quality [Medium -

Write Out Attributes Metadata

o) (o) (]|

{D Extended CAD is licensed software. Please contact your system administrator for information about your licensing status.
This feature exists for only the following importers:

® Catiavb
® [nventor

e JT

* NX

e Pro-E

¢ SolidWorks

The Import Only Display Data SolidWorks importer option must be unchecked for Extended CAD to
function.

(D Warning

If a file already exists with the same path and name as the Extended CAD file, SpinFire will automatically overwrite it.

Known Issues

® Some SolidWorks data is not extracted to the Extended CAD file due to known issue. (example: Actify created a simple object with three
Number fields and a Yes/No field. Only the first Number field was extracted)
® Multiple "density" attributes are written for SolidWorks and NX files.
® The following attributes are missing from Inventor extractions:
® Manager
® Revision Number
® Create Date



SpinFire™ Plug-ins

Plug-ins are pieces of software that add functionality to SpinFire Professional. A plug-in might add a new component tab to the program or it may
add a new object to the toolbar. Parts List is a plug-in which provides the combined list of all the parts with the names and quantity represented in
the 3D file. (inclusive of number, size, specification and grade of each piece).

Automated Excel

The Automated Excel plug-in provides a quick and easy way to get a summary of your parts lists along with some part information into Microsoft
Excel.

The plug-in provides the ability to combine versions of the assembly in one document so that easy comparisons can be done using Excel
functionality. The comparison type reports can compare assembly versions where the names are the same or where they are different. For
example when an assembly is updated, a comparison report can be run to compare what has changed. In the case where the assembly is sent
out to a vendor and they provide their version where the names have changed, the plug-in allows you to match up part names so that you can
compare volume and surface area changes between the two versions.

The plug-in extracts the following information:

® 3D file name

® File path to .3D

® Snapshot image of current display in the workspace
® Part name for every component in the assembly

® Volume for each component

® Surface area for each component

® Quantity for each component

The process of creating a report involves 5 steps.

. Select the report type

. Select an empty template or previous report
. Select the sorting criteria

. Select the output location

. Review the results

abhwNBE

To access the plug-in, select Automated Excel from the Tools menu.

Sample Templates

Sample templates are supplied which can be used to expand upon.

They are located in the following location;

32Bit: C:\Program Files\Actify\SpinFire\10.0\kernel\plugins\AutoExcelTemplates
64Bit: C:\Program Files (x86)\Actify\SpinFire\10.0\kernel\plugins\AutoExcelTemplates

Create a report

The first panel allows you to choose which type of report to create.



Page 1 of & Select tupe of operation

Generation Mode

@ Create

) Update
(70 Sty

() Comparizon

< Back [ Meut » ] ’ Cancel

® Create - All report types begin with this step.

® Update - Updates a single assembly report.

® Study - Adds a second version of the same assembly where names are the same to a report.

® Comparison - Adds a second version of the same assembly where names are different to a report.

Once the type of study type is selected, the location of the template is performed.

Fage 2 of 5: Select Template Excel file for Create Excel File with Data

Input Excel Template File

Usze az default

When the "Use as default" option is selected, the location will be remembered the next time the plug-in is used.

After the location is defined and the Create option was selected, the options panel is displayed to control how the output is added to the Excel
file. If Update, Study or Comparison is selected, this panel is skipped. What ever options were used to create the original Excel file will be used
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There are three properties to set.

® The "Sort On" option determines the order the components of an assembly are listed.
* Number - Each component is assigned a number and will follow the Actify Sort Order
® Part Name - The name as it appears in SpinFire
® V\olume - This is the volume of the part
® Surface Area - This is the surface area of the part

® The "Sort Order" determines whether the information is ascending (smallest to largest for numbers and A - Z for Part Name) or
descending (largest to smallest for numbers and Z-A for Part Name)

® The "Include Hidden Components" determines whether only parts currently displayed in SpinFire are included or whether all components
in the assembly tree are included regardless of their display state.

Select Next to proceed to defining where the output file will be stored.
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Output Excel Data File

Use az default

Again the "use as default" option is used to remember the output location for the next time the plug-in is used.

The final step allows you to review the results and make changes if necessary.

- Automated Excel: Crea =

Fage 5 of &: Finizh screen

General Settings

Generation Mode Create
Source File C:h\actibhTemplate Create, slax
Destination File C:h\Actib\Document Create. sz

Custom Properties
ActifyincludeHidden no
ActifylList Type partslist
ActifySortOrder ascending
ActifySort Type number

Results ] ’ Finizh

Selecting Results allows you to review the output file in Excel.



Y v . = reate - Valve.xls: Wicrosoft Excel

Home Insert Page Layout Formulas Data Review View Developer Add-Ins & 9 = X

L Page Break Preview - i nEéNewWindow R} i %
g = = o | W

I@ Custom Views E Arrange All
Marmal| Page Show  Zoom 100% Zoomto Save Switch Macras
Layout IS Full Screen - Selection E Freeze Panes = (O] ' 34 Waorkspace Windows ~ -

Waorkbook Views Zoom Window Macros

E5 - (" S |

u] E

Date:

E C
- @
ac t’ File Mame:  Co\UserstGue: t0ocumentsity, 300 Tibutterflyvalve jt
Organizer: :!

Attendees:

Design Review Meeting

MNumber Part Name Quantity  Yolume Surface Area
1 arm_SOLID_SOLIDS 13678, 0466 G036.510127
2 cover_SOLI0O_SOLIDS MS7. 7727 S066.524685
3 jam_nuwt_375_SOLIO_SOLIDS T14.369387  T40.0385129
4 zorew_10_s TS_SOLIO_SOLIDS 445 541545 467 3415665
5 sorew_S_ 4 375 _SOLID_SOLIOS 103.370526 176 1108034
6 zhaft_SOLID_SOLIDS 125186346 5240570443
T walve_body_SOLIO_SOLIDS 141732 684 3735021128
8 valve_SOLID_SOLIDS 234724701  4003.036333
3 woodnf_key SOLIO_SOLIOS 151.596564 130.8701385

PRI e I B QN —

-
will
M4 4 » M| <Create Data>Actify %2 i | [

Ready | °3 EOM % o—U+—#) .

If you are satisfied with the results, select Finish to complete process, otherwise select back and make any changes on the previous panels.

Related topics

Template Creation
Perform a Comparison

The Comparison option allows the user to compare two different versions of an assembly that use different naming conventions for the assembly



components. The Study option assumes that the names of the parts remains the same between version. The comparison option is meant to
handle comparing an in house version of the assembly, with one generated by a customer or another vendor.

To match up parts a manual operation is required to map the components. Comparison can be performed only on a file that a create or update
has been previously performed and the template [JPS1|#_msocom_1] is properly configured for a comparison.

Comparison of two different versions of an assembly involves two steps.
Step 1: Extract the BOM information of the first version of the assembly using the Create option and selecting a comparison template.

Step 2: To extract and compare the BOM information of the first and the second version of the assembly, select Tools > Automated Excel from
the menubar. This displays the Create screen.

To accomodate the differeing names an additional panel is presented before the report is generated that allows you to move the components
around.

The plug-in does attempt to match of like named components as the last component in the shows.

Automated Excel: Comparison

Page 4 of & Edit information
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To match up the other components you use the Map ID column. To match two like components enter the ID of like component from the left
column in the Map ID column.
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Once the IDs are entered, hit the Sort button to move the items around.

Automated Excel: Comparison
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If you have a component that does match up you can append a letter after the Map ID. For example to move a component between the fourth and
fifth component use a map ID of 4a.

Sample Template

For the Automated Excel plug-in to function, an Excel file must be created to act as a template.
There are three types of templates.

1. Single version of an assembly



2. Compare two versions of same assembly
3. Compare two versions of an assembly that use different naming for each

Her is an example of a single version template.

| Hame Insert Page Layout Farmulas Data Review View Add-Ins

=%

"_| % | Caiibri i - |
-|| oy ||| = | B Merge & Center = ||| § ~ %% » [|=%8 ;08| Conditional Format  Cell
H A’ | l | @ = l “ o] Formatting = as Table = Styles =

| :
Paste f |B I U .”_
lipboard ™ Font {F] Alignment ] Mumber {F] Styles

[ ] {1 | { L] =
S5 Wrap Text G I - = = o
=) rap e enera -é; | U

[

Insert Delete F

-

-

Cells
Ci7 (= S |
e P B | £ | D . E . E & H. !
L .
2 | ® Date:
B File Name: =filename#pll=
‘ {
3| Organizer:
3 | Attendees:
? {
3. {
3 Design Review Meeting
o
1|
._2_ Jumber Part Name Juantity S ice Area
3 <numbergpll: <partnamegplls <quantity#pll: <volume#pli> <surfacearea#pll>
4: <[*= <*]=>
5| <image#pll>
.2
z | |

When this template is filled in, it looks like the following:
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To Create a Template

You can create a template file to place the extracted BOM information of the assembly components of any CAD file. Set the tags in the cells
where you want the information to be placed. Once a create is done with the template, the template sheet is hidden.

A template is composed of several tags that tell the plug-in where to place data. The tags fall into two categories, single instance and table.
The single instance tags are the following:

® <filename#pll> - this will record the path and file name of the currently loaded assembly for create and update.
® <filename#pl2> - this will record the path and file name of the currently loaded assembly for study and comparison



® <image#pll> - this will paste the image of the 3D workspace for a create and update.
The table tags are the following:

<number#pl1> - This is the number that is also used in the Parts list and Auto Note plug-ins.
<partname#pl1> - name of the part in the assembly when a create or update are performed.
<quantity#pl1> - the quantity of a part in the first assembly when a create or update is performed.
<volume#pl1> - the volume of a part in the first assembly when a create or update is performed.
<surfacearea#pll> - the surface area of a part in the first assembly when a create or update is performed.
<partname#pl2> - name of the part in the assembly when a comparison is performed.

<quantity#pl2> - the quantity of the second assembly when a study or comparison is performed.
<volume#pl2> - the volume of the second assembly when a study or comparison is performed.
<surfacearea#pl2> - the surface area of the second assembly when a study or comparison is performed
<[*> - is used to locate the lower left corner of the table (placed directly below the first cell in the table)
<*]> - is used to locate the lower right corner of the table (placed directly below the last cell in the table)

When a Create is performed the following custom properties are created to store the sort information.

® ActifySortType
® ActifySortOrder
® ActifylncludeHidden

Do not modify the values for these properties.
To create a Template in Excel

1. Open an Excel file.

2. Name a sheet “<Template>Actify”, to define it as a template sheet. There can be other sheets. The plug-in will ignore these.
3. When the template is filled in by the plug-in, the template sheet is hidden.

4. A new sheet is created named Actify.

There are three types of templates

1. Single version of an assembly
2. Compare two versions of same assembly
3. Compare two versions of an assembly that use different naming for each

Example of Create / Update template:

Date:

actify  —

Organizer:
Attendees:

Design Review Meeting

<number#pll: <partnametpll= <guantity#pll: <volumespll> <surfacearea#pll=
<[*= <*]=

<imagegpll=

The following tags apply to a template that is only going to be used for Create and Update.

<filename#pl1>
<image#pl1>
<number#pl1>
<partname#pl1>
<quantity#pl1>
<volume#pl1>
<surfacearea#pl1>
<[>*

<]>*



Example of Study template:
The following tags apply to a template that is going to be used for Create and Study.

<filename#pl1>
<filename#pl2>
<image#pl1>
<number#pl1>
<partname#pl1>
<quantity#pl1>
<volume#pl1>
<surfacearea#pll>
<quantity#pl2>
<volume#pl2>
<surfacearea#pl2>
<[>*

<]>*

*Example of Study template:

Date:

File Mame: <filename#pll=
<filename#pl2=

Organizer:

Attendees:

Design Review Meeting

<number#pll: <partname#pli= <guantity#pllz <volume#ipll> <surfacearea#pll> <quantity#pl <voclumespl2> <surfaceareapl2>
<[*= <*]=

<image#pll>

The following tags apply to a template that is only going to be used for Comparison.

<filename#pl1>
<filename#pl2>
<image#pl1>
<number#pl1>
<partname#pl1>
<quantity#pl1>
<volume#pl1>
<surfacearea#pl1>
<partname#pl2>
<quantity#pl2>
<volume#pl2>
<surfacearea#pl2>
<[>*

<]>*

The main tag difference with this set is the addition of the <partname#pl2> tag. This is used to accommodate differing names between the two
versions of the assembly.

Automatic Parts Labeling

The Automatic Parts Labeling plug-in automates creation of markup containing component name for all parts and subassemblies in the assembly.

The plug-in creates markup using the 3D Note markup. Once created it appears in the Markups tree and is no different from a 3D note created
manually. So the same edit and deletion capabilities apply to the markup created using the plug-in as markup created manually.

*Note:*The plug-in does not remember which parts / sub assemblies it has previously created markups for. If the assembly has 10 parts and the
Apply button is clicked twice, then the result will be 20 markups.

To access the plug-in, select Auto Note from the Tools menu.
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The Automatic Part ID Markup window opens.
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Click button and select.

® button to view the help document for Automatic Parts Labeling plug-in.
® icon to view the About dialog for the Automatic Parts Labeling plug-in.

The basic flow is the following:

® Select the method of creating Part Labels.
® Select the format - Name or Number.
® Click Apply to start the markup creation process.

Select Parts

The Select Parts has three options for applying markup to the assembly.



® All parts - applies markup to all the parts in the assembly. (The default is All parts).

® All Subassemblies — applies markup to all subassemblies in the assembly.

® Single Part(s)/Subassembly(ies) — This selection will bring up an assembly tree. User can select Part(s)/ Subassembly(ies) from the
assembly tree. Markups are created for the selected Part(s)/ Subassembly(ies).

Specify Content

The Specify Content supports two options.
® Name — This will create markup using the name of the component as entered in the tree. (The default is Name)
® Number — This will create markup using an integer value that will match the numbering generated using the Parts List plug-in.

Appearance

Font

The Font button sets the font used to generate the markup. Font can be used to differentiate new markup from existing markup.

The default font is defined in SpinFire Professionsl's OPTIONS > Settings > 3D Viewer > Label Font.

Color

The Color button sets the background color of the markup. Color can be used to differentiate new markup from existing markup.

The default color is defined in SpinFire Professional's OPTIONS > Settings > 3D Viewer > Label Font > Color.

Sample Text displays the Font and color selected by the user.

Once Reset to defaults button is selected, it resets the selected font and the color to the default Font and Color which is set in SpinFire

Professional.

Progress

The Apply button initiates the creation of the markup.

During creation of the markup, the progress bar indicates the total number of parts to be processed and number of components that have been
processed.

Note: For large assemblies, the actual creation of the markups may take a long time.

Stop

When the plug-in is processing, clicking Stop will terminate the processing of the assembly information.
The markup created for already processed components will not be deleted.

Cancel

Click Cancel button or the , in the upper right corner of the plug-in panel to leave the Automatic Parts ID plug-in.

Draft Angle Analysis

Overview
The Draft Angle Analysis plug-in allows the user to easily analyze a part for proper draft angle.
A Draft Angle describes the amount of taper for molded or cast parts perpendicular to the parting line.

To access the Draft Angle Analysis (DAA) plug-in, select Draft Angle Analysis from the Tools menu.

4 Rotor. 30 Actify SpinFire Professional

Fle Edi Tools Navigation Documents  Toolars  Help
i Y- bl G | B | @) @ st | B

*Note:*Draft Angle Analysis is applicable only for 3D documents. An active 3D workspace is required to initiate the Draft Angle Analysis plug-in. If
a 2D drawing or image document is active, the Draft Angle Analysis plug-in is disabled.

Draft Angle Analysis panel opens.
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Contains the icons for the following commands:

d 6 icon: Cancels the current operation in the DAA.

R

icon: Opens up help document for DAA plug-in and the About dialog.
To create a Draft Angle Analysis for any 3D file, the user needs to:

® Select Pull Direction
® Select the Draft Angle
® Select Parts/ Surfaces

Select Pull Direction

The Pull Direction is defined as the axis against which the angular values specified in the dialog box will be evaluated. By default the Reference
Frame selects the World Reference Frame and positive Z direction as the default.



—Select Pull Direction
Feference Frame Direction
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Define Pull Direction

® The user can also select the different direction on the world reference frame by simply using the Direction drop-down and choosing the
desired direction.

® |f another reference frame has been created, the user can also select any direction against that reference frame by using the Reference
Frame Pull drop-down and then making the appropriate Direction selection, if required.

® |f an appropriate coordinate system does not exist, the user can click Define Pull Direction button, select a surface and a new
coordinate system is created.Note: When the user clicks Define Pull Direction button, the dialog box changes to ‘Pick on a Surface’. To

Q

exit the pick mode without selecting a surface, select the icon.

Select Draft Angle

The three options are as follows.
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® *Delta:*The user can select the Draft Angle, Upper and Lower limits of tolerances.The user can select the desired draft angle to be used
for analysis. The default Draft Angle is 2.00 degrees. The draft angle can be changed (increased/ decreased) in increments of tenths of a
degree with the help of buttons, or by typing a value inside the text box.
Note: If a new value is selected for the Draft Angle, the scale below the parameter settings changes accordingly.

® Limit: Defines the Minimum Value and Maximum Value of draft angle extremes.Min value: This is the lower boundary of the analysis,
expressed in degrees of variation from the pull direction, and can be a positive number, negative number, or zero.
Max value: This is the upper boundary of the analysis, expressed in degrees of variation from the pull direction, and can be a positive
number, negative number, or zero.
Note: There is no “tolerance” in this specification as there is in the basic mode.
Gradient: Selection of Gradient specifies a range of deviation from the pull direction, and have the analysis report the results. This option
is useful where the effects of a compound surface or a set of surface transitions (such as seen in the blends of a boss with a side wall
and a floor of a pocket) need to be analyzed.

® Parting Line Visualization: Sets the analysis tolerance to zero. Any surface with non negative (zero or greater) draft will be green while
surfaces with negative draft will be red. The partying line is represented by the transition between red and green. Also if there is any red
surrounded by green, then there must be some tooling allowance made to accommodate it through the use of slides, lifters or core pins.
No geometry is created representing the parting line.Note: When Parting Line Visualization is selected, Gradient option will be grayed
out.

Preview Bar:
Preview Bar displays the colors depending upon the value selected in the draft angle, min value and the max value.

Note: To change the color scale double-click on the color component (for Delta and Limit settings, there are three color regions and for Parting
Line Visualization, there are two), this displays the dialog box. Choose the desired color and the scale will change accordingly.

Select Part

This option allows the user to select Parts or Surfaces.

Select Part supports three options:



® All Parts: All parts visible in the scene will be analyzed. The default is All Parts.
® Select Parts: The user can select a part or a set of parts for any single analysis. When this option is selected, the assembly tree is

displayed.
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a vertex point on the part in the active workspace.
® Pick the part by selecting on the appropriate node in the assembly tree.
® Select Surfaces: The user can select a surface or a set of surfaces for any single analysis.
Entity Count: The test box displays the total number of entities selected (parts/ surfaces).

Views

Wigws

Create Wiew B eztore Wiew

® Click Create View to save the view for further reference.This displays a pop-up.

E

Wigw M amne:

k. | Cancel |

. ® Enter the View Name.
® Click OK to save the view name.
® Click Restore View to restore the view without saving the result.

* Analyze/ Apply : This button will kick start the analysis based on the user selected “Draft Angle”, “Select Part” options on the selected
individual Part(s) or Surface(s). Apply button would initiate the analysis which will change surface colors of the selected parts or surfaces

to communicate the Draft Angle Analysis results.



® Reset: It would clear any surface or part selections made by the user and would reset the “Entity Count” to zero. The surface analysis
colors are reset.

® Cancel: It will close the DAA interface and bring the focus back to SpinFire Pro Window. The current view orientation will not change.
The colors will be reset, unless the user had saved the view.

Exploded Assembly

The exploded assembly plug-in quickly helps to create exploded assembly views.
The plug-in allows you to quickly move components using different transformation methods applied to the components.
There are three different transformation types:

® linear - all components move in one direction
® radial - all components move out from a central axis
® spherical - all components move out from a central point.

@ Handy Hint
The easiest way to understand the transformation types is to try them.
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Explode Direction

Minimum Distance

The minimum distance plug-in calculates the minimum distance between two or more parts.
To access the plug-in, select Tools > Compute Minimum Distance.

This displays the Minimum Distance panel.
Minimum Distance

Q

Compare Set #1

@ Partz () Surfaces Rermove

Compare Set #2

@ Partz () Surfaces Select Remmove

Click IEI : This opens the Help File and About dialog for Minimum Distance plug-in.

To select parts or surfaces

® |n Compare Set # 1 Group box select either Parts or Surfaces radio button.

® Click the Select button.

® Select any part or surface from the Workspace or Assembly Tree.This displays the selected part or surface name in the Compare Set # 1
text box.

Note: You can select any number of parts or surfaces from the Workspace or Assembly Tree.

Click Stop Selection to stop the selection.

In Compare Set # 2 Group box select either Parts or Surfaces radio button.

Click the Select button.

Select any part or surface from the Workspace or Assembly Tree.This displays the selected part or surface name in the Compare Set # 2
text box.

Note: You can select any number of parts or surfaces from the Workspace or Assembly Tree.

® Click Stop Selection to stop the selection.

® Click Create displays the minimum distance between the selected parts and surfaces in the viewport as a markup.

To remove the selected part or surface

® Select the part or surface which you would like to remove from the Compare Set group box.This highlights the Remove button.
® Click Remove.This deletes the selected part/surface from the Compare Set group box.



Note
*You can pick multiple parts or surfaces by using Ctrl+Click and +Click and select any number of parts/ surfaces.

Note

«To stop the selection click e
Minimum Thickness

The minimum thickness plug-in finds the location on the part with the minimum wall thickness.

UPDATE: Version 1611.3 and Higher
The 1611.3 version fixes the erroneous results experienced in the German and French languages.

@ Partz () Surfaces

Parameters

draft angle

modeling tolerance

Cancel

To use the plug-in follow these steps:

1. Hit the Select button to begin the selection process (the button changes to Stop selection)
® |f Parts is selected, then the picking is at the part level.
® |f Surfaces is selected, then the picking is at the surface level. In this mode the calculation is done between the surfaces
selected and all surfaces (including the selected ones), so there is no need to select both sides of where you think the minimum
thickness is.
2. Hit the Stop selection button
3. Hit the Compute button
4. A markup with the measurement will be created on the part

Parameters

The draft angle and modeling tolerance help define what qualifies as a minimum thickness measurement.

Draft angle - This parameter compensates for parts where opposite faces are not parallel. If set to 0.0, then the two surfaces at the point of
measurement must be parallel. So if you are doing cast or plastic type injected parts, then a non zero value would be better. For example if the
part was designed with a draft angle of 4 or 5 degrees, then setting this to 5 or 6 degrees would be appropriate.



Modeling tolerance - Many parts will have small modeling error. For example often times small parts of a fillet will have poor tessellation and the
thickness measurement will be based on this and not the true minimum thickness area. If you do a calculation and you definitely know it is not
correct, then increasing this value and performing the measurement again will often correct the problem. Some trial and error might be required
until you get the expected results.

Be Careful
{D If the measurement finds the minimum thickness where you don't expect it, try increasing the modeling tolerance.

Model Compare

The Model Compare plug-in takes two similar parts and displays what is the same and different through the use of coloring the parts.

ST |

Current Document; Robot. CATFProduct 3D / Robot
Compare Set #1
Add ..
Compare Set #2
Add .. I

Material Options

B

| Finish || Clase |

[hwvert Campare

1. To start the plug-in go to Edit + Compare Models
. Select Add for the Compare Set #1
. Select the first part to compare
® You can select as many parts as needed
® Asyou select the parts, the geometry will be hidden to make further selections easier
. Select Stop to complete part selection
. Select Add for the Compare Set #2
. Select Stop to complete part selection
. Select Compare Sets
® The parts are colored according to the color legend

[CVI\N]

~N o oA

Material Options

The Display Removed Material is only available to select when selecting the second

Part List Generator

The Part List Generator plug-in allows the user to quickly create parts list for assemblies.
To view the Parts List, select File > Export > Parts List

This displays the Parts List panel for the current .3D file.
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Note: A parts list is generated only for 3D documents. An active 3D workspace is required to initiate the Parts List plugin. If a 2D drawing or
image document is active, the Part List Generator plug-in is disabled.

This displays the parts list in the view point on the right pane and Assembly Tree on the left pane of the WorkSpace component.
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®

Tool Bar

Running across the top of the application window is the tool bar.

SRR =R

® File icon: Allows the parts list to be printed, to view a print preview, to save the content to a tab delimited file or close the plug-in. These
options are also available at the bottom of the panel.
® Book icon: Displays the SpinFire Reader.

Parts List Preview Section

Displays the preview of Flat Single-Level view of all the parts or Multi-Level view of the subassemblies/subparts.

* Number: Displays the serial number of the parts available in the file.
* Name: Displays the name of the part/ assembly
® Quantity: Displays the quantity.



Specify Content

Specify Content supports two options:

Flat Single-Level: Displays the total count of parts and quantities at the selected level of Assembly, sub-Assembly or multiple
sub-assemblies. For ex: If any part is repeated more than once in the file, then the parts list displays the total count in the Assembly Tree.
(By default the application selects Flat Single-Level)

Multi-Level: Displays the detailed list like parts, quantities and hierarchical relationship that may exist within selected Assembly,
sub-Assembly or multiple sub-assemblies. The parts list clearly shows relationship between Assembly, its sub-assemblies and the
constituent components with proper indentation. For ex., if a part is available in two subassemblies then the parts list displays twice with a
count 1 for each instance.

When Do Not Include Hidden Parts is selected, the parts list is created only for the checked Assemblies/ Subassemblies/ Parts in the Assembly
Tree in the Parts List panel.

Assembly

Shows or hides the Assembly Tree on the left side of the pane. The assembly tree is hidden by default.

Assembly Tree allows the user to define which Assembly, Subassembly and parts are included in the parts list.

CNTL allows the selection and deselection of individual components in the tree.

SHIFT allows the user to select a range of components.

When selected [

When selected

<< Azzembly ]
, displays the Assembly Tree structure on the left pane.

[ »» Aszembly ]

, the Assembly Tree structure is hidden.

Once the selection is complete, select

[ Erirt... ” Presview II Save H Cloze ]

Print: Prints the Parts List for the current file.

Preview: Can view the print preview of the Parts List for the current file before printing.
Save: Saves the Parts List for the current file in the selected path.

Close: Closes the Parts List panel.

PDF Export

0)

Export 3D PDF
The PDF Export plug-in only exists with 10.2.x versions. The PDF Export plug-in was rolled into the main feature set as of SpinFire
10.3.

See Export 3D PDF.

The Actify PDF Export plug-in allows one to export 3D models to a .pdf file.

In Acrobat you can:

Rotate, zoom, and pan the 3D model

Change the background color

Change the lighting

View the assembly tree

Change to standard views (front, back, top, bottom, right, left)
Select and highlight parts
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Exporting to PDF

If the plug-in is installed with SpinFire, simply:

1. Load your 3D model.
2. Go to the File > Export > PDF... menu item.

4. Enter in header and footer text.

Eile | Edit Tools Mavigation [Documents Help

¥ Open Workspace... Ctrl+0
Close
H Save Ctrl+5
Save As..,
Save a Copy...
Import...
| Export » JPEG...
Lﬂl Email EMP...
‘e Print r EMF S
u}, Print Preview... EartT
Exit Alt+F4 PDF...

g ¢ Guamizione Lat STL...
3. Select the location and enter a name for the pdf file.
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@ Special Note
The Actify PDF Export plug-in is available in SpinFire 10.2 or greater

Extended PDF Features
In Extended mode, Acrobat allows you to use measurement and cross-section tools. To use these features,

1. Load the exported pdf file into Adobe Acrobat Pro.
2. Enable the extended pdf features.
3. Save the file.

STL Export

The STL Export plug-in creates an STL version of the loaded geometry. This only applies to 3D data.
Refer to the link http://en.wikipedia.org/wiki/STL_%28file_format%?29 for specifics on the STL file format.

The only information included in the file is the triangle information. All color, surface, part, assembly and markup information is lost.

Third Party Plug-ins

With SpinFire Professional's open architecture, Actify is able to provide plug-ins that expand the functionality of
SpinFire Professional, allowing added abilities to the already robust product. Because of the open architecture, third
party developers can create these added components. Below are the list of Actify approved third party plug-ins.

* Weight Calculator Plug-in
Porting SpinFire 9.0 Plug-ins to SpinFire 10.x

Requirements

® Actify Sample Plug-in for SpinFire 10 - ActifySF10_Sample_plug
® Microsoft Visual Studio 2010 or later
® Spinfire 10 installed on your computer to run the plug-in

Note: We currently do not support side-by-side running of plug-ins for older versions of SpinFire. This means that if you have version 9 and
version 10 of SpinFire running in your computer. You can also use your plug-in from version 10 once you switch over. Your plug-in will stop
working for SpinFire 9.

Actify, Inc.

Steps in Porting your Plug-in

1. Make sure you have Actify.SpinfirePro.dll and Actify.Xview3D.dll. These files are provided with the ActifySF10_Sample_plugin pack

age.


http://en.wikipedia.org/wiki/STL_%28file_format%29
http://help.actify.com/download/attachments/4751606/ActifySF10_Sample_plug.zip?version=1&modificationDate=1327334722320&api=v2
http://help.actify.com/download/attachments/4751606/ActifySF10_Sample_plug.zip?version=1&modificationDate=1327334722320&api=v2

2. Open your plug-in csproj in a text editor. The interop DLLs in SpinFire 9 have been renamed in SpinFire 10. You need to do a global
search and replace of interop DLLs referenced by your plug-in. This means replacing it in the text file:
a. Actify.Spinfire.Interop.dll to Actify.SpinfirePro.dll
b. Actify.Xview3D.Interop.dll to *Actify.XView3D.dl|

Here is an example code snippet in the csproj text file after doing the replacement:

<l ten& oup> <Reference Include="Actify. SpinFirePro">
<Hi nt Pat h>.\ Actify. SpinfirePro.dl|</H ntPath>
<Enbedl| nt er opTypes>Tr ue</ Enbedl nt er opTypes>

</ Ref er ence>

<Reference | nclude="Actify.XView3D"'>
<Hi nt Pat h>.\ Acti fy. XVi ew3D. dl | </ Hi nt Pat h>
<Enbedl nt er opTypes>Tr ue</ Enbedl nt er opTypes>

</ Ref er ence>

3. <OPTIONAL> You can double check that your plug-in project has been modified correctly to use Spinfire 10 interop DLLs by opening the
csproj in Microsoft Visual Studio 2010 and checking the references in Solution Explorer. See figure 1 for an example screenshot.

Solution Explorer - ActifySamplePlugin
| MERF e
A Solution "ActifySamplePlugin’ (1 project)
4 I ActifySamplePlugin

4 | Properties
4] Assemblyinfo.cs

4 | Rels
< Actify.SpinFirePro

-3 Actify XView3D

-2 Microsoft.CSharp

3 Systern

3 Systern.Core

« Systern.Data

« Systern.Data.DataSetBxtensions
«3 Systern.Windows.Forms

3 System.Xml

+J Systern Xml.Ling

] Connect.cs

. Soluti.., |58 W W Tearmn.. EB Class.. E Resouw...

Properties - Q %
Figure 1 - Solution Explorer
4. Modify all your C# code (*.cs) that references Actify.Spinfire.interop to Actify.SpinFirePro. The same needs to be done for XView3D
references. See figure 2 for example modifications in the Actify sample plug-in C# code.




using System.Runtime.InteropServices;
using System.Windows.Forms;

Elnamespace ActifySamplePlugin

{
#Public member functions - 1DTExensib [Comvisible(true)]
IDTExtensibility2 [GuidAttribute("67F@1AB0-225F-401E-9319-4BEFAAAAF427"), Progld(“ActifySamplePlugin.Connect”™)]
W OnConnection = = public class Connect : Extensibility.IDTExtensibility2
W OnDisconnection : { ) "
"% OnStartupComplete - = #region Attributes
= OnAddnfUpduze private Actify.SpinFirePro.Application m_SFApp;
=y 2 private long buttonlID;
OnBeginShutdown private object addInInstance;
e #endregion Attributes
. HookEvents L] 5
¥ CreateMenu L]
. spinfireApp_CommandBarExecute = #region Public member functions - IDTExensibility2 interface implementation
= public veid OnConnection(object application, Extensibility.ext Connecttode connectMode, object addInIns
m_SFApp = application as Actify.SpinFirePro.Application;
addInInstance = addInInst;
¥
=] public void OnDisconnection(Extensibility.ext Disconnectode disconnectMode, ref System.Array custom)
m_SF = null;
Part of the CodeSMART project _adl:?:stana = null;
Global Solution History W% ~ 4 m

Figure 2 - C# source code modifications
5. After these changes, recompile/build your plugin in Visual Studio 2010 and successfully generate a plug-in DLL. For the Actify sample
plug-in, a DLL file in bin\release\ActifySamplePlugin.dll is generated.

Registering your Plug-in

1. In order for your plug-in to interoperate with SpinFire, you need to add some entries to the Windows registry.

2. You need Microsoft's regasm tool to register your SpinFire 10 plug-in. The tool is included in the tool subdirectory in
ActifySF10_Sample_plugin package.

3. Copy regasm.exe and regasm.exe.config into your SpinFire plug-ins folder. Your SpinFire plug-ins folder is usually in C:\Program Files
(x86)\Actify\SpinFire\10.0\kernel\plugins.
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Figure 3 - The Spinfire Plug-in folder
4. Copy your plug-in DLL into the spinfire plug-ins folder too. For example, in the Actify sample plug-in, you need to copy the ActifySample
Plugin.dll from the bin\release folder to C:\Program Files (x86)\Actify\SpinFire\10.0\kernel\plugins (or wherever SpinFire is installed).
5. Open a text command prompt window by executing cmd.exe from Windows.

Note
For Vista, and Windows 7, you need to run cmd.exe as an administrator. A plug-in will not register without administrator
privileges.

6. From the command prompt, change directories to the Actify SpinFire plug-ins folder.

Bl Administrator: taskeng.exe

C:N>cd "C:\Program Files (x86)\NActify\SpinFire\10.8\kernel\plugins"
C:\Program Files (x86)\Actify\SpinFire\18.0\kernel\plugins>»

Figure 4 - Command prompt SpinFire plug-ins folder
7. From the command prompt, run:

regasm <your_plugin_name>.dll /codebase

® This step will register your plug-in and add necessary fields to the Windows registry for SpinFire to communicate with your



plug-in.

Note

For Vista, and Windows 7, you need to run cmd.exe as an administrator. A plug-in will not register without
administrator privileges.

W Administrato keng.exe = B P4

C:\Program Files (x86)\Actify\SpinFire\1@.0\kernel\plugins>regasm ActifySamplePl
ugin.d?l /codebase

T TS ATV SOInTIre oS TOner —

Figure 5 - Command prompt run regasm
8. <Optional>: You can check what regasm adds to the registry by executing

regasm <your_plugin_name>.dll /codebase /regfile:entry.reg

® This step produces an entry.reg text file in your plug-ins directory which contains the fields to be added to the Windows registry.
The entry.reg file will also list down your plugin’s GUID# which is part of the next step. The GUID# is a 32-character hexadecimal
string used by Windows to uniquely identify your plug-in. This is a 128-bit signature of your plug-in.
. Get your plug-in CLSID. This GUID code is located in your plugin’s Connect.cs, with the GuidAttribute field. For example, for Actify’s
sample plug-in code, the GUID# value is: 67F01A80-225F-401E-9319-4BEFAAAAF427

-
oo ActifySamplePlusgin - Microsoft Visual Studio
e e —
File Edit

View Refactor Project Bu-ld_Debn.;g '_I'earh Data Tools Test V510x Wiﬁdﬂw.l"_ﬂp

A Lt ™ i N R, - = Lle L] b |Release -| | Any CPU =| | | # | ActifyProjects = Bt e el I

PR AR iEEE

™ ] Connect.cs . Microsoft.Common.targets
§ 1% ActifySamplePlugin.Connect -! 3
|
E Connect
g -lusing System;
& using System.Runtime.InteropServices;
_-: using System.Windows.Forms;
g_ Actifys lePlugi
g IDTExtensibility2 namespace ActifySamplePlugin ==
- ¥ OnConnection { e i
"% OnDisconnection [ (e ~ ) ]
“ OnStartupComplete 1/ -a'\%{"-}. Y1AB@-225F -401E-9319-4BEFAARAFA2T"), 1Id(“ActifySamplePlugin.Connect™)]
7 OnAddinsLipdate Eubl:c class hh’"""'-';--.:, xtensibility. :I;__.‘Jggr
1 L S— e ——————
¥ OnBegindhutdown = #region Attributes
private Actify.SpinFirePro.s ion m_SFApp; |
i private long buttonlID;
cno u1e * 2 private cbject addInInstance;
reateMenu {

#endregicn Attributes
spinfireApp_CommandBarExecute

#region Public member functions - IDTExensibility2 interface implementation
public void OnConnection{object application, Extensibility.ext tMode connectMode, ol
{
m_5FApp = epplication as Actify.SpinFirePro.
addInInstance = addInInst;

L - public void OnDisconnection(Extensibility.ext t disconnectMode, ref System.
Giobal Solution History 100% =~ 4 Ll

Figure 6

10. <OPTIONAL> The previous step creates necessary Windows registry entries for your plug-in. You can double-check these entries by

running regedit.exe and checking for appropriate fields in your Windows registry. The location of the registry entries is different for 32-bit
systems and 64-bit systems. Figure 8 shows a screenshot for 64-bit systems.

a. 32-bit: HKEY_CLASSES_ROOT\CLSID
b. 64-bit: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\CLASSES\CLSID
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Figure 7 - Registry entries on a 64-bit machine for the Actify sample plug-in
11. Open spinfire.plugins file in a text editor. This file is located in your main spinfire kernel folder. For typical installs, this is in: “C:\Program
Files (x86)\Actify\SpinFire\10.0\kernel “. You need to append several lines near the end of the XML file. For example, in the Actify sample
plug-in, the following lines are included.

<ap: addi n
xm ns:ap="[http://ww. actify. com namespaces/ addi ns"| http://ww. acti fy. conf nanespa
ces/addins] id="-1"
| oadBehavi or="3" bui |l d="1550. 4" cl si d="{67F01A80- 225F- 401E- 9319- 4BEFAAAAF427} "
i nst Parans="/s /instance={0}"/V /qgnl NSTALLDI R=\"{1}\ """ >
<ap: nane>Act i f ySanpl ePl ugi n. Connect </ ap: nane>
<ap: description>Actify Sanple Pl ugi n</ap: description>
<ap: fri endl yName>Sanpl e</ ap: fri endl yNanme>
<ap: cl si d>{ 67F01A80- 225F- 401E- 9319- 4BEFAAAAF427} </ ap: cl si d>

<ap: conpany>Actify | nc. </ ap: conpany>

</ ap: addi n>

Note

For your plugin, you'll need to fill out:
the name
description

friendly name
company fields with appropriate values.
Be careful to use your plugin’s correct CLSID.

ﬁ&w..,h_,,.,wmﬁ._ — SPINFIREPLUGINS ftext file —

TN A= Rt tp 1 Fuuw, Aoty . COR/RARRITSAN SA20NN" 10="-1% LoadBelaviOr="3" Bulld=el30.4% olaide® [§TFOIAR0-IISF-400E-B010-SBETARAATAITI® instParams="/s /Lnrtances(D} Lquats/V Jgu INSTALLEIRS\Lgeot: (11\Lquaey
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<ap1 friendl;
<apiclaidrid

ot BTIS s i TH Lail Cali] Seli8 [ [ 3

P —— rpm—

Figure 8 - Example appended lines to spinfire.plugins text file

Weight Calculator

The Weight Calculator plug-in is created by Achelon in Italy.

The Weight Calculator plug-in allows one to compute the solid weight using material properties.


http://www.achelon.it/

The plug-in provides the ability to approximate the weight of a model based on the type of material chosen. The material is selected from an
extensive list of materials commonly used in the manufacturing industry.

Materials can be added, deleted or modified from the list supplied with the software. This allows the User to customize the material list to their
specific needs.

In this way various material types can be explored to see the impact on the weight of the part or assembly. This information is also extremely
useful for buyers and people generating quotes.

The result of this operation can be shown on the screen and eventually included in the .3d file as a markup
The plug-in allows the following information:

Add/modify/remove materials and weight specifications
Set weight visualization

Set markup information

Set the precision

Set the type of parts to calculate weight

Choose the method of parts selection

The process of calculating weight.

. Update the materials list

Update general settings

. Select the material used

. Calculate the weight

. Position the new markup annotation

O wN P

UPDATE: Version 1611.3 and Higher
The 1611.3 version now allows the user to choose the type of units to output from the calculation. The user can choose:

® kilograms,
® grams,

® pounds,
® orounces

To calculate weight, click the Calculate Weight! button from the main tool bar or Icon Bar.

File Edit Tools Mavigation Documents Help Calculate Weight

Ui- 3 W 3 L 8]

ImageData - g ‘ @ Stop XPlus! | @ Current Material : Steel 88 Calculate Weight !

To change the settings, click the General Settings button from the main tool bar.
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To change the Material, click the Current Material button from the main tool bar.
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Any material weight values containing decimal places must use a period ('.") character for the decimal place for all languages and operating
systems. The Weight Calculator plug-in will remove commas entered.

The Material Table for the local users is located in the follwoing folder;
C:\ProgramData\Actify Inc\SpinFire102\11.0.1611.4\GestPesi.ini

Note: The 11.0.1535.3 folder will change according to the Build of SpinFire 10.0 installed.
This Materal list can be modified manually by opening the above file in Notepad.

It can also be copied to this folder on other PC's so multiple users have access to the same Table.

XSection Plus

The XSection Plus plug-in calculates the area of a cross section.

The purpose of the Surface Area of Cross Section plug-in is to augment SpinFire Professional cross section capabilities by providing the
capability to compute the surface area of a sectioned model. The plug-in will be implemented as a separate dialog that can be invoked from
SpinFire Professional.A sectioned model may include a single part or multiple parts. The parts may be separate or embedded. The initial plug-in
will provide the basic functionality to compute the surface area with limited capabilities. Only visible parts will be used by the plug-in.
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This enhancement should prove to be very valuable for many users. Anyone needing to calculate stamping pressures for example will find this
feature of massive benefit.

Installing SpinFire 10

Installing SpinFire
Installation video can be found here: Installation Video

SpinFire 10.0 can be installed with either Full install file or the Web Install file.

The Full install file works well for customers that are installing on multiple PCs across the network as they will only have to download it once.

User Privileges

The user installing SpinFire must have administrator privileges in order for the installation to complete.

Prerequisites

Microsoft .NET Framework 4 redistributable package (Standalone Installer) is required for the installation to take place

It will be listed in the "Programs" list as follows;

€5 Actify STL Export for SpinFire 10.0 Actify, Inc. 2011/09/03 102 KB 11.0.1536.6
__ o Actify XSection Plus for SpinFire 10.0 Actify. Inc 2011/09/03 131 KB 11.0.15366
2 Microsoft .NET Framework 4 Client Profile Microsoft Corporation 2011/05/13 38.8MB 4.0.3031%
% Microsoft .NET Framework 4 Extended Microsoft Corporation 2011,/05/13 51.9 MB 4.0.3031%9
" “Microsaft Visual C++ 2010 x64 Redistributable - 10.0.... Microsoft Corporation 2011/09/03 13.6 MB  10.0.30319

If it is not installed it can be downloaded from the following location;
http://lwww.microsoft.com/download/en/details.aspx?id=17718

** Windows Server 2008 R2 - Additional installation requirement


http://www.microsoft.com/download/en/details.aspx?id=17718

The Microsoft ASP.NET MVC 2 application needs to be installed in addition to the .Net 4 Extended described above.

The AspNetMVC2_VS2008.exe file can be downloaded from the following location;
http://lwww.microsoft.com/download/en/details.aspx?displaylang=en&id=22079

** Windows XP 64Bit - Additional installation requirement - Please Note that SpinFire 10.8.3 is not supported for Windows XP.
Make sure the following components are installed prior to the SPinFire installation:

® 64-bit Windows Imaging Component (WIC)
® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
® Microsoft ASP.NET MVC 2
® http://www.microsoft.com/download/en/details.aspx?id=22079
® MSXML 6.0
® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=993c0bcf-3bcf-4009-be21-27e85e1857b1
® NET2
® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en
* NET4
® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
Visual C++ 2010
® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

Installation Options
The installation allows you to select the necessary components you need:

® Typical (installs ALL but DAA Plug-in and most Common Importers)
® Complete (installs all Importers and Plug-ins)
® Custom (add or remove from the Importer and Plug-in lists)

Note: The Weight Calculation Plug-in can only be installed from the SpinFire “Plug-ins” page.

Installation Steps

The steps below will explain the installation steps for the (3) options, Typical, Complete, and Custom.
If either SpinFire 8.3, 8.4, or 9.0 are not already installed, please have either your Seat ID or License file available.

® Double-click the installation file to start the SpinFire Installation Wizard
® Select the proper Language
® Wait while the files are extracted
1. This could take several minutes
® At Welcome Screen select next
® Accept terms and conditions
® At Seat IDScreen, do one of the following;
1. Key in current Seat ID
® This will perform an Internet Activation
2. Browse for, and select, the current license file
3. Skip and set up licensing after the installation
® NOTE: SpinFire will start in the "Reader" mode untill a valid license is supplied

NOTE: If you already have either SpinFire 8.3, 8.4, or 9.0 running, the license file will automatically be copied to the 10.0 folder, and this screen
would be bypassed.

Select Next

Browse to Installation folder if not using the default
Select Next

Select Type of Installation

1. Typical

® |[nstalls following Importers

® AutoCAD, PDF, CATIA V4, CATIA V5, HPGL, IGES/VDA, NX, ProE, SolidWorks, STEP
® |[nstalls All Available Plug-ins

® Except for DAA and “Weight Calculation” Plug-ins

2. Complete

® |nstalls All Available Importers
® |Installs All Available Plug-ins
® Except “Weight Calculation” Plug-in


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=22079
http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

3. Custom

® Select which Importers to install

® Select from the Displayed List
® Select which Plug-ins to install

® Select from the Displayed List

® Select Next
Select Install
The last screen to see is the “Finish” screen, where you select “Finish”

Changing or Uninstalling SpinFire

SpinFire 10.0 now lists all the Importers, Plug-in's, and SpinFire itself on the Add and Remove Programs list.

f-:}ﬁu:tif)' AuteCad for SpinFire 10,0 Actify, Inc.
ff'fﬁ.ctify Auternated Excel for SpinFire 10,0 Actify, Inc.
=3 Actify Autormatic Pars Labeling fior SpinFire 100 hetify, Ine.
(. Actify CatiaV4 for SpinFire 10.0 Actify, Inc.
f_-:}m:tif'_.- CatiaV3 for SpinFire 10,0 Actify, Ing,
{2 Actify CGM for SpinFire 10,0 Actify, Inc.
{23 Actify Draft Angle Analysis for SpinFire 100 hetify, Ine.
(. Actify Exploded Assembly for SpinFre 10.0 Actify, Inc.
f_-:}ﬁttif:..l HPGL for SpimFire 10.0 Actify, Inc.
ff'rﬁ.n:tif'_.' [deas for SpinFire 10,0 Actify, Inc,
{2} Actify Iges for SpinFire 10.0 hctify, Ine.
ﬁ:—.{l.l:ti[:" [mventar for SpinFire 1000 Actify, Inc.
f_-:}ﬁ.ttif'_.' T for SpinfFire 10,0 Actify, Inc.
F‘::'Aftif}' Medel Compare 2 for SpinFire 10,0 Actify, Inc,
{2} Actify MY fer SpinFire 10,0 Actify, Ine.
ﬁ;- .Cl.l:llif:,- Parasalid for SpinFire 100 .l'-'cctrFy. Ine.
(-f}ﬂttif}' Parts List Generator for SpinFire 10.0 Actify, Inc,
ff;ﬁ.u:tif:,.l POF Importer for SpinFire 10.0 Actify, Inc.
{2} Actify PRC for SpinFire 100 Actify, Ine.
G;- .I:l.l:l:if:,- ProE for SpinFire 1000 .'-'lu:trl":.-'I Inc.
87 Actify Prof Importer Actify Inc.
ff:;'—'l.u:tif'_.l Shortest Distance for SpinFire 10.0 Actify, Inc.
=3 Actify SolidEdge for SpinFire 10,0 hctify, Ine.
Actify SolidWarks for Spinfire 10,0 Actify, Inc.
W] Actify SpinFire 8.4.1 Actify Inc.
&l &, ctify SpinFire 2.0 Actify, Inc.
& Actify SpinFire 10,0 Actify, Inc.
E_;-A:I:if:,' Step for Spinfire 100 Actify, Inc.
f-:;m_—:if}- 3TL Export for SpinFire 10,0 Actify, Inc.
ff'fﬁ.ctif:,.l STL for SpinFire 10,0 Actify, Inc.
{2 Actify Weight Calculater for SpinFire 100 hetify, Ine.
(: Actify X5ection Plus for SpinFire 10.0 Actify, Inc.

SpinFire 10.0 can be changed, repaired, or un-installed as follows;

® Goto “Control Panel”
® For Windows XP select “Add or Remove Programs”
® For Windows 7 select “Programs and Features”
® You will now see a list of Actify components
® Actify <Importer Name> for SpinFire 10.0
® Actify <Plug-in Name> for SpinFire 10.0
® Actify SpinFire 10.0
® Note: You will also see previous versions of SpinFire if installed

Change, Repair, Uninstall

® To Change, Repair, or Uninstall an Importer or Plug-in;
® Select the component



Select Change

Select Next

Then select the operation you wish to perform
® Modify
® Repair
* Remove

® Selext Next

ﬁ Actify AutoCad for SpinFire 10.0 - InstallShield Wizard g

Program Maintenance

Modify, repair, or remove the program.

@ Modify

Change which program features are installed. This option displays the
Custom Selection dialog in which you can change the way features are
installed.

) Repair

Repair installation errors in the program. This option fixes missing or
corrupt files, shortcuts, and registry entries.

("I Remove

@ Remove Actify AutoCad for SpinFire 10.0 from your computer.
T

Installshield

[ < Back |[ Next = | [ Cancel ]

® To Change, Repair, or Uninstall SpinFire 10.0;
® Select the Actify SpinFire 10.0
® Select Change
® Select Next
® Then select the operation you wish to perform
* Modify
® Repair
® Remove
® Selext Next
® Note: This will uninstall all the SpinFire 10.0 components.

Actify SpinFire 100 - InstallShield Wizard =)
—— — y

%
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Command line options

Install SpinFire in silent mode using a response file
You can install SpinFire in silent mode and provide the information to the installation using various option parameters.

To install SpinFire in silent mode you must use the /s and /f1 paramters:

SpinFirelnstaller.exe /s /f1"C \ TEMP\ Spi nFirel0. 8. 3.iss"



The file "SpinFire10.8.3.iss" is the installation response file. Usually this file is created by running the installation in regular mode and by recording
the user actions during the installation process.

Alternatively, you can download the appropriate files from the links below:

® Download SpinFirel0.9.iss files
® |nstall
® Uninstall

® Download SpinFire10.8.3.iss files
® |Install
® Uninstall

® Download SpinFirel0.8.2.iss files
® |nstall
® Uninstall

® Download SpinFirel0.8.1.iss files
® [nstall
® Uninstall

® Download SpinFirel0.8 .iss files
® |nstall
® Uninstall

® Download SpinFirel0.7 .iss files
® [nstall
® Uninstall

® Download SpinFirel0.6 .iss files
® |nstall
® Uninstall

® Download SpinFirel0.5 .iss files
® [nstall
® Uninstall

® Download SpinFirel0.4 .iss files
® |nstall
® Uninstall

See examples below using these .iss files.

IMPORTANT
(D The /f1 parameter is required otherwise Importers and Plugins will not have uninstall options when listed in the Add/Remove Programs.
Also: There must be no spaces between the /v switch and the quote-parameters that follow.

Other optional parameters

Parameter

Description

/L

Language

It specifies the language to be used for the silent install. If no language is specified the system language is used if
available otherwise default to English.

Possible values:

1031 — German

1033 — English

1041 - Japanese

1028 - Traditional Chinese
2052 - Simplified Chinese
1040 - Italian

1036 - French

Example:

SpinFirelnstaller.exe /s /L"1031" /f1"C \ TEMP\ Spi nFi rel0. 2. i ss"

v

Installation Parameters

It allows to specify a string with series of parameters such as target directory, importers and plugins configurations.
The syntax is as follow:


http://help.actify.com/download/attachments/4030994/1931.2.SpinFire10.9.iss?version=1&modificationDate=1438360414547&api=v2
http://help.actify.com/download/attachments/4030994/1931.2.RemoveSpinFire10.9.iss?version=1&modificationDate=1438360423037&api=v2
http://help.actify.com/download/attachments/4030994/RC.1912.5.SpinFire10.8.iss?version=1&modificationDate=1428952800257&api=v2
http://help.actify.com/download/attachments/4030994/RC.1912.5.RemoveSpinFire10.8.iss?version=1&modificationDate=1428952809140&api=v2
http://help.actify.com/download/attachments/4030994/RC.1850.1.SpinFire10.8.iss?version=1&modificationDate=1419871827717&api=v2
http://help.actify.com/download/attachments/4030994/RC.1850.1.RemoveSpinFire10.8.iss?version=1&modificationDate=1419871831193&api=v2
http://help.actify.com/download/attachments/4030994/RC.1845.2.SpinFire10.8.iss?version=1&modificationDate=1419871732747&api=v2
http://help.actify.com/download/attachments/4030994/RC.1845.2.RemoveSpinFire10.8.iss?version=1&modificationDate=1419871737860&api=v2
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/SpinFire10.8.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/RemoveSpinFire10.8.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/SpinFire10.7.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/RemoveSpinFire10.7.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/SpinFire10.6.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/RemoveSpinFire10.6.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/SpinFire10.5.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/RemoveSpinFire10.5.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/SpinFire10.4.iss
http://dgaw5tjbqpbsi.cloudfront.net/software/WebDownloadLatest/RemoveSpinFire10.4.iss

SpinFirelnstaller.exe /s /L"1033" /f1"C. \ TEMP\ Spi nFirel0.0.iss"
/Vll "

Where the (...) can have the following values:
INSTALLDIR=\"target path\"

PLUGINS=\"plugins configuration\" (ALL|TYPICAL|NONE)
IMPORTERS=\"importers configuration\" (ALL|TYPICAL|NONE)
LICENSE=\"license file path\"

Be Careful

1
The use of \" for these sub-parameters is due to the fact these are passed already inside a quoted string.
The \ character is used to escape the quote and avoid premature string termination.

Examples

Install All Importers and All Plug-ins plus Weight Calculator Plug-in
NOTE: Add below Example contents into individual Batch (.bat) files

Install Weight Calculator Plug-in Download

REM I nstall SpinFire

REM Al'| | nporters

REM Al l Pl ug-ins

REM Change install |ocation accordingly

REM | NSTALLDI R=\"C:\ Program Fi | es (x86)\ Acti fy\ Spi nFire\10.0\"
SpinFirelnstaller.exe /s /L"1033" /f1"C \ TEMP\ Spi nFirel0.iss"

/v"LI CENSE=\"C:\ TEMP\ | i cense. al \" PLUG NS=ALL | MPORTERS=ALL | NSTALLDI R=\"C:\ Program
Fil es\ Actify\ SpinFire\10.0\""

Pause

REM | nstal | Wi ght Calculator Plug-in
I nst Wi ght Cal cul ator_1548 1. exe /s /instance=1 "/V /gn"

Install No Importers and No Plug-ins

REM I nstall SpinFire

REM Al'| | nporters

REM Al l Pl ug-ins

REM Change install |ocation accordingly

REM | NSTALLDI R=\"C:\ Program Fi | es (x86)\ Acti fy\ Spi nFire\10.0\"

SpinFirelnstaller.exe /s /L"1033" /f1"C \ TEMP\ Spi nFi rel0. 2. i ss"
/v"LICENSE=\"C:\ TEMP\ | i cense. al \" PLUG NS=NONE | MPORTERS=NONE | NSTALLDI R=\"C: \ Program
Fil es\ Actify\SpinFire\10.0\""

Install SpinFire in Japanese with All Importers

SpinFirelnstaller.exe /s /L"1041" /f1"C \ TEMP\ Spi nFi rel0. 2.i ss"
/v" LI CENSE=\ "H: \ Li censesReposi tory\Licence.al\" | MPORTERS=ALL | NSTALLDI R=\"C:\ NEW
DI RECTOR\ "


https://dgaw5tjbqpbsi.cloudfront.net/software/arm/release/InstWeightCalculator_1611_3.exe

32Bit — Plug-ins=Typical / Importers=None

SpinFirelnstaller.exe /s /L"1033" /f1"C.\TEMP\ Spi nFirel0.2_32Bit.iss"
/v"LI CENSE=\"C:\ TEMP\ | i cense. al \" PLUG NS=TYPI CAL | MPORTERS=NONE
I NSTALLDI R=\"C: \ Program Fi | es\ Acti fy\ Spi nFire\10.0\""

Install Weight Calculator Plug-in

I nst Wei ght Cal cul ator_1548 1.exe /s /instance=1 "/V /gn | NSTALLDI R=\"C:\ Program
Fil es\ Actify\SpinFire\10.0\kernel\""

64Bit-- Plug-ins=ALL / Importers=ALL

SpinFirelnstaller.exe /s /L"1033" /f1"C \TEMP\ Spi nFirel0.2_64Bit.iss"
/v"LICENSE=\"C. \TEMP\ | i cense. al \" PLUG NS=ALL | MPORTERS=ALL | NSTALLDI R=\"C:\ Program
Files (x86)\Actify\SpinFire\10.0\""

(D IMPORTANT
The order for the command line parameters is important. Follow the example and use /s /L /f1 and /v in this order.

Unnstall SpinFire in silent mode using a response file

To uninstall SpinFire via command line you need to specify silent mode and an installation response file.
The syntax is the following:

SpinFirelnstaller.exe /s /f1"C \ TEMP\ RenoveSpi nFi rel0. 2. i ss"

(D IMPORTANT
There should be no spaces between the /f1 parameter and the quotes ().

The RemoveSpinFire10.2.iss can be created by copying the following code.

RemoveSpinFirel0.0.iss

[ { ODD5F937- 1D1B- 4BEB- 9E50- 949D3DAF549E} - Dl gOr der |

Dl g0={ ODD5F937- 1D1B- 4BEB- 9E50- 949D3DAF549E} - SdWel conmeMai nt - 0
Count =3

Dl g1={ ODD5F937- 1D1B- 4BEB- 9E50- 949D3DAF549E} - MessageBox- 0
Dl g2={ ODD5F937- 1D1B- 4BEB- 9E50- 949D3DAF549E} - SdFi ni sh-0

[ { ODD5F937- 1D1B- 4BEB- 9E50- 949D3DAF549E} - SdWel conmeMai nt - 0]
Resul t =303

[ { ODD5F937- 1D1B- 4BEB- 9E50- 949D3DAF549E} - MessageBox- 0]
Resul t =6

[ { ODD5F937- 1D1B- 4BEB- 9E50- 949D3DAF549E} - SdFi ni sh- 0]

Resul t =1

bOpt 1=0

bOpt 2=0



Installation Video
Running SpinFire 10.0 side-by-side with older versions.

Side-by-Side

SpinFire 10 uses a new technology called Side-by-Side Manifest to allow multiple version of the software to be installed at the same time.
So, you can install SpinFire 10 alongside any other older version of SpinFire you may already have in your system.
This allows you to evaluate the new release while keeping the old version working as usual.

These are the things you need to be aware when using SpinFire side-by-side with older versions:

The .3D file format has changed

The .3D format continues to evolve to accommodate new features in the new version of SpinFire.
We make sure the latest version of SpinFire can read every .3D you may already have produced with any older version of the product.
However the old versions cannot read the .3D produced by the newer release of SpinFire.

Make sure you do not overwrite older .3D by using them with the new SpinFire 10 if you plan to continue using an older version of the product.

.3D File Association

Windows allow one application to be associated with a given file extension. Every version of SpinFire associate the .3D file extension to itself.
This will cause a conflict when using multiple version of the product within the same system.
The best way to open a .3D file from the file explorer is to use the Right-Click menu and select the Open With option.

SpinFire 10 installation detects when older version of the software are installed and makes sure there is an "Open With" entry in the Right-Click
menu for each available version of the software.

Recommendation

While it is very useful to have multiple version of SpinFire running at the same time we do recommend to pick one version as your choice for your
day-by-day work.

We suggest you limit the use of multiple versions to the evaluation period and to make definitive choice after that and remove older version of the
product to minimize conflicts and confusion with the file association and the .3D file format change.

SpinFire Releases

The following lists the released SpinFire 10 versions and their respective build numbers.

Version Build Number Date of Release

SpinFire 10.9 1931.2 7/31/2015
SpinFire 10.8.3 19125 4/13/2015
SpinFire 10.8.2 1851.5 12/23/2014
SpinFire 10.8.1 1845.2 11/23/2014
SpinFire 10.8 1826.3 6/27/2014
SpinFire 10.7 1816.4 5/9/2014
SpinFire 10.6 1732.5 8/13/2013
SpinFire 10.5 1706.4 1/8/2013
SpinFire 10.4 1647.4 10/31/2012
SpinFire 10.3 1632.4 717/2012
SpinFire 10.2.2 1611.4 3/19/2012
SpinFire 10.2.1 1608.2 2/25/2012
SpinFire 10.1 1551.3 11/22/2011
SpinFire 10.0 1543.2 9/21/2011

If you are a registered customer, go to http://www.actify.com/customer-resources/ for a list of links to download.


http://www.actify.com/customer-resources/

Configuring and Activating SpinFire
Configuring and Activating SpinFire™

Activation

Activation transforms your trial version of SpinFire™ into a fully licensed product. Begin Activation from either the Options component or the Tool
s menu. There are two types of seats for SpinFire™: node-locked and floating. A node-locked seat is licensed for one computer. A floating seat
works in conjunction with a floating license server; the total number of floating seats that can be running at any one time is determined by the total
number of licenses that have been purchased.

To activate, you will need either the license file (*.al) or the Seat ID you received from Actify or an authorized reseller at the time of purchase.

A node-locked seat of SpinFire™ is licensed on a per-computer basis. It is possible to transfer your license from one computer to another if, for
example, you replace your computer. To enable a transfer, simply activate SpinFire™ on the new computer; activation will cancel the license for
your old computer and enable the transfer. A maximum of three transfers of a node-locked seat are allowed.

Importers

With SpinFire™, you can view 3D CAD files in nearly all the most popular file formats. To view a file in a certain format you will need to have the
importer for that format installed. Importers are modules that give SpinFire™ direct access to your native CAD files. To see a list of the importers
already installed in your SpinFire™, go to the Options component and click Importers.

For a list of supported file formats see the SpinFire™ Formats page.

Related topics

Options component

Associate CAD File Formats with SpinFire
Update an Importer

Set Importer Update Frequency

Set Volume Precision

License File Request for Manual Activation

Activate SpinFire™

Activation transforms your trial version of SpinFire™ into a fully licensed product. There are two types of Seat ID for SpinFire™: node-locked and
floating. A node-locked seat is licensed for one computer. A floating seat works in conjunction with a floating license server; the total number of
floating seats that can be running at any one time is determined by the total number of licenses that have been purchased.

To activate, you will need either the Seat ID or the license file (*.al) you received from Actify or an authorized reseller at the time of purchase. If
your computer does not have access to the Internet, you must use the license file to activate SpinFire™.

To activate using a Seat ID:

Find the Seat ID that was emailed to you when you purchased SpinFire™.

. Click the Options button.

. Click Activation.

Enter your Seat ID and click Activate OnlineSpinFire™ and the importers you purchased will be active.

I

To activate using a license file:

. Click the Options button.

. Click Activation.

. Click Read License File...

. Browse to the license file (.al) you received from Actify or an authorized reseller and click *Open.The license file will have an .al
extension.

A OWNBE

Related topics

Options component

Associate CAD File Formats with SpinFire


http://www.actify.com/products/spinfire-cad-solution-system/cad-system-file-importer/

File associations determine which program your Windows system uses to open a certain file format. You can set SpinFire™ to be the default
program associated with supported CAD file formats.

To associate CAD file formats with SpinFire™

1. Select the Options component
2. Select the Importers pageThis page lists the installed importers.
3. Find the format you want and select its check box in the Association column.A dialog box will ask you to confirm your decision.

Note

« You can dissociate a file format from SpinFire™ at any time by clearing its Association check box.

Related topics

Options component

License File Request for Manual Activation

Thank you for purchasing SpinFire™. If the computer you are using for the Actify product you have installed is not connected to the Internet or
cannot access it for some network restrictions, you must use a license file to activate the software.

You may request a license file by submitting a support ticket from http://support.actify.com/step_one.asp and including the following information:

1. Your Seat-ID
2. Your Computer-ID

@ IMPORTANT
We need the information above in order to send you a license file.

What is a Seat-ID? It is the license code that enables you to activate and run your purchased Actify products. An example of seat ID is
"06-123-2345678". You can retrieve it by consulting your order email or documents, or by launching SpinFire™ and accessing the
Options > Activation page.

What is a Computer-ID? It is a code that is specific to your computer only and it is generated after having installed spinfire. An
example is "ACTY614853". You can access it by launching SpinFire™ and accessing the Options > Activation page.

What if | do not have a Seat ID? If you are in your limited time evaluation of Spinfire Pro, you do not need any of this and no action is
required on your part.

If you do not have any access to internet, you can print this page, provide the required information and fax this page to Actify, Inc. at: (415)
227-3802

Open a Viewers Settings File

You can save the current settings of your Application Settings page, 3D Viewer Settings page and 2D Viewer Settings page in an XML file.
Another user may then load this XML file to set the Application, 2D and 3D Viewer Settings. This can be useful if you have a file that requires
certain settings in order to be viewed properly or if an organization needs to have the same settings for all its users.

To open a viewers settings file:

1. In the menu bar, select Tools > Import Settings.
2. Choose the file and click OK.This will have a *.xml extension. Default name is SFPConfig.xml.

Related topics
Save a Viewers Settings File
Options component

Save a Viewers Settings File

You can save the current settings of your Application Settings page, 3D Viewer Settings page and 2D Viewer Settings page in an XML file.
Another user may then load this XML file to set the Application, 2D and 3D Viewer Settings. This can be useful if you have a file that requires
certain settings in order to be viewed properly or if an organization needs to have the same settings for all its users.

To save a viewers settings file:

1. From the menu bar, select Tools > *Export Settings...*This opens the Save As dialog box.
2. Choose a place to save your file.


http://support.actify.com/step_one.asp

Related topics

Open a Viewers Settings File

Options component

Set Importer Update Frequency

You can determine how often SpinFire™ checks for the availability of updates to the installed importers.

To set importer update frequency

. Select Options component.

. Select the Settings page.

. Select the Application page.

. From the Check For Updates menu, select the desired frequency.The available choices are Never, Every Week, and Every Day.
SpinFire™ accesses the Internet to check the availability of importer updates.

5. Click Apply Settings.
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Note
« When an update is available for an importer, this will be indicated on the Importers page of the Options component. Available updates are not
automatically installed but must be downloaded and installed by a user. See Update an Importer for details.

Related topics

Options component

Update an Importer

Set Volume Precision

The Volume Precision setting determines the resolution at which the volume of models are computed. Higher precision gives greater accuracy but
may slow down operations with the model.

To set volume precision

. Select Options component.

. Select Settings.

. Select 3D Viewer.

. From the Volume Precision menu, select the level of precision.
. Click Apply Settings.
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Related topics

Options component

Update an Importer

Installed importers are listed on the Importers page of the Options component. If an update is available for an importer it will be indicated beneath
the importer name.

To update an importer:

1. Select Options component.

2. Select the Importers page.This page lists all the importers installed on your system.

3. Find the importer you would like to update.Whenever an update is available for an importer, this will be listed underneath the component
name. For example, "(Build 1008: Download 26.1 MB)" where 26.1 MB is the size of the update download.

4. If an update is available, click the word Download.Dialog boxes will appear as the importer is downloaded and installed. Once the
importer installation is complete, "Download" text will disappear, and the build number of the importer will be updated.

« To determine how often SpinFire™ checks for importer updates, see Set Importer Update Frequency

Related topics

Options component

Set Importer Update Frequency

Using Floating Licenses



Introduction

A floating license is a license that is not linked to a specific computer, but can ‘float' among different computers on the network.

In a floating license environment there is one machine that acts as floating license server: its job is to be the gatekeeper of the floating licenses on
the network. It knows how many floating licenses are available, and how many are in use, and which user is using the license.

One floating license can be used by only one computer on the network at any given time. Two licenses can be used by any two computers on the
network at any given time, and so on.

When a client host needs a license, it will contact the server and ask for a license. This process is called checkout a license. If a license is
available, the server will grant the client that the license, and that license will not be available anymore to other clients. If all the floating licenses
are checked out, then the server will send an error to the client (Spinfire).

When the client does not need the license anymore, it will return the license to the server: it will check-in the license. Typically this happens when
the programs quit. Even if the program shuts down unexpectedly, the floating license server will reclaim the license.

Server and client are configured through a Floating License File, license.al. The Floating License File contains the following information:

® Server Hostname: the network name of the machine that is the floating license server. The server is responsible for keeping track of how
many licenses are in use on the network and for assigning the licenses to the clients.

® Server Host Id: The mac address of the the server. Also referred as 'Physical Address'

® Vendor Name: A name that uniquely identifies the company whose product is licensed. in our case, the vendor name is 'actifyd' The
vendor name is needed to determine the service name.

®* Number of licenses: The number of available lisenses

® Licensed Feature: A FEATURE is any software components that can be licensed: Spinfire is a feature, an importer is a feature, but it
can be extended to any software component. Technically speaking, what gets checked out/checked in is a FEATURE.

® Borrowing Flag: A flag indicating if a feature can be borrowed, i.e. the client can get a license and then disconnect from the network.

® Borrowing Time: the time (in hours) that the that specifies the length of time a feature can be borrowed.
Spinfire determines if a license is floating by looking at the configuration code. If the license is floating, then inside the license.al file there
is an xml node that is the floating license file. Spinfire will extract that node text and save it in a file on disk, as the sfpflv2.dat file, so that
can be used by the floating license system.

For more information on SpinFire licensing, please refer to the following Pages;
® Spinfire Licensing

® Using Floating Licenses

Borrowing/Returning Licenses

The Borrow License command allows a floating license to be used temporarily when a computer is disconnected from the network running the
license server. This is a useful feature for mobile users.

When SpinFire™ is in floating license mode, the Borrow License command appears in the Tools menu. When you click on this menu object, you
borrow the license for two weeks. This borrowed license will not be available to other users until it is returned or expires. The borrowed license
allows SpinFire™ continue working even after the computer is disconnected from the network with the license server.

The borrowed license may be returned anytime within the two weeks after it is borrowed by connecting to the network running the license server
and selecting Tools > Return License.

After two weeks, the borrowed license expires and SpinFire™ will no longer operate without being connected to the network.

Borrowing a License for More than Two Weeks

If you need to borrow a floating license for more than two weeks, you can do so using the following dialog.



Specify Borrow Length [ﬂ

How long do you want to borrow?

(@ Mumber of days
15 =

() Spedify date

5/21/2014

This will allow borrowing of a license for up to 45 days. (If you need to run SpinFire™ off the network for more than 45 days, we suggest
purchasing a standalone seat of SpinFire™.)

Loss of Network Connection

If the network connection between SpinFire™ and FLEXIm is broken, the floating license will remain checked out for two hours by FLEXIm; it will
be unavailable to other users for two hours, even if the network connection is re-established. Also, after a period of time, an error message may
announce that SpinFire™ is unable to connect to the FLEXIm server and close the application; any work that has not been saved will be lost. This
problem does not apply to a "borrowed" floating license.

Related topics

Floating License Installation Procedures
Configuring and Activating SpinFire
Floating License Installation Procedures

Server Setup

Floating License Server Requirements

Pentium IV class computer or higher

96MB Ram required for FLexLM application

Windows NT, Windows XP, Windows Vista/7, Windows 2000/2003/2008 Server, 32 or 64Bit
TCP/IP protocol installed

Installation

Note: These instructions are for installing the floating license configuration to be used with SpinFire Professional V2004, Build 818, or later. If
you would like to install or update a floating license configuration to work with earlier versions of SpinFire Professional, see Floating License
Installation (SpinFire Pro Build 814 or Earlier).

Determine the build number from the SpinFire Professional menu bar by selecting Help > About.
Please note that you cannot have multiple Seat ID's configured on the same FlexLM server. That is, if you want one floating Seat ID with

Importers, and one without, you will have to install and serve FlexLM on two different servers.

Obtain SpinFire Licenses
Request License Files from Actify

Contact Actify with the following information about your Purchase and your Server to request your license files:

SEAT ID: XX-XXX-XXXXXXXX

Host Name (Case sensitive)

*Physical Address (MAC) *XX-XX-XX-XX-XX-XX

Operating System

Is it 32 or 64Bit

Run the following command to obtain the Server Host information above;



® “ipconfig /all"
You will then receive (2) NEW files from Actify:

® license.al (Client)
® sfpflv2.dat (Server)

FlexLM Server Setup 32-bit System (see alternative instructions for 64-bit below)

STEP 1 - Download the FlexLM Server Code

http://ig.actify.com/ig/FloatingLicenseSupport/SFFloatingInst_840.exe

STEP 2 - FlexLM Installation

® Extract files from above download on the desired server machine into the following location (Default);
® C:\Program Files\Actify
Go to C:\Program Files\Actify\Floating License Manager
® Copy the NEW "sfpflv2.dat" file to this folder, replacing the current file

STEP 3 - FlexLM Configuration

®* Run "Imtools.exe", located in installation folder (C:\Program Files\Actify\Floating License Manager)
® Select the "Config. Services" Tab
® Make sure the Path to the "Imgrd.exe" and "sfpflv2.dat” files point to the installation folder shown above
® Check "Use Services" and "Start Server at Power Up" at the bottom
® Select the "Save Service" button and select Yes
® Select "Start/Stop/Reread" tab and select "Start Server"
® Select the "ReRead License File" button
® Select the "Server Status" tab and "Perform Status Enquiry"
® You should get back a listing of all your available licenses, similar to below;
Status

Flexible License Manager status on Wed 4/25/2007 08:56
[Detecting Imgrd processes...]
License server status: 27000@ Server
License file(s) on vassello-xp: C:\Program Files\Actify\Floating License Manager\sfpflv2.dat:

Server: license server UP (MASTER) v9.2
Vendor daemon status (onServer):

actifyd: UP v9.2
Users of CATIA: (Total of 1 license issued; Total of O licenses in use)

Users of CATIA_V2: (Total of 1 license issued; Total of O licenses in use)

FlexLm Server on Windows 7/2008 64-bit system
NOTE: Please see this Instructional Video for additional help.

STEP 1 - Download the FlexLM Server Code

® Select link to download the “Floating License Manager-x64.zip” file
® This will extract version 11.8

STEP 2 - FlexLM Installation

® Extract files from above download on the desired server machine into the following location (Default);
® C:\Program Files(x86)\Actify

® Go to C:\Program Files(x86)\Actify\Floating License Manager

® Copy the NEW "sfpflv2.dat" file to this folder, replacing the current file

STEP 3 - FlexLM Configuration



http://iq.actify.com/iq/FloatingLicenseSupport/SFFloatingInst_840.exe
http://s3.amazonaws.com/Actify/Video/Floating%20License/FLoating%20License%20%20Setup.mp4
http://www.actify.com/resources/customerpage/FloatingLicenseManager-x64.zip

Run "Imtools.exe", located in installation folder (C:\Program Files(x86)\Actify\Floating License Manager)
Select the "Config. Services" Tab

Make sure the Path to the "Imgrd.exe" and "sfpflv2.dat” files point to the installation folder shown above
Check "Use Services" and "Start Server at Power Up" at the bottom

Select the "Save Service" button and select Yes_

Select "Start/Stop/Reread" tab and select "Start Server"

Select the "ReRead License File" button

Select the "Server Status" tab and "Perform Status Enquiry"

You should get back a listing of all your available licenses, similar to that above for 32bit;_

FireWall Set-up

If the firewall is on then you'll also need to do the following

® Go to Control Panel->Windows Firewall ( If you are in category view, you might need to go into System & Security first)
®* Goto Advanced Settings in Windows Firewall (should be in the action list on the left side)
® Go to the Inbound rules ( there is tree in the left and it should be under the root item)
® Create a new rule ('you can right click on Inbound rules->New Rule, or, select the Action "New Rule" from the list on the right)
® Select Rule Type as Program
® Click Next
® Select This Program Path and browse to Imgrd.exe (the new 64 bit Imgrd)
® Click Next
® Select Allow the connection
® Click Next
® Select Domain, Private, Public( 3 checkboxes)
® Click Next

® Give a name to the rule( e.g. Actify LMGRD)
® click Finish

® Repeat Steps above for the actifyd.exe program
® (it's in the same folder as Imgrd.exe)

Client Setup

Install SpinFire Client
® Make sure SpinFire has first been installed on the desired Client PC’s

SpinFire Client — Windows XP

STEP 1 - Client Activation

Automatic Activation

® Copy the NEW license.al file to the following location of each client;

® SpinFire 8.4: “C:\Documents and Settings\All Users\Application Data\Actify\SpinFire Professional”
® SpinFire 9.0: “C:\Documents and Settings\All Users\Application Data\Actify\SpinFire90”

® SpinFire 10.0/10.1: “C:\Documents and Settings\All Users\Application Data\Actify\SpinFire100”

® SpinFire 10.x: “C:\Documents and Settings\All Users\Application Data\Actify\SpinFire10x”

® Start the SpinFire Application
® SpinFire will now obtain a license from the server, and automatically Activate when opened for the first time**

Note: The SpinFire 10.x installation process will automatically copy the license file from the 8.4 or 9.0 folder into the 10.x folder, listed above.

SpinFire Client — VISTA\Windows 7

Client Activation
Automatic Activation

® Copy the NEW license.al file to the following location of each client;
® SpinFire 8.4: “C:\ProgramData\Actify\SpinFire Professional”
® SpinFire 9.0: “C:\ProgramData\Actify\SpinFire90”
® SpinFire 10.x: “C:\ProgramData\Actify\SpinFire10x”
® Start the SpinFire Application
® SpinFire will now obtain a license from the server, and automatically Activate when opened for the first time**

Note: The SpinFire 10.x installation process will automatically copy the license file from the 8.4 or 9.0 folder into the 10.x folder, listed above.



IMPORTANT NOTES:

® ** Make sure the license.al file has content and that the permissions allow normal users Read/execute access. Adding the “everyone”
user will resolve an issue as well.
* The "sfpflv2.dat" file will automatically be extracted from the license.al file and copied to the same folder as the license.al file.
® |f the license file is not placed correctly, is invalid, or does not have the correct permissions, SpinFire 9.0/10.0 will start and work in Read
er mode with limited functionality.
® SpinFire 10.x Installation will automatically copy the license file from previous version of SpinFire to the ..\Actify\SpinFire10x folder as
follows;
® SpinFire 8.4: .\Actify\SpinFire Professional
® SpinFire 9.0: ..\Actify\SpinFire90

Knowledgebase

Modify FlexIm Port Number

There are times when the intended server is already running a FlexLM server, serving licenses for other Applications. It is possible that the
SpinFire "Port Number" of 27000 is already being used by another application. As an example, AutoCAD uses this port number as well.

In this case you will have to change the Port Number SpinFire uses to avoid this conflict, preventing the licenses from being served.
This can be done using the process shown below.

Modify FlexLM Server file

Modify the first line of the “sfpflv2.dat” file as follows;
Change this:

SERVER <Host Name> <Mac Address>

To this:

SERVER <Host Name> <Mac Address> 28000

(Or any number desired)

Modify FlexLM Client file

Modify line 11 of the “license.al” file as Follows
Change this:
<al:FLEXLMFILE> SERVER <Host Name> <Mac Address>
To this:
<al:FLEXLMFILE> SERVER <Host Name> <Mac Address> 28000
(Where Port 28000 matches that of the sfpflv2.dat file)

NOTE: You will then have to re-distribute the license.al file to the clients

What to Do when updating the “sfpflv2.dat” file

Server

Copy new “sfpflv2.dat” file to Floating License manager Folder, replacing current file
Start LMTools

Go to the Start/Stop/Reread Tab

Select Reread

Go to “Service Status” tab

Select “Perform Status Enquiry”

Verify license server is up and running

Client
® Go to one of the folders
SpinFire 8.4
* XP: C:\Documents and Settings\All Users\Application Data\Actify\SpinFire Professional
® Vista/ Win 7:  C:\ProgramData\Actify\SpinFire Professional
SpinFire 9.0
* XP: C:\Documents and Settings\All Users\Application Data\Actify\SpinFire90

® Vista/ Win 7:  C:\ProgramData\Actify\SpinFire90
SpinFire 10.0



* XP: C:\Documents and Settings\All Users\Application Data\Actify\SpinFire100
® Vista/ Win 7:  C:\ProgramData\Actify\SpinFire100

® Delete “license.al” and “sfpflv2.dat” files

® Copy new file into this folder

® Start SpinFire

Floating license troubleshooting

1. If there is a problem with the licensing, first Stop and Restart the License Server
¢ Start Imtools.exe. (Default location: C:\Program Files\Actify\Floating License Manager)
® Open the the Start/Stop/Reread window
® Select Stop Server
2. Check for, and terminate any running floating license processes (Imgrd.exe and actifyd.exe)
® Open the Task Manger window
Do this either by right-clicking the Windows and clicking Task Manger, or by pressing Alt+Ctrl+Delete and clicking Task Manger.
Click the Processes tab
Click Imgrd.exe
Click End Process
Click Yes on the Warning dialog box
This should also terminate the actifyd.exe process
If the actifyd.exe process is still running, right-click actifyd.exe and click End Process
. Start Imtools.exe. (Default location: C:\Program Files\Actify\Floating License Manager)
. Select Configuration using Services
. Select the Config Services tab and verify the location of the Imgrd.exe and sfpflv2.dat files.(Default location: C:\Program
Files\Actify\Floating License Manager)
. Open the the Start/Stop/Reread window
. Click Start Server
. Click ReRead License File, if necessary. If unsure, always do a reread
. If starting the service fails, make sure that the floating license processes were terminated (Step 2) and that the path for Imgrd.exe in the
Config Services tab is correct
10. If reread fails:
® Open the sfpflv2.dat file in a text editor and verify that the first line contains the correct machine name and MAC address (and
port number, if relevant)
® Verify that the is the correct version by opening the Server Status window and checking the status of the server.
Note: Imtools.exe need not be running for the floating license server to be running. Once Imgrd.exe and actifyd.exe are running
(verify via Task Manager), Imtools.exe can be closed.
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Related topics

Configuring and Activating SpinFire

Running FlexLM on Windows 7 32-bit

Running FlexLM on Windows 7 32-bit

In order to get FlexLM running on Windows 7 32-bit, perform the following:

1. Install our version as normal
® http://ig.actify.com/ig/FloatingLicenseSupport/SFFloatinginst_840.exe

2. Download from the following location:
® FlexLM Version 11.11 Updates Download

3. Unzip the file you just downloaded into a temporary folder
4. Copy the following files and place into the installation folder, C:\Program Files\Actify\Floating License Manager, overwriting the
current files

® Imgrd.exe
® |mtools.exe

® Imutil.exe

5. Start, configure, and run LMTools as described on the Floating License Installation Procedures page.

SpinFire 10.0 Release Notes

Overview

SpinFire 10 represents a large effort to improve on SpinFire 9.0.


http://iq.actify.com/iq/FloatingLicenseSupport/SFFloatingInst_840.exe
http://iq.actify.com/iq/FloatingLicenseSupport/SFFloatingInst_840.exe
http://s3.amazonaws.com/Actify/Software/FlexLM/For%20Actify%20Help/V11.11_32Bit.zip
http://www.globes.com/support/fnp_utilities_download.htm
http://www.globes.com/support/fnp_utilities_download.htm
http://www.globes.com/products/utilities/v11.9.1/lmtools_i86_n3.zip
http://www.globes.com/products/utilities/v11.9.1/lmtools_i86_n3.zip

With SpinFire 9.0 we improved reading large files.

SpinFire 10.0 focused on stability, fixing issues, Windows 7 compatibility and adding much needed enhancements.

Windows 7 compatibility: Microsoft changed many things in Vista and Windows 7, SpinFire 10 is a fully compatible Windows 7 application that
does not require compatibility mode anymore. We also added the support for the new thumbnails for .3D files in the Windows file explorer which
can be now displayed in various sizes.

Other changes include the use of the new File Open dialog, how the .3D file is associated to SpinFire and how the over all application behaves
with the new Windows 7 window management.

The new publishing engine

Another big improvement in SpinFire 10 is the redesigned streamlined importing process. This new version of SpinFire uses the new publishing
engine as component driving the import procedure. This new engine called "PubCore" and is the same used in our server product Centro 4.1. It
brings speed improvement and stability to the import process.

Because of the use of PubCore we also improved the management of importer settings. All importers now show a consistent user interface for
changing theirs properties.

The new modular install

Major improvements have been made in the install procedure. SpinFire 10 installation is more modular and allows importers and plug-ins to
installed and updated directly from within the application. We added also a feature called "importer auto-deploy" that allow to download and install
the appropriate importer when opening a CAD file.

In the options/plug-in page you can now browse, download, and install new and existing plug-ins. As soon as new modules are made available
from Actify a notification will be shown in the start-up page of the application. No need to visit a web-site, no need to log-in. Just a click on the link
and the new functions will be downloaded and installed.

These improvements allow to easier updates of importers from Actify allowing to SpinFire to be better up to date with recent versions of CAD
systems and their format change.

Use of .NET 4.0

Starting with SpinFire 9.0 we started the process to move our code-base to the .NET platform from Microsoft.
In this release many more components have been converted to .NET. The application requires .NET V4.0 to be installed on the target machine.

New Features

We also have been adding features to SpinFire 10. Some as part of the main application, some as external plug-ins to allow you to better
customize SpinFire to your needs.

Minimum Distance and Minimum Thickness plug-in.

This plug-un allows to compute the minimum distance from two arbitrary set of geometries or to compute the minimum thickness of a single part.

Read more about Minimum Distance ...
Read more about Minimum Thickness ...

Projected Area

This feature allows to projects the surface area of a part or parts
onto a plane. It is similar to casting a light on the parts and
calculating the surface area of the shadow on the wall.

Read more ...

Better Home Page

The new SpinFire start-up screen now shows three main areas of
interest:

® Messages: here SpinFire display useful messages about
the license in use, available updates for importers or
plug-ins, or warning messages about components that
may fail to load or activate.

® Recent Document: here SpinFire provides a list of the
most recent open files (.3D or native CAD files). Along
with the file name SpinFire shows a small images of the SpinFire 10
model or drawing, the date when the file was last opened,
and the size of the file.

® Status, Options and Links: on the left side of the home
page SpinFire features useful links to access common
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area of the application or useful web pages available on
Actify web site.

Read more ...

Importers AutoDeploy

If a user attempts to open a native CAD file which requires an
importer that is not installed, SpinFire's AutoDeploy will ask the
user if they wish to install the importer. As soon as the importer
installs then the native CAD file is imported into SpinFire 10.

Improved Importer Updating

If SpinFire 10 detects a newer version of any importer or plug-in is

available, a message will appear on the Home page as well as on
the Importers/Plug-Ins pages. The user can then update directly from the Importer or Plug-In page. This improvement allows Actify to update and
add importers and plug-ins without requiring users to reinstall a new version of SpinFire.

Improved Settings

We improved the settings for the application as well. You can now
control:

The frequency for updates check over the Internet
Enable/Disable the auto-deploy feature

Change the number of items shown in the last open
document list.

Enable/Disable update notifications in the home page
All settings can be saved to a XML file and re-imported
later or on other stations running SpinFire.

New/Improved CAD formats support

I-Deas
SpinFire 10.0 now handles I-Deas files with the
extensions MF1, ARC, UNV, and PKG. The version of
|-Deas supported are:

® Upto 13.x (NX5)

® NX I-deas 6

SolidWorks

SpinFire 9.0 handled only the display data of SolidWorks
3D models. SpinFire 10.0 has improved on this utilizing
the additional data in the SolidWorks files however if this
cannot be processed we fall back to the display data
method. You can force using the old method by enabling
the importer options setting, Import Only Display Data f
or the SolidWorks importer.

SolidWorks versions support are up to 2011.
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® |n addition we incorporated bug fixes and additional improvements to the following importers since SpinFire 9.0:

® Catia v4 - now supports versions up to 4.2.5
Catia v5 - now supports versions up to R20
Inventor - now supports versions up to 2012
JT - now supports versions up to 9.5

NX - now supports versions up to NX7.5
ParaSolid - now supports versions up to 23
PRC - supports all Versions

Most important bug fixes

Pro/ENGINEER - now supports versions up to Wildfire 5
STEP - now supports versions AP 203 E1/E2, AP 214

In SpinFire 10 we fixed a large amount of issues from previous versions. The following are some of the most important:

® The order of the recent open document was not changing when an existing document was reopened.

The file association of CAD files was broken in SpinFire 9

® Image preview of .3D files in Windows Explorer was broken in SpinFire 9. It has been fixed and improved to take advantage of Windows

7 improved capabilities.



® SpinFire 9 required "Compatibility Mode" in Windows Vista and Windows 7. SpinFire 10 is fully compatible with Windows 7.

® Picking and measuring along a cross-section has been fixed.

® Printing in pure Black and White was not working properly. SpinFire 10 fixes the problem and allow to import 2D in pure black and white
for most of 2D file formats.

® Multiple problems with picking points, circles and edges have been fixed when working in multiple viewport modes.

® Auto-installation of importers has been re-introduced.

® Pointsets entities are now more visible and easy to pick and measure.

SpinFire 10.1 Release Notes

Overview

SpinFire 10.1 introduces support for 4 new languages on top of the three already available in 10.0. So the official languages now supported in
SpinFire are:

English

German

Japanese

French (introduced with 10.1)

Italian (introduced with 10.1)

Simplified Chinese (for China) (introduced with 10.1)
Traditional Chinese (for Taiwan) (introduced with 10.1)

We also concentrated our effort in solving some problems reported by users in the 10.0 release.

The installation

Version 10.1 can be installed side-by-side with previous versions such as 9.0 and 8.x releases of SpinFire.

The install detects the presence of version 10.0 and upgrade this release providing the fixes to current users of SpinFire 10.0. When upgrading
from 10.0 the installation detects the current configuration of importers and plug-ins and update all the components already installed with the
latest release.

Most important bug fixes

Eliminated some permission problems causing the license check to fail on some Windows 7 systems.

Fixed opening a native file from the file browser using the double-click action.

Limited the alerts for updates in the home page to 3 messages maximum.

In some plug-ins the selection of parts or assemblies on the assembly tree was not detected properly.

In some system an markup with a link to another document in the work-space was causing the launch of IE.

When selecting the transform commands on a part on two consecutive loaded files SpinFire was crashing.

The weight calculator plug-in was not consistently display the same decimal symbol when viewing in other languages other than English.

SpinFire 10.2 Release Notes

* Important Note: A few issues have been brought to our attention. They should be resolved
shortly and a new version released. Please see below for the explanation and possible
workarounds

Issues

® Options->Settings->3D Viewer and 2D Viewer pages

® Changes made here are saved but do not take effect in the Workspace
¢ Dimension Units

® Default value is set to MM and cannot be changed
* Workspace->“Units” dropdown

® Changes made are saved but do not take effect in the Workspace

® Dimensions are still in MM

Workarounds

® How to change the Units on created Dimensions
® Right-click on the dimension
® Select Units
® Select desired unit



® How to change the appearance on created Notes and Dimensions
® Right-click on the dimension or Note

Select Properties

Select Font or Color

Change to desired setting

Overview

10.2 is a simple release to fix a licensing issue and to introduce the first iteration of the Export to 3D PDF plug-in.

Export to 3D PDF Plug-in
® Allows exporting of 3D models to PDF files

® Within Adobe Acrobat, one can rotate, zoom, pan on the model, view the assembly, change the background color and lighting
® See PDF Export for more information

Most important bug fixes

® Expired End-Of-Maintenance (EOM) dates in licenses stopped importers from functioning

Notes

The Catia v5 and SolidWorks importers are updated using a new underlying library version. Because of this, these versions and future versions of
these importers will only be available to SpinFire 10.2 or greater.

SpinFire 10.2.1 Release Notes

Overview

The 10.2.1 was released to quickly address the issue where saved Settings were not being applied when using SpinFire.

Issues Addressed

® 3D Viewer and 2D Viewer settings were not being applied after changing and saving.

®* The Auto-Deploy feature stopped working in 10.2. Attempting to import a native CAD file without having the importer installed now asks
the user of they want it to be installed.

® The right-mouse menu on a 3D model had incorrect characters in the menu for the Simplified Chinese language.

Supported Environments

Client Environment Minimum Recommended
Operating System Windows 7 (32-bit)
Windows 7 (64-bit) Windows 7 (64-bit)

Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below

Windows Vista

OS Language Supported English (US) English (US)
Simplified Chinese Simplified Chinese
Chinese Chinese
French French
German German
Italian Italian

Japanese Japanese



CPU / Processor

Memory (w/o Importers)

Memory (w/ Importers)

Note: Windows XP 64Bit Prerequisites

Pentium Ill, 2.0+ Ghz

1.0 GB (2.0 GB for Windows Vista or
Windows 7

2.0 GB (3.0 GB for Windows Vista or
Windows 7

® 64-bit Windows Imaging Component (WIC)

® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385

® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079

* MSXML 6.0

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=993c0bcf-3bcf-4009-be21-27e85e1857b1

® NET2

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en

* NET4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

® Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.2.2 Release Notes

Overview

The 10.2.2 was released to quickly address EOM license dates were incorrectly interpreted by SpinFire.

Issues Addressed

® Expired End-Of-Maintenance (EOM) dates in licenses stopped importers from functioning

Supported Environments

Client Environment

Operating System

OS Language Supported

CPU / Processor

Memory (w/o Importers)

Memory (w/ Importers)

Minimum

Windows 7 (32-bit)
Windows 7 (64-bit)
Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below

Windows Vista
English (US)
Simplified Chinese
Chinese

French

German

Italian

Japanese

Pentium 1ll, 2.0+ Ghz

1.0 GB (2.0 GB for Windows Vista or
Windows 7

2.0 GB (3.0 GB for Windows Vista or
Windows 7

Recommended

Windows 7 (64-bit)

English (US)

Simplified Chinese

Chinese

French

German

Italian

Japanese

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

Note: Windows XP 64Bit Prerequisites

® 64-bit Windows Imaging Component (WIC)

® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079
® MSXML 6.0

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=993c0bcf-3bcf-4009-be21-27e85e1857b1
® NET2

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en
* NET4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
® Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.3 Release Notes

Overview

SpinFire 10.3 adds functionality to measure tubing as well as adding enhancements to the Export 3D PDF functionality. A few importers have
been reinstated with a number of bug fixes to current importers. 10.3 also introduces support for 2 new languages.

SpinFire 10.3 summary of changes:

Tube Length calculator

Tube Length Bill of Materials support

Update of importers with the TechSoft 5.0.1 library

The Export 3D PDF plug-in is now part of the SpinFire functionality
Additional enhancements to the Export 3D PDF functionality
SAT importer

Rhino importer

TIFF importer

Catia v5 PMI fixes

Korean language support

Czech language support

The installation

Version 10.3 can be installed side-by-side with previous versions such as 9.0 and 8.x releases of SpinFire.

The install detects the presence of version 10.x and upgrades this release providing the fixes to current users of SpinFire 10.x. When upgrading
from 10.x the installation detects the current configuration of importers and plug-ins and update all the components already installed with the latest
release.

Issues Addressed

* 3D PDF Improvements
® This is part of SpinFire main functionality; it is no longer a plug-in

Improved tessellation
The model “fits" better within exported viewable window
Allows user to select PDF template to use
SpinFire installs seven PDF templates
SpinFire background color is exported to PDF
Some Reader functionality such as printing is now available in SF 10.3 Reader
STL Export plug-in will now export only visible marked data as it did in v.8.4.1
Fixed issue where saving .3D files with an active section cut will be an empty 3D graphic after reloading the .3D file
Some SF 8.x .3D files could not be rendered in wire-frame in SF 10.x. This is now fixed
Can now drag-and-drop CAD or .3D files on to the SpinFire desktop icon
The Registration check box remains checked when a user registers
Catia v5 Importer Improvements

® Some files did not import when Import PMI option is enabled
SConverter error would occur importing Catia v5 CATPart.
Catia v5 importer shows the importer CAD view names incorrectly
Symbol for position nodes are displaying now
Hidden annotation planes are imported as hidden now
Housing 3D Catia v5 PMI data inaccurate
Fixes to some files with missing surfaces and misplaced surfaces
Catia v5 PMI location flags are now being show properly as arrows rather than rectangles
Catia v5 PMI "balloon" indicators now properly show as circled items rather than squares
Double pointed arrows are now appearing correctly; they were appearing as squares


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

¢ JT Importer Improvements

Fails to import attached file

Some JT part files failed to open in SF 9.0 now open in 10.3
Some JT assembly files failed to open now open in 10.3

Catia v5 PMI symbol for degrees was misplaced on the wrong line
® NX Importer Improvements

® Pro-E Importer Improvements

Improved Importer Support

Importer
Catia v5
I-DEAS
Inventor
ParaSolid
PRC
Pro-E

NX
SolidWorks
STEP
SAT
Rhino

TIFF

Known Issues

® The right mouse menu on a Tube Length markup has an incorrect Hide/Show menu text.

Supported Environments

Client Environment

Operating System

OS Language Supported

® Construction surfaces were erroneously visible on some NX models
® Exception error was occurring opening some NX files

® Pro-E file imports with untrimmed surface

® Missing surface issue corrected
® STEP Importer Improvements

® Some STEP files that opened in 8.4.1 but not 9.0 open in 10.3

Native Version Support

R4 to R21

Up to 13.x (NX 5), NX I-deas 6

Up to 2012

Up to v24

All Versions

Up to Wildfire 5

Unigraphics V11.0 to NX 8 (3D Only)
Up to 2012 (3D only)

AP 203 E1/E2, AP 214

Reinstated
Reinstated

Reinstated

Minimum

Windows 7 (32-bit)
Windows 7 (64-bit)
Windows XP SP3 (32-hit)

Windows XP SP2 (64-bit)
Note: See requirements below

Windows Vista (32 or 64 Bit) SP2
English (US)

Simplified Chinese

Chinese

Czech

Recommended

Windows 7 (64-bit)

English (US)
Simplified Chinese
Chinese

Czech



CPU / Processor

Memory (w/o Importers)

Memory (w/ Importers)

Graphics

Note: Windows XP 64Bit Prerequisites

French

German

Italian

Japanese

Korean

Pentium 1ll, 2.0+ Ghz

1.0 GB (2.0 GB for Windows Vista or
Windows 7

2.0 GB (3.0 GB for Windows Vista or
Windows 7

Open GL capable Graphics with 128 Mb

RAM

® 64-bit Windows Imaging Component (WIC)

® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385

® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079

® MSXML 6.0

French

German

Italian

Japanese

Korean

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more

512 Mb or higher recommended

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=993c0bcf-3bcf-4009-be21-27e85e1857b1

® NET2

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en

* NET4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

® Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.4 Release Notes

Overview

SpinFire 10.4 includes a new conversion output option called CAD2CAD and a number of bug fixes to current importers.

SpinFire 10.4 summary of changes:

CAD2CAD

CATIA Improvements

°
L]
L]
® UG NX Improvements

The Installation

Version 10.4 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected upon

Memory handling improvements

installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is
also detected on installation, and relevant components are updated.

Issues Addressed

SpinFire

An unhandled exception no longer occurs if Model Compare is run before a model is opened.

A memory leak no longer occurs when a model is rotating and the user moves the mouse pointer over the rotating object.
AutoDeploy now works in SpinFire 10.3.

On the Tube Length markup label menu, the first selection item has been changed to Hide Length.


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

L =63.74 mm

Hide Length

LInits

Decimal Places

Stay on Top

Lock Position

Copy

Delete

Properties

* A memory leak with spinning annotations no longer occurs.
® After Opening a .3D file in Internet Explorer, the |IE session can be closed.

Importers

Supported Environments

Client Environment

Operating System

OS Language Supported

CPU / Processor

Memory (w/o Importers)

Memory (w/ Importers)

CATIA V5: Drawing no longer crashes PubCore.

CATIA V5 R20 SP4: CATDrawing file no longer causes PubCore error.
CATIA V5: 2D CATDrawing file imports successfully.

CATIA V5: 2D drawing no longer uses a rectangle rather than a rounded cornered box to show dimension values.
UG NX: 2D and 3D files load successfully.
UG NX: Dash dot polyline is shown correctly.

Minimum

Windows 7 (32-bit)
Windows 7 (64-bit)
Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below

Windows Vista (32 or 64 Bit) SP2
English (US)
Simplified Chinese
Chinese

Czech

French

German

Italian

Japanese

Korean

Pentium 1ll, 2.0+ Ghz

1.0 GB (2.0 GB for Windows Vista or
Windows 7)

2.0 GB (3.0 GB for Windows Vista or
Windows 7)

Recommended

Windows 7 (64-bit)

English (US)

Simplified Chinese

Chinese

Czech

French

German

Italian

Japanese

Korean

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more



Graphics Open GL capable Graphics with 128 Mb 512 Mb or higher recommended
RAM

Note: Windows XP 64-Bit Prerequisites

® 64-bit Windows Imaging Component (WIC)

® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079
® MSXML 6.0

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=993c0bcf-3bcf-4009-be21-27e85e1857b1
® NET2

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en
* NET4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
® Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.5 Release Notes

Overview

In addition to improved function and additional importer libraries, SpinFire 10.5 includes five new CAD2CAD conversion outputs:

ACIS
IGES
Parasolid
PRC

STL

The Installation
Version 10.5 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected upon

installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is
also detected on installation, and relevant components are updated.

Issues Addressed

® Importing failed when a non-administrator attempted to import a Catia v5 2D drawing.
® The tree control inside SpinFire caused poor performance for users without an Internet connection.
® Techsoft 3DX v5.2 importer libraries are included in the installation.

Supported Environments

Client Environment Minimum Recommended
Operating System Windows 7 (32-bit)
Windows 7 (64-bit) Windows 7 (64-bit)

Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below.

Windows Vista (32- or 64-bit) SP2

OS Language Supported English (US) English (US)
Simplified Chinese Simplified Chinese
Chinese Chinese
Czech Czech
French French

German German


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

Italian Italian

Japanese Japanese
Korean Korean
CPU / Processor Pentium 1ll, 2.0+ Ghz Pentium IV-Core 2 Duo or greater
Memory (w/o Importers) 1.0 GB (2.0 GB for Windows Vista or 2.0 GB (3.0 GB for Windows Vista or
Windows 7) Windows 7) or more
Memory (w/ Importers) 2.0 GB (3.0 GB for Windows Vista or 3.0 GB (4.0 GB for Windows Vista or
Windows 7) Windows 7) or more
Graphics Open GL capable graphics card with 128 MB 512 MB or higher
RAM

Note: Windows XP 64-Bit Prerequisites

® 64-bit Windows Imaging Component (WIC)
® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079

® MSXML 6.0

® http://www.microsoft.com/en-us/download/details.aspx?id=3988
® NET2

® http://www.microsoft.com/en-us/download/details.aspx?id=6523
* NET4

® http://www.microsoft.com/en-us/download/details.aspx?id=17718
® Visual C++ 2010

® http://www.microsoft.com/en-us/download/details.aspx?id=14632

SpinFire 10.6 Release Notes

Overview

SpinFire 10.6 includes:

® New Minimum Bounding Box algorithm
® Added CAD2CAD support
* JT
* New Extended CAD feature
® Updated CATIA V6 3D support (see Additional Notes)
® Updated NX 8.5 3D and 8.0 2D support

The Installation

Version 10.6 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected upon
installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is
also detected on installation, and relevant components are updated.

Issues Addressed

CATIA V5 Part File Fails to Import

Projected Surface Area - Problem with results on some files
TechSoft 3DX v6.0 importer libraries are included in the installation
Some CAD2CAD CATProducts fail to convert

* Some IGES files can't be read due to an extra <CR> in the initial line
* NX Files are not Converting to Step with C2C Converter
* SolidWorks File Imports but Does not Convert

® Some incorrect translations for the German version
®* NX 2D 7.5 and 8.0 geometry not importing

Additional Notes


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/en-us/download/details.aspx?id=3988
http://www.microsoft.com/en-us/download/details.aspx?id=6523
http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=14632

® Because the new bounding box algorithm uses the name Minimum Bounding Box, the old algorithm has been renamed to Axis-Aligned

Bounding Box

® CATIA V6 files (.3dxml) are processed using the CATIA V5 importer
® The Extended CAD feature only exists for following importers:

* CATIAVS
® |nventor

* JT

* NX

* Pro-E

® SolidWorks

Supported Environments

Client Environment Minimum

Operating System Windows 7 (32-bit)

Windows 7 (64-bit)
Windows 8 (32-bit)
Windows 8 (64-bit)
Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below.

Windows Vista (32- or 64-bit) SP2

OS Language Supported English (US)

Simplified Chinese
Chinese

Czech

French

German

Italian

Japanese

Korean

CPU / Processor Pentium Ill, 2.0+ Ghz

Memory (w/o Importers) 1.0 GB (2.0 GB for Windows Vista or

Windows 7)

Memory (w/ Importers) 2.0 GB (3.0 GB for Windows Vista or

Windows 7)

Graphics Open GL capable graphics card with 128 MB

RAM

Note: Windows XP 64-Bit Prerequisites

64-bit Windows Imaging Component (WIC)

® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079
MSXML 6.0

Recommended

Windows 7 (64-bit)

English (US)

Simplified Chinese

Chinese

Czech

French

German

Italian

Japanese

Korean

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more

512 MB or higher

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=993c0bcf-3bcf-4009-be21-27e85e1857b1

.NET 2

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en

.NET 4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

Visual C++ 2010


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.7 Release Notes

Overview

SpinFire 10.7 includes:

® Update importers

The Installation

Version 10.7 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected upon
installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is
also detected on installation, and relevant components are updated.

Issues Addressed

Tessellation settings in CAD2CAD do not seem to work; we'll remove these settings
Export-> pdf doesn't work with attached files

Enterprise Installation - Czech version .mst file 1029.mst missing

German translation of license warning dialog boxes need changing

Solidedge 4500060906-00-3_Lampenarm2_PMS300_(06-2007).asm with SPPRO 10.6
Far-away PMI from catiav5 catpart

JT file fails to open on 10.6 and with importer SP applied but opens on daily 10.6.1

Put option to use Techsoft libraries for SAT importer

Importer Pack 1807.4 (with MS Visio) - Importing CATIA V5 PMI Crashing Pubcore
CATIA V5 .CATPart Fails to Import

UG NX 2D Drawing Crashes during Import Attempt {datakit #11105}
Source-Package-22555-FCO00AAM17326_s_FCO0AAM17326.001.0027.DRAWINGOO01.prt
® NX importer crash with 2D import setting enabled FAOOAAH66773_009.prt

® NX 2D 24267849.drawing001.001001.prt Drawing Crashes During Importing

(D Extended CAD Licensing
The licensing scheme for Extended CAD (metadata extraction) has changed since SpinFire 10.6.

If your purchased Extended CAD license is not functioning, go to the Activation page and click the Activate Online button.

If the problem persists or your system does not have access to an Internet connection, please contact Actify support.

Supported Environments

Client Environment Minimum Recommended
Operating System Windows 7 (32-bit)
Windows 7 (64-bit) Windows 7 (64-bit)

Windows 8 (32-bit)
Windows 8 (64-bit)
Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below.

Windows Vista (32- or 64-bit) SP2
OS Language Supported English (US) English (US)
Simplified Chinese Simplified Chinese

Chinese Chinese


http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

CPU / Processor

Memory (w/o Importers)

Memory (w/ Importers)

Graphics

Note: Windows XP 64-Bit Prerequisites

Czech

French

German

Italian

Japanese

Korean

Pentium 1ll, 2.0+ Ghz

1.0 GB (2.0 GB for Windows Vista or
Windows 7)

2.0 GB (3.0 GB for Windows Vista or
Windows 7)

Open GL capable graphics card with 128 MB
RAM

® 64-bit Windows Imaging Component (WIC)
® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385

® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079

® MSXML 6.0

Czech

French

German

Italian

Japanese

Korean

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more

512 MB or higher

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=993c0bcf-3bcf-4009-be21-27e85e1857b1

* NET2

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en

* NET4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

® Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.8 Release Notes

Overview

SpinFire 10.8 includes:

® Update importers

The Installation

Version 10.8 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected upon

installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is
also detected on installation, and relevant components are updated.

Issues Addressed

Specific ProE file would not open

Pro/E files failing to open some WildFire 5 files

CATPart Catia V5 not highlighting annotation in workspace when selected from the annotation tree
SolidEdge .asm - File crashes SFP with stack overflow {not fixed on st5}
SolidEdge .par files load with just blue background, but nothing is showing except the arrows. {unfixed st5}

A Catia v5 sub-assembly is being imported as a single part. The part list for the sub assembly does not appear in SpinFire.
A JT file the assembly tree part names import into SF 10.1 incorrectly.
Catia V4 3d Import will get no assembly tree, only surfaces

SAT File never finishes publishing/opening.

Multi-Component CATIA CATPart Opens as Single Part

Assembly structure in CatiaV5 files - missing deeper entries


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

Supported Environments

Client Environment

Operating System

OS Language Supported

CPU / Processor

Memory (w/o Importers)
Memory (w/ Importers)

Graphics

Note: Windows XP 64-Bit Prerequisites

Minimum

Windows 7 (32-bit)
Windows 7 (64-bit)
Windows 8 (32-bit)
Windows 8 (64-bit)
Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below.

Windows Vista (32- or 64-bit) SP2
English (US)
Simplified Chinese
Chinese

Czech

French

German

Italian

Japanese

Korean

Pentium 1ll, 2.0+ Ghz

1.0 GB (2.0 GB for Windows Vista or
Windows 7)

2.0 GB (3.0 GB for Windows Vista or
Windows 7)

Open GL capable graphics card with 128 MB
RAM

® 64-bit Windows Imaging Component (WIC)
® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385

® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079

® MSXML 6.0

Recommended

Windows 7 (64-bit)

English (US)

Simplified Chinese

Chinese

Czech

French

German

Italian

Japanese

Korean

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more

512 MB or higher

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857bh1

* NET2

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en

* NET4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

® Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.8.1 Release Notes

Overview

SpinFire 10.8.1 includes:

® Importer updates include support for the following versions:

® CatiaV5-6R2014 SP4


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

® |nventor 2015
® Creo0 3.0
® SolidEdge ST7

The Installation

Version 10.8.1 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected
upon installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is

also detected on installation, and relevant components are updated.

Issues Addressed

Crashing issue using NVIDIA Quadro FX 1800 video cards with updated drivers.
Pubcore.exe process doesn't terminate using AMD Radeon video cards with updated drivers.
CAD2CAD error on XP 32-bit systems

Rhino 3D files do not open on XP 32-bit systems

The list of countries on the Registration page reduced.

Importers fail to remain active using English version and altering decimal separator.
NX 8.5 assembly will not open if 2D Import is "ON" in NX importers settings.

NX8.5 file won't open in Spinfire 10.8

NX: Items are drawn twice on UG NX 2D Sheet 001 of specified file.

UG NX Importer - Problem opening file in folder with long Path Structure

2D NX9 file importers empty.

NX File Imports with no Geometry

Poor CATDrawing display.

CATIA V5 will not open - conversion process terminated

CATIA V5 R22 SP5 Hotfix 16 file causes SpinFire to never finish opening file.
CATIA V5: Cylinders from Catia do not completely appear in SF

CATIA V5 missing geometry but works in SF 8.4

CATIA V5 file published with an empty workspace

CATIA V5 Importer not Importing CATIA V4 data referenced to in .CATProduct assembly file
CATIA V5 3D File Importers with Incorrect Surfaces

CATIA V5: simple_assembly5 -- Incorrect color for part instance

Error in edge subdivide of stepfile in SPPRO 10.6, 10.7, Centro 6.1

Known Issues

The Country field does not remain filled after performing an online registration.

An additional "6.2" folder is created under the c:\users\<username>\AppData\Local\Actify\PubCore folder.

Some Inventor files fail to publish with the new importer upgrade.
Some NX 9 files fail to import or show geometry
The Rhino importer supports up to 5 though the importer description may not indicate this.

There are known issues with Catia v5 R24 files with incorrect assembly tree names. Geometry may be missing as well.

Supported Environments

Client Environment Minimum Recommended
Operating System Windows 7 (32-bit)
Windows 7 (64-bit) Windows 7 (64-bit)

OS Language Supported English (US) English (US)

Windows 8 (32-bit)
Windows 8 (64-bit)
Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below.

Windows Vista (32- or 64-bit) SP2

Simplified Chinese Simplified Chinese



Chinese Chinese

Czech Czech
French French
German German
Italian Italian
Japanese Japanese
Korean Korean
CPU / Processor Pentium Ill, 2.0+ Ghz Pentium IV-Core 2 Duo or greater
Memory (w/o Importers) 1.0 GB (2.0 GB for Windows Vista or 2.0 GB (3.0 GB for Windows Vista or
Windows 7) Windows 7) or more
Memory (w/ Importers) 2.0 GB (3.0 GB for Windows Vista or 3.0 GB (4.0 GB for Windows Vista or
Windows 7) Windows 7) or more
Graphics Open GL capable graphics card with 128 MB 512 MB or higher
RAM

Note: Windows XP 64-Bit Prerequisites

® 64-bit Windows Imaging Component (WIC)

® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079
® MSXML 6.0

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=993c0bcf-3bcf-4009-be21-27e85e1857h1
® NET2

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en
®* NET4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
® Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.8.2 Release Notes

Overview

SpinFire 10.8.2 includes:

® Importer updates include support for the following versions:
® NX9.0.2.5c

The Installation

Version 10.8.2 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected
upon installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is
also detected on installation, and relevant components are updated.

Issues Addressed

® NXv9.0.2.5 Rev C files open as empty files.

Known Issues

® NX 9.0.3 files may not open successfully.
® Catia vb R24 Assembly tree names are incorrect.

Supported Environments


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

Client Environment Minimum

Operating System Windows 7 (32-bit)

Windows 7 (64-bit)
Windows 8 (32-bit)
Windows 8 (64-bit)
Windows XP SP3 (32-hit)

Windows XP SP2 (64-bit)
Note: See requirements below.

Windows Vista (32- or 64-bit) SP2

OS Language Supported English (US)

Simplified Chinese
Chinese

Czech

French

German

Italian

Japanese

Korean

CPU / Processor Pentium Ill, 2.0+ Ghz

Memory (w/o Importers) 1.0 GB (2.0 GB for Windows Vista or

Windows 7)

Memory (w/ Importers) 2.0 GB (3.0 GB for Windows Vista or

Windows 7)

Graphics Open GL capable graphics card with 128 MB

RAM

Note: Windows XP 64-Bit Prerequisites

64-bit Windows Imaging Component (WIC)

® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079
MSXML 6.0

Recommended

Windows 7 (64-bit)

English (US)

Simplified Chinese

Chinese

Czech

French

German

Italian

Japanese

Korean

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more

512 MB or higher

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=993c0bcf-3bcf-4009-be21-27e85e1857b1

.NET 2

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en

.NET 4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.8.3 Release Notes

Overview

SpinFire 10.8.3 includes:

Importer updates include support for the following versions:
® SolidWork 2015
* JT 10
® Parasolid V27
* NX10d


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

The Installation

Version 10.8.3 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected
upon installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is
also detected on installation, and relevant components are updated.

Issues Addressed

® SpinFire
® After registering, the country field reverts back to blank rather than staying on the country registered.
Missing French and Malaysia from country list on the Registration page.
Missing Estonia and New Zealand from country list in Japanese version.
Changed "USA" to "United States (USA)" in list of countries on the registration page.
Allow tessellation quality parameters for CAD to STL process.
3DPDF Export has a length restriction for the file name.
URL link is incorrect within e-mail from SpinFire.
nVIDIA GeForce 9600 latest drivers (341.44) crashes SpinFire.
CAD2CAD fails on Windows 7 32-bit.
® SpinFire 10.8.2 on Windows 7 32-bit: NEWSHELL3Dsupport.dll error occurs.
* AutoCAD
® For some DXF files the mirror image is imported.
* AutoCAD DWG is importing with extraneous unwanted drawing.
* AutoCAD DWG drawing missing an entire table.
® AutoCAD arm DWG missing border with AutoCAD.
® Catia V5
® A 2D Catia V5 file opens where the text does not fit the lower right table correctly and is missing the logo.
® Fail to open converted Catia V5 file from CT Core Technologie 3D Evolution 2013.
® Parts from a Catia V5 assembly are not being imported. i.e. missing parts.
® Specific CATPart file fails to open.

* IGES

® Some IGES files fail to open in SpinFire 10.8.1.
® Inventor

® Inventor file shows extra surfaces.

® The Stapler.iam Inventor assembly fails to open.

® Open JT file version 10.

Additional surfaces are rendered opening an NX file.
Failure to read NX 9.0.3.4 D1 version prt file.

Specific NX file opens blank.

Poor tessellation of holes.

Unable to open NX 9.0 file.

NX 9 3D Files opening empty.

NX9 error importing.

Specific NX file currently opens with a blank 2D drawing.

® SAT
® Poor tessellation quality in SAT importer.
® SolidWorks
® A SolidWorks 2D file doesn't frame correctly.
A SolidWorks 2D drawing is missing geometry and has additional DIM's which will not be displayed in SolidWorks itself.
SolidWorks 2D document is missing a central drawing.
SolidWorks 2D shaft_pulley.SLDDRW drawing is missing some text or dimensions (measurement drawing annotations).
SolidWorks drawings are outside of frame making the containing paper really wide.
SolidWorks 2D drawing: T theta symbols are missing next to values.
Solidworks 2D object(s) are missing.
SolidWorks 2011 2D drawing file loaded incorrectly.
SolidWorks 2D SLDDRW - missing theta symbol from drawing.
Fail to open SolidWorks 2015 files.

® STEP

3D work space entities appear to be missing.

STEP Assembly imports with missing part.

STEP File importing with incorrect surfaces.

A STEP file opens with only the doughnut shape in SpinFire.

A ball shaped part appears in a STEP file import that should not be there.

Known Issues

® NX 9.0.3 files may not open successfully.



® Some quality issues with Catia V5 R24 files

® SolidWorks 2015 2D files fail to open.
® CAD2CAD JT export file is v8.1

Supported Environments

Client Environment

Operating System

OS Language Supported

CPU / Processor

Memory (w/o Importers)
Memory (w/ Importers)

Graphics

Note: Windows XP 64-Bit Prerequisites

Minimum

Windows 7 (32-bit)
Windows 7 (64-bit)
Windows 8 (32-bit)
Windows 8 (64-bit)
Windows Vista (32- or 64-bit) SP2
English (US)
Simplified Chinese
Chinese

Czech

French

German

Italian

Japanese

Korean

Pentium 1ll, 2.0+ Ghz

1.0 GB (2.0 GB for Windows Vista or
Windows 7)

2.0 GB (3.0 GB for Windows Vista or
Windows 7)

Open GL capable graphics card with 128 MB
RAM

® 64-bit Windows Imaging Component (WIC)
® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385

® Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079

® MSXML 6.0

Recommended

Windows 7 (64-bit)

English (US)

Simplified Chinese

Chinese

Czech

French

German

Italian

Japanese

Korean

Pentium IV-Core 2 Duo or greater

2.0 GB (3.0 GB for Windows Vista or
Windows 7) or more

3.0 GB (4.0 GB for Windows Vista or
Windows 7) or more

512 MB or higher

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=993c0bcf-3bcf-4009-be21-27e85e1857b1

* NET2

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en

* NET4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

® Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

SpinFire 10.9 Release Notes

Overview

SpinFire 10.9 includes:

® Support for 3D Inventor 2016
® Support for 3D Catia V5-6 R2015 (R25)


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

® Added flattened layer mode to CatiaV5 and NX Importers
® Update 3D & 2D importers

The Installation

Version 10.9 can be installed side-by-side with previous releases of SpinFire, such as 9.0 and 8.x. The presence of Version 10.x is detected upon
installation and upgraded, thereby providing fixes to current SpinFire 10.x users. The current configuration of importers and plug-ins is
also detected on installation, and relevant components are updated.

Issues Addressed

® AutoCAD

® Catia

IGES

NX

® Added flattened layer mode for DWG importer.

A DWG file is importing without any Dimensions.
AutoCAD DWG file imports incorrectly.

DWG file import correctly, but all layers are hidden.

An AutoCAD DWG file is missing red hashed lines.

An AutoCAD DWG file hangs on importing drawing.

AutoCAD DXF file border placement of 2D drawing is incorrect

AutoCAD DWG file takes a very long time to open and is incorrect when opened
AutoCAD dwg filename with Chinese characters fails to Import

[63]

CATIA V5 2D Import (*.catdrawing) will display wrong and overlapped geometry
CATIA V5 R19 - Problem saving as .3D

CATIA V5 drawing imports with a view misaligned

CATIA V5 2D CATDrawing missing data on Alle text

Missing PMI text on 2D Catdrawing file

A CATIA V5 2D CATDrawing -fFrame around drawing is incorrect

CATIA V5 R22 sample .CATPart files not importing

CATIA V5 R24 will not read into SpinFire Professional 10.8.3

.CATPart file from CATIA V5 R19 SP9 HF83 doesn't open in Spinfire 10.x
CATIA V5 2D does not fit to page when imported with SpinFire 10

CATIA V5 2D issue - drawing file crashes SpinFire Professional

CATIA V5 (4T28 2D CATDrawing) - V61: text not fitting in container

CATIA V5 2D 4728 CATDrawing - V61: Chinese text not fitting to page or table
CATIA V5 2D underscores incorrectly written as Czech characters

® & & 0 0 06 0 06 0 0 0 0 0 0 O O O

CATIA V4 2D Issue: drawings is missing most entities compared to HPGL
® No IGES annotations in Spinfire 10.8.X
® Support for NX10 2D

® NX 2D drawing importing with dimensions out of place
® NX 2D Drawing Missing Geometry

Parasolid

® Import Parasolid binary file *.x_b failed.

SolidEdge
® importing .dft/converted .dft.3d files open in windows XP dont open in Windows 7 (solidedge)
SolidWorks

® Support for SolidWorks 2015 2D
® Support for multi-sheet Solidworks 2D
® Miscoloration of line drawings in SolidWorks 2D

Known Issues

NX 9.0.3 files may not open successfully.
Some quality issues with Catia V5 R24 files
SolidWorks 2015 2D files fail to open.
CAD2CAD JT export file is v8.1

Supported Environments

Client Environment Minimum

Operating System Windows 7 (32-bit)

Actually DWG drawing is missing/shifted, but measurement is imported correctly.

CATIA V5 Assemblytree names in CATIAV5 R24 A20*.catpart (misnomer: "geometrical result")
CATIA V5 2D CATDrawings are not being imported with items in the correct position

Recommended



Windows 7 (64-bit)
Windows 8 (32-bit)
Windows 8 (64-bit)
Windows XP SP3 (32-bit)

Windows XP SP2 (64-bit)
Note: See requirements below.

Windows Vista (32- or 64-bit) SP2

Windows 7 (64-bit)

OS Language Supported English (US) English (US)
Simplified Chinese Simplified Chinese
Chinese Chinese
Czech Czech
French French
German German
Italian Italian
Japanese Japanese
Korean Korean
CPU / Processor Pentium 1ll, 2.0+ Ghz Pentium IV-Core 2 Duo or greater
Memory (w/o Importers) 1.0 GB (2.0 GB for Windows Vista or 2.0 GB (3.0 GB for Windows Vista or
Windows 7) Windows 7) or more
Memory (w/ Importers) 2.0 GB (3.0 GB for Windows Vista or 3.0 GB (4.0 GB for Windows Vista or
Windows 7) Windows 7) or more
Graphics Open GL capable graphics card with 128 MB 512 MB or higher
RAM

Note: Windows XP 64-Bit Prerequisites

Wor

64-bit Windows Imaging Component (WIC)

® http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
Microsoft ASP.NET MVC 2

® http://www.microsoft.com/download/en/details.aspx?id=22079
MSXML 6.0

® http://www.microsoft.com/downloads/en/details.aspx?FamilylD=993c0bcf-3bcf-4009-be21-27e85e1857b1

.NET 2

® http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fal-affb-40e78d788b00&displaylang=en

.NET 4

® http://www.microsoft.com/downloads/en/details.aspx?FamilylID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en

Visual C++ 2010

® http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

king with Microsoft Surface Pro Tablet

Display Area

The display area of the Surface Pro Tablet can be much smaller compared to a desktop's monitor. Because of this the following lists a few tips to
help operate with the smaller screen.

® When working in the Work space, hide the assembly tree panel.
® When performing measurements, zoom in to get a closer view of the model especially if you're relegated to using the touch pad, touch
screen, or surface pen.

Mouse vs. Touch Pad vs. Surface Pen

Mouse


http://www.microsoft.com/download/en/details.aspx?displaylang=en&id=1385
http://www.microsoft.com/download/en/details.aspx?id=22079
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=993c0bcf-3bcf-4009-be21-27e85e1857b1
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b44a0000-acf8-4fa1-affb-40e78d788b00&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=BD512D9E-43C8-4655-81BF-9350143D5867&displaylang=en

Attaching a mouse to your Surface Pro Tablet offers the same feel of SpinFire as if it were on a desktop.

Touch pad

The touch pad offers a similar feel to mouse use. This can be augmented with the touch screen as well.

Many people have used the mouse wheel to easily zoom in and out on models in the SpinFire Work space. Since the touch pad does not have a
mouse wheel, the user can using the touch screen "pinching" motion to zoom in and out. Or one can set the default mouse movement
Rotate/Pan/Zoom from Rotate to Zoom.

Surface Pen

There are a few features in SpinFire 10 that maybe more difficult to use the Microsoft Surface Pen over the touch pad or a mouse.
The following lists some of the SpinFire features which require more dexterity to use the Surface Pen or may not work with the Surface Pen.

Selecting vertices in measurements
Selecting edges in measurements
Selecting arcs in measurements

Moving an annotation from a measurement
Tool Tips

Known Issues

® The "pinching" motion does not zoom in or out in isometric mode.
® Some graphic driver updates may cause SpinFire to crash. See Surface Pro Tablet Troubleshooting.

Surface Pro Tablet Troubleshooting

This troubleshooting document describes issues/scenarios from users that were resolved with system configuration adjustments. Actify has found
the proposed solution has resolved most cases in that scenario but may not solve all instances. This page will be updated as new scenarios and
information is discovered.

SpinFire Crashing Importing 3D Models

If this issue is occurring on one or some systems but not all with the same models, this could be due to a conflicting graphics driver.

In some specific cases, the graphics driver version 9.17.0010.3062 causes SpinFire to crash but either upgrading to a newer version, or reverting
t0 9.17.10.2867 from 2012-DEC-05 resolves the issue.

Solution

Option 1
Try updating the system's graphic driver from the Intel download site.
Download the latest driver from (Intel driver Version 15.31.9.64.3165 works);
® Intel® Iris™ and HD graphics Driver for Windows 7* and Windows 8* 64
Option 2
Try rolling back the system's graphic driver.
To roll back drivers:

. Go to the Control Panel.

. Click on Device Manager.

. Open up the Display Adapters.

. Click on the Driver tab.

. Click on the Roll back Driver button.

. Verify the Driver Version in the upper portion of the dialog window.

OO hAWNE

SpinFire Tech Tips

This section includes helpful tips and tricks for SpinFire Professional users.

If there are any tips or tricks you'd like to submit, please feel free to email them to info@actify.com


https://downloadcenter.intel.com/Detail_Desc.aspx?agr=Y&ProdId=3712&DwnldID=22842&ProductFamily=Graphics&ProductLine=Laptop+graphics+drivers&ProductProduct=3rd+Generation+Intel%C2%AE+Core%E2%84%A2+Processors+with+Intel%C2%AE+HD+Graphics+4000&lang=eng

FlexLM User View

The following will allow users to check the status of the FlexLM server and see who may be using a SpinFire license.

You will need the “Imutil.exe” utility installed on your machine, see links below:

® 64Bit: Imutil V11.11 64Bit >> V11.11_64Bit.zip
® 32Bit: Imutil V11.11 32Bit >> V11.11_32Bit.zip
Steps:

® Copy the Imutil.exe file to a shared directory on your network. Be sure the Client has access to the license Server using the DNS
resolution.
® Create a Batch file with the following information:

ECHO OFF

ECHO License Manager query SpinFire PRO Start

Imutil Imstat -c port number@server name -f 3DView35 core
pause

ECHO License Manager query end

Note: You will need to enter the TCP / IP port number and the server name or the server IP address.

® Example: Imutil Imstat -c 27000@Dell-M4500 -f 3DView35-Core

The results of the command should look like the following:

Imutil — Copyright (c) 1989-2010 Flexera Software, Inc. All Rights Reserved.
Flexible License Manager status on Tue 9/25/2012 08:49

[Detecting Imgrd processes...]
License server status: 27000@Dell-M4500
License file(s) on Dell-M4500: C:\Program Files (x86)\Actify\Floating License Manager\sfpflv2.dat:

Dell-M4500: license server UP (MASTER) v11.9
Vendor daemon status (on Dell-M4500):

actifyd: UP v9.2
Feature usage info:

Users of 3DView35-Core: (Total of 3 licenses issued; Total of 1 license in use)
“3DView35-Core” v1.0, vendor: actifyd floating license

Jim Vassello Dell-M4500 Dell-M4500 (v1.0) (Dell-M4500/27000 104), start Tue9/25 8:10

SpinFire Most Often Used Functions

This document contains information on the most often used functions in SpinFire Professional.
CLICK HERE to access the PDF.

End User License Agreement - SpinFire

SpinFire(tm) 10 for Windows Vista, 7, 8

Actify, Inc.
SOFTWARE LICENSE AGREEMENT

PLEASE READ THIS DOCUMENT CAREFULLY. IF YOU AGREE WITH THE TERMS AND CONDITIONS OF THIS END USER LICENSE
AGREEMENT (the "Agreement”), AND WISH TO RECEIVE AND USE ACTIFY'S SOFTWARE PRODUCT (the "Software"), PLEASE CLICK ON
THE YES BUTTON BELOW. THE SOFTWARE WILL ONLY BE INSTALLED ON YOUR MACHINE IF YOU HAVE SO INDICATED YOUR
ACCEPTANCE OF THIS AGREEMENT.

1. Grant Of Limited License. Software Use Restrictions. In consideration for your acceptance of the terms and conditions of this Agreement, Actify
will grant to you a personal, non-transferable and non-exclusive right to use and execute the Software on a single personal computer (a "PC"),
without right to sublicense or distribute the Software (except as provided in Section 3 below). Under no circumstance may you store, use or allow
the use of the Software in any manner on more than one PC at one time. You agree that you will not modify, reverse engineer, decompile or
disassemble any portion of the Software.

2. Duplication Restrictions. In order to effect your license rights hereunder, you may install the Software by duplicating it onto the hard disk drive


http://s3.amazonaws.com/Actify/Software/FlexLM/For%20Actify%20Help/V11.11_64Bit.zip
http://s3.amazonaws.com/Actify/Software/FlexLM/For%20Actify%20Help/V11.11_32Bit.zip
http://help.actify.com/download/attachments/10682830/SF106MOUF.pdf?version=1&modificationDate=1381308406523&api=v2

or into the CPU memory of a PC for use thereon, and you may make full or partial copies of the Software, but only as necessary for backup or
archival purposes or for purposes of distribution pursuant to Section 3 below. You agree that (i) your use and possession of such copies shall be
solely under the terms and conditions of this Agreement, and (ii) you shall place the same proprietary and copyright notices and legends on all
such copies as included by Actify on any media containing an authorized copy of the Software originally provided by Actify.

3. Distribution of the Software to Others. You may duplicate and distribute copies of the Software to others, or allow copies of the Software to be
made by someone else, provided that all of such copies include (i) the entire installation package as originally provided for the Software by Actify,
and (ii) a copy of this License Agreement.

4. Ownership of Software. You agree and acknowledge that Actify transfers no ownership interest in the Software, in the intellectual property in
any Software or in any Software copy, to you under this Agreement or otherwise, and that Actify and its licensors reserve all rights not expressly
granted to you hereunder.

5. Transfer Restrictions. This license is personal to you. Except as expressly provided in Section 3 above, you may not transfer the Software
and/or assign this License to any third party. If you attempt to transfer or assign this License, such transfer or assignment will be void and without
effect.

6. Export Restrictions. You may not export or re-export any Software or other technology received under this Agreement except in full compliance
with all United States and other applicable laws and regulations. In particular, none of such Software or technology may be exported or
re-exported into (or to a national or resident of) any country to which the U.S. embargoes goods, or to anyone on the U.S. Treasury Department's
list of Specially Designated Nationals or the U.S. Commerce Department's Table of Denial Orders.

7. Term; Termination. The term of this Agreement shall commence when you electronically download or receive (if Actify delivers the Software to
you by email or alternative means) and shall continue thereafter. If you fail to fulfill any of your material obligations under this Agreement, Actify
and/or its licensors may pursue all available legal remedies to enforce this Agreement, and Actify may, at any time after your default of this
Agreement, terminate this Agreement and all licenses and rights granted to you under this Agreement. You agree that Actify's licensors
referenced in the Software are third-party beneficiaries of this Agreement, and may enforce this Agreement as it relates to their intellectual
property. You further agree that, if Actify terminates this Agreement for your default, you will, within thirty (30) days after any such termination,
deliver to Actify or render unusable all Software originally provided to you hereunder and any copies thereof embodied in any medium.

8. Publications and Lectures. The use of SpinFire(tm) in data manipulation for any kind or publication or lecture should receive a full acknowledge.

9. Governing Law. This Agreement shall be governed by and interpreted in accordance with the laws of the State of California, excluding its
choice of law rules.

10. Disclaimer Of Software Warranty. ACTIFY PROVIDES THE SOFTWARE TO YOU "AS IS" AND WITHOUT WARRANTY OF ANY KIND,
EXPRESS, STATUTORY, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION ANY WARRANTY OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE OR INFRINGEMENT. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN TO YOU BY
ANY ACTIFY EMPLOYEE, REPRESENTATIVE OR DISTRIBUTOR WILL CREATE A WARRANTY FOR THE SOFTWARE, AND YOU MAY NOT
RELY ON ANY SUCH INFORMATION OR ADVICE.

11. Limitation Of Liability. IN NO EVENT SHALL ACTIFY OR IT LICENSORS BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL,
INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND (INCLUDING WITHOUT LIMITATION THE COST OF COVER, DAMAGES ARISING
FROM LOSS OF DATA, USE, PROFITS OR GOODWILL, OR PROPERTY DAMAGE), WHETHER OR NOT ACTIFY HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH LOSS, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY ARISING OUT OF THIS AGREEMENT.
THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITED REMEDY.
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